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Welcome! 

First contact 

1. Configure your screen for correct display. 

2. Run the program:  click the icon set on Desktop. 

3. Key in your name in the License Owner dialog box: this allows you to customize your user rights to the 
program, which are activated by the dongle plugged into your computer. 

4. Add and designate your active target machine: its engraving area defines the maximum surface area of 
the plate that you are going to engrave. 

5. Customize your program: open the Options dialog box. 

6. Click the General tab. 

7. Click your measuring Unit, and then on your Language. 

8. Click in the Options dialog box. 

9. A message will warn you that the program has to be restarted for it to be displayed in your 

language:  click. 

10. Run the program. 

 If you are not very familiar with the Windows operating system, look up topic About Windows 

programs. 
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Need Help? 

This electronic documentation, which is always available, provides targeted, user-friendly help as you work 
with the program. 

View the Contextual Help to see how to use a 
tool bar or a dialog box, for example. 

Help offers information about the current screen, 
or the task you are performing. 

1. Click the tool bar/dialog box. 

2. Press: the topic that contains the information is 

displayed in the Help window. 

Read the On-line Help using its highly flexible 
browsing tools. 

Colors, animations, and dynamic links enhance the 
help screens. 

Click command Contents in menu ?Help: the Welcome 
topic is displayed in the Help window. 
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GravoStyle 5 

Discover GravoStyle 5 

 Window 

 Menus 

 Toolbars 

 Tool palettes 

 Work modes 

 Produce a composition 

 Program Levels/Options 
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Window 

 

 

When many document or program windows are open, quickly locate GravoStyle window 
thanks to the Gravograph logo displayed in the bottom right corner. 
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GravoStyle 5 Menus 

Click a menu for more information. 

 ?Help 

Contents 
Search 
Use Help 

Consulting on-line Help 

About Commanding and integrating a program option 
or level 

 File 

New 
Open 
Save 
Save as 

Creating a composition 
Opening a .gnh file 
Saving while working 
Saving a composition 

Open a model Creating a composition from a template 

Save a model Saving a composition as a template 

Find 
Information 

Finding a .gnh file 
Information about the current composition 

Import 
Export 

Importing objects in composition 
Exporting objects to an external program 

Insert object Retrieving a bitmap image saved with vectorial 
contours 

Vectorize / Vectorize Parameters 
Scan / Select scanner 

Vectorizing an image 
Digitizing an image 

Print 
Print preview 
Print parameters 

Printing the composition 

Recent files List of the last four files opened 

Exit Close the window and exit the program 

 Edit 

Undo 
Redo 

To cancel/restore a procedure 

Cut 

Copy 
Paste 
Delete 

Placing objects 

Select all Selecting objects 

Pointer position 
Snap mode 
View object 
Mouse use 

Work area 

Clear Undo Memory Deleting the saved cancellations 

Options Customize the program 
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 View 

2D XY View 

2D YZ View 
2D XZ View 
3D engraving View 
3D ISO View 
View 

View in the work area 

Zoom 
Last Zoom 
Max Zoom 
Zoom material 
Zoom selection 

Zoom tools 

Redraw 

Quick Redraw 
Redisplaying the composition 

Wire direction Viewing draw direction 

Wire color 
Fill color 

Display mode for engraving paths 

Arrow direction Viewing draw direction 

 Modify 

Text  Using the Advanced Text functions (non-
horizontal text, font editor, etc.) 

Shapes  Drawing geometric shapes 

Align Aligning objects 

Effects  Applying effects to objects 

Duplicate  Duplicating an object 

Transform  Transforming an object 

Tasks  Creating professional objects 

Material Configuring the composition 

Guide lines Managing guide lines 

Symbols Placing objects from program library 

PhotoStyle Processing a bitmap image using PhotoStyle 

Bitmap Editor Retouching a bitmap image 

Wysiwyre Displaying 2D render on material 

 Machining 

Setup machines To add a target machine 

Tool database To manage engraving tools 

Machining To open the Machining dialog box 
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GravoStyle 5 Toolbars 

 Main Bar 

New 

Open 

Save 

Create a new composition, or use a composition that you have saved as 
a file. 
Save the composition regularly to avoid the accidental loss of your work. 

Undo 

Redo 

Each action you perform is saved in the program’s Undo/Redo memory. 
You can therefore cancel or restore a series of steps to return to a 
specific stage of preparing a composition. 

Copy 

Paste 

Cut 

Call up these commands to insert an object from another composition or 
from an external document into the composition. 

Zoom area 

Last zoom 

Max zoom 

Zoom material 

Zoom selection 

Use these commands to improve the composition’s display quality and 
size. 

Redraw 
Regularly force the redisplay of the composition on-screen. 

Print 

Produce a paper printout for a pre-engraving presentation (test or 
engraving check). 

Comments about the 

composition 

Attach your personal notes to the current composition. 

Web links 
Contact us via Internet. 

Engraving dialog box 
Set and transfer the engraving parameters to your machine. 
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 Toolbox 

Working modes Creating objects Handling objects 

Material mode  

Selection mode  

Text mode  

Drawing mode  

Point mode  

Advanced Text  

Symbols  

Tasks  

Group  

Ungroup  

Align  

Transform  

Measure  

Duplicate  

Effects  

Engraving Using a bitmap image Engraving environment 

Wysiwyre  

Engraving quotation  

Assign a toolpath  

PhotoStyle  

Bitmap Editor  

Scanner  

Vectorize  

for IS machines  

for L-Solution machines  

for IS machines  

Functionality available in Discovery level 

Functionality available in Graphic level 
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GravoStyle 5 tool palettes 

Organizing tool palettes 

1. In the Options dialog box, click the Display tab. 

2. In the Toolbar configuration zone, click 

Activate automatic 

reorganization 

The exclusive palette mode displays access first to the useful 
tools. 

Click any working mode in the toolbox (text, drawing, points, 
selection): 
• the linked palette will open. 
• useless palettes are closed to avoid toolbar clutter. 
• palettes you docked in the program window remain at screen. 

Disable this automatic management to open or to close palettes at 
need. 

 Restore default config.   
to mask everything. 

 Save user's config.   
to memorize the display and position for palettes you have 
opened. 

 Restore user's config.   
to display and position palettes according to your configuration. 

Palettes available in Discovery level 

 

 

 

 

 

Palettes available in Graphic level 
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Activating a GravoStyle 5 working mode 

While you are working, you will frequently switch from one mode to another, depending on the procedure you 
want to perform. 

1. Select the mode that allows you to execute the procedure of your choice from the table below. 

2. Click the question "What can I do…": the specific topic for the working mode displays. 

3. From the list of procedures authorized by the mode, click the one you need. 

 

Material mode is used to configure the composition (origin, orientation, surface, margins). 

What can I do in Material mode? 

 

Text mode is used to place and type lines of text in the composition. 

What can I do in Text mode? 

 

Drawing mode is used for drawing geometric shapes in the composition. 

What can I do in Drawing mode? 

 

Selection mode is used to select and manipulate objects placed in the composition. 

What can I do in Selection mode? 

 

Point mode is used to retouch the vectored contours of the objects placed in the composition. 

What can I do in Point mode? 
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Producing a composition 

What are the main steps to produce a composition? 

Define a target machine Create and design the machine that will execute the 
engraving. 

Create a composition Create a new composition, or base a new composition 
on an existing one. 

Configure the composition If the composition and plate have the same 
rectangular surface, the configuration could apply to 
either one, without any changes being required. 
As soon as the plate has a different shape or 
dimensions, configure the composition to adapt it to 
the plate’s profile. 

Place objects Enhance the composition with text, geometric shapes, 
or images. 

Common tasks Memorize these actions you will regularly carry out 
when working on the composition. 

Engrave the composition Once the composition is finished, it is engraved onto 
the plate. 
Set the parameters and tools involved in executing 
the engraving, then transfer the composition from the 
program to your machine. 

 Never unplug the dongle when you are working with the program. 
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GravoStyle 5 Levels 

To meet the requirements of your new engraving applications, order and activate in GravoStyle 5 the 
option or the level of your choice. 

Discovery  

 

This first level displays GravoStyle graphic environment to engrave with rotative tool on IS 
machines. 

From text layout to machining, the basic toolbox offers the functions required to produce a plate. 

Discovery features (non-contractual list) 

Standard functions for all levels + Options 

Standard functions 
Create a composition 
Zoom/Redraw - Undo/Redo -Save - Print 
Information about current work - Invoicing help 
Call out the program support - Customize program 

Configuring the 
composition 

Dimensions and margins - Origin - Orientation - Cylinder parameters 
Long plate option 

Setting a line of text 
Automatic/manual mode 
Position between margins (alignment, distance to margins, height, length, line 
spacing, baseline, etc.) 

Setting text attributes 
Font - Width - Rotation - Spacing - Underline - Slant/Italics - 
Index/Exponent - Auto-kerning - Styles 

Typing text 
Text from right to left - Level 1 Braille text 
Font Editor option 
Engraving Fonts option: Pack #1 - Pack #2 - Pack #3 - Asia Pack 

Designing advanced 
text 

Text in a rectangle - Slant/Diagonal Text 
Vertical text - Text in Columns - Text in arc 

Placing objects 
Simple shapes (markers, rectangles, arrows, lines, curves, polygons, circles, arcs, 
etc.) 
Symbols - Import (BMP, TIFF, WMF, PNG, EPS, HPGL, DXF, IGES, ISO, etc.) 
Drilling points - List of names/Incrementations 
Matrix option 
Dial option 

Manipulating objects 
Select 
Copy/Cut/Paste - Delete - Group/Ungroup 
Set on Grid/Guide lines/Layers - Transform - Align 
Export 2D ( HPGL, DXF, IGES) 

Using a bitmap image 
PhotoStyle/Bitmap editor option 

Engraving the 
composition 

Setting a target machine - Drivers for GII & NH machines 
Tool engraving properties - Transfer for engraving 
Wysiwyre render on material 
Number of machines Increment option 
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Graphic  

 

You will work with 
• the advanced toolbox. 
• three environments dedicated to specific engraving 
fields. 

To work in the environment of your choice, click the 
related tab in the toolbox: 
• the color of the program’s interface changes 
(window, dialog boxes, menus) 
• functions specific to the environment are available in 
menus and toolbars. 

When you exit the program, the active environment is 
memorized for the next run. 

You can use either GravoStyle or Laser functions 

to design a composition. 
But you must activate the environment dedicated 
to your machine to drive the physical execution of 
the engraving. 

 

GravoStyle (active by default) 

Composition and engraving with 
rotative tool on IS machines 

 

Advanced machining 

Management of the toolpaths assigned 
to objects designed in GravoStyle 
environment 

 

Laser option 

Composition and engraving with laser 
beam on L-Solution machines 

Graphic features (non-contractual list) 

Functions + Functions + Options 

Setting text attributes 
Uppercase/Lowercase 

Typing text 
Font Editor option 
Engraving Fonts option: Pack #1 - Pack #2 - Pack #3 - Asia Pack 

Designing advanced 
text 

Text on curve 

Placing objects 
Matrix series 
Braille Level 2 option 
Dial option 
Bar code option 

Manipulating objects 
Duplicate - Measure - Convert to curves 
Effects on curve objects (intersection, subtraction, joining, segmentation, overlap 
markers, offset, envelop) 
Editing vectorial contours 
Material Auto-Optimization option 

Material Pro-Optimization option 

Using a bitmap image 
Scanner/Vectorizing 
PhotoStyle/Bitmap editor option 

Engraving the 
composition 

Basic 2D filling 
Laser engraving with L-Solution machines 
Advanced management of engraving paths 
Number of machines Increment option 
Post-processors for other vendors machines option 
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Using a target machine 

Installing your target machine 

To transfer the composition to the engraving machine plugged into your computer, establish a software 
connection between GravoStyle and this target machine. 

Creating a target machine 

Adding a target machine to Windows 

Configuring an existing target machine 

Set the properties of a target machine in Windows 
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Installing a new target machine 

 We suggest adding a Binary target machine. This format optimizes calculation, the transfer 

period, and checking of data received by the machine. 

Open the Machines dialog box: click the Setup machines command in the Engraving menu. 

 Close  When you close the Machines dialog box, a message will ask if the default target machine’s dimension 

area become the default dimensions. 

 Yes  Click to assign these dimensions to each blank composition. 

Creating a target machine 

The new target machine is featured in 

the list of the machines installed in the 
Machines dialog box. It is automatically 
designated as the target machine by 
default. 

A. Click opposite the Add a machine icon. 

B. Click opposite the type of your machine. 

C. Right-click the machine model in the list of available 
machines. 

D. Click the Add this machine command in the contextual 
menu. 

 E. Double-click on Add to Windows in the Configure output 
dialog box and add the target machine to Windows: the 
target machine appears in the List of installed printers. 

Click. 

 F. Type the Name of the target machine in the Machine 
Properties dialog box. 

Click. 

Designate by default 1. Right-click a target machine. 

2. Click the Set as default command in the contextual 
menu: the default target machine becomes active in the 
Material dialog box. 

Properties 1. Right-click a target machine. 

2. Click the Properties command in the contextual menu. 

3. Configure the target machine in the Machine Properties 
dialog box. 

Delete 1. Right-click a target machine. 

2. Click the Delete command in the contextual menu. 

 To use more than 4 machines, use the Number of machines increment option. 

 To use a machine that is not a Gravograph brand machine, check that you have the Graphic 

level, and use the Post-processors for others tables option. 
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Adding a target machine to Windows 

Install the target machine as a printer (the order of the procedures varies depending on the Windows system 
install on your computer). 

The installed machine features in the Printers folder and its name is displayed in the Configure 

output dialog box. 

1. Install the target machine. The Add printer Wizard opens when you double-click Add to Windows in 
the Configure output dialog box. 

2.  Next>  Click in the Add printer Wizard. 

3. Click Local printer ( unclicked Plug & Play box). 

Next>  Click. 

4. Click the Port which the cable linking the computer and the machine is plugged into.  Next>  Click. 

LPT if the connection is hooked up using a Gravograph parallel cable plugged into the machine’s parallel 
port and into one of the computer’s LPT ports. 

COM if the connection is hooked up using an adapted Gravograph serial cable plugged into the machine’s 
serial port and into one of the computer’s COM ports. 

 Configure the serial link. 

FILE if the engraving is saved in the form of a file for subsequent transfer to your machine. 

5. Select the Windows driver used to communicate with the target machine. 

You are adding a target machine 

for the first time. 

 It is possible that Windows will 

ask you to insert a specific 
Microsoft installation CD-ROM. To 
install the driver, follow the 
instructions displayed. 

Click Generic Manufacturer, then on the Generic 
Printer/Text Only driver. 

Next>  Click. 

 Finish  Once you have clicked, Windows will install the driver. 

You have already added a target 

machine referenced by the 
"Generic/Text Only" driver. 

a. Click the Generic Manufacturer, and then on the 

Generic Printer/Text Only driver. 

Next>  Click. 

b. Click Keep the existing driver. 

Next>  Click. 

6. Type the machine’s name under Printer name. Next>  Click. 

7. Click No to avoid designating this machine as the default printer. 

Next>  Click. 

8. Click Do not share this printer. 

Next>  Click. 

9. Click No to avoid printing the test page. 

Finish  Click. 

10. Continue installing the target machine. 
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Configuring an existing target machine 

The properties of the target machine, 
which are displayed in the Machine 
Properties dialog box, are provided by 
the post-processor, which is regularly 
updated at the factory. 

1. Open the Machines dialog box: lick the Setup. machines 
command in the Engraving menu. 

2. Right-click a target machine. 

3. Click the Properties command in the contextual menu. 

Name To rename the target machine, type the new name. 

Overall dimensions Minimum and maximum engraving areas and thicknesses 

Standard point XYZ coordinates and position for the work area origin in the 
engraving area. 

Associating a target machine in 
Windows 

Designate the target machine, which will 
start engraving right after a transfer in 
Port mode. 

1.  Output  Click in the Machine Properties dialog box. 

2. Click Use Windows spooler in the Configure output 

dialog box. 

3. Click the machine in the List of installed printers. If it is 
not featured in, add the target machine to Windows. 

4. Click. 

Modifying the post-processor (for 
advanced users only)  This procedure automatically renders your warranty 

with your Gravograph distributor null and void. 

Set the parameters in the Machine Properties dialog box. 

More  Click to edit the post-processor. 

Selecting an output other than 
physical engraving 

1.  Output  Click in the Machine Properties dialog box. 

2. Click the output in the Configure output dialog box. 

In a file: You are saving the engraving data in the Draws 

folder, as a file for subsequent transfer to the IS machine. 
Type the name of the current composition, followed by the 
extension .Uxx (xx is the number of the file created). 

Automatic files 
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Setting the properties of a target machine in Windows 

1. Select the target machine to be configured in the 

 

Machining dialog box  

Machining dialog box  

2.  Spooler  Click: the print manager window for the machine opens. 

3. Click the Properties command in the Printer menu. 

4. Modify the properties of your choice in the target machine's Properties dialog box. 

5. Close the printer’s Properties dialog box. 

6. Close the print manager window. 

To bring up the Windows contextual help, click this box, then a zone in the dialog box. 

Configuring the serial link 

Synchronize the serial link parameters 
between the computer and the engraving 
machine each time you 
• add a target machine using a COM 
port. 
• select this target machine to engrave the 
composition. 

 If the serial parameters for the 
computer and the engraving 
machine are different, errors may 

occur during transfer, which will 
alter the execution of the 
engraving. 

a. In the target machine’s Properties dialog box, click the 
Ports tab. 

b. In the list of ports, click the COM port which the cable 
linking the computer and the machine is plugged into. 

c.  Configure Port  Click. 

d. In the COM Properties dialog box, click the Parameters 
tab. 

e. Key in the serial parameters for the machine (see the 
Gravograph user manual). 

f. Click. 

Designate the type of data transferred 
to the machine 

 

Windows 98 a. In the Properties dialog box, click the Details tab. 

b.  Spool Settings  Click. 

c. Click the RAW default data type. 

Windows 2000 a. In the Properties dialog box, click the Advanced tab. 

b.  Print Processor  Click. 

c. Click the RAW default data type. 
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Creating a composition 

Creating a composition 

New composition Create a blank composition or a composition based on a model. 

Open an existing composition Use a composition or a model that you have saved in the form of 
a file. 

Saving the current composition Save the composition to a disk (hard drive, diskette, CD-ROM) 
• if you plan on modifying it subsequently. 
• if you want to use it as a model for other compositions. 

 What are the composition formats you can open or save? 

  
File types Definition 

  GravoStyle (*.gnh) Composition created and saved in the program 

  Neutral (*.vnx) Neutral file created and saved in GravoStyle or Type3 whatever the 
version 

  GravoStyle98 
(*.vnd) 

Composition created and saved in the GravoStyle 98 for Windows 
95/NT program 
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New composition 

 Creating a new composition closes the current composition. 

Save the new composition under a valid name. 

Blank Composition 

 A blank composition is 
automatically created each time 
you run the program. 

1. Activate the New command: 

Click in the main tool bar. 

Use the keyboard shortcut. 

Select the New command in the File menu. 

2. Configure the composition. 

Creating from a model 

The new composition is created from a 
copy of the model selected. 

To bring up the Windows contextual 

help, click this box, then a zone in the 
dialog box. 

1. Open the Open a Model dialog box: 

Use the keyboard shortcut. 

Select the Open a Model command in the File menu. 

2. Locate the spot where the file is located ( DRAWS is the 
default folder). 

3. Select the .vnm file to be opened: you will see the preview 
and comments for the model selected. 

Click the filename. To search quickly, click in the list and 

type the first character of the name. 

Type its name in the Name box. 

4.  Open  Click. The new composition contains all the objects 

placed in the base model. 

Each text display font that is missing is replaced by the default 
font. 
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Opening an existing composition 

What is involved is a composition or a model that you have saved as a file for subsequent use. 

 Creating a new composition closes the current composition. 

Opening one of the last four files 
opened 

Click its name in the Recent File List of the File menu. 

Opening a composition or a model 

To bring up the Windows contextual 

help, click this box, then a zone in the 
dialog box. 

1. Open the Open dialog box: 

Click in the main tool bar. 

Use the keyboard shortcut. 

Select the Open command in the File menu. 

2. Locate the spot where the file to be open is ( DRAWS is 
the default folder). 

3. Select the file to be opened: you will see the preview and 
comments for the file selected. 

Click the file name. 

To search quickly, click in the list and type the first character 
of the name. 

Type its name in the Name box. 

4.  Open  Click: the file name will be displayed in the title bar. 

Each text display font that is missing is replaced by the default 
font. 
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Saving the composition 

Saving as a composition 

The composition is saved as a file with the 
same name, in .gnh format. 

To bring up the Windows contextual 
help, click this box, then a zone in the 
dialog box. 

1. Open the Save As dialog box: 

Click in the main tool bar. 

Use the keyboard shortcut. 

2. Locate the folder where the file will be saved ( DRAWS is 
the default folder). 

3. Type your Comments. 

4. Designate the File Type (*.gnh default). 
To create a neutral format file, click type *.vnx. 

5. Type the name of the composition in the Name box. 

To replace an existing file, click its name in the list. 

To save a new file, delete the "*" character and key in a 

new name. 

6.  Save  Click: the file name will be displayed in the title bar. 

Saving as a model 

The model is saved from a copy of the 
current composition, as a file with the 
same name, in .vnm format. 

 To edit a model, use the Open 
command. 

1. Open the Save a Model dialog box: select the Save a 
Model command in the File menu. 

2. Execute steps 2 to 6 of the Saving as a composition 
procedure. 
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Common tasks 

Common tasks 

Keyboard shortcuts A keyboard shortcut is a combination of key strokes that you type 
to execute a standard command. 

Zoom/Redisplay Use these commands to improve the composition’s display quality 
and size. 

Undo/Redo Each procedure that you carry out is saved in the program. You 
can therefore cancel or restore a series of procedures so you can 
return to a specific stage of preparing a composition. 

Save Save the composition regularly: 
• to avoid accidentally losing your work. 
• to save the last changes made. 

Information Update the features of the current composition (comments, 
working time, etc) 

Print Produce a paper output for a presentation before engraving (test 
or engraving note). 

Engraving Quotation Assess the engraving price for a selection of objects or the whole 
plate. 

Software support How to find technical assistance or sales information? 

Running 1. Click Start in the Windows task bar. 

2. Click command Programs in the Start menu. 

3. Click group GravoStyle in the Programs menu. 

4. Click in the group. 

Exiting 

 Before exiting, save the 

composition. 

Use the keyboard shortcut. 

Select the Exit command in the File menu. 
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G5 Hotkeys 

File menu 

Keys Command Main bar 

 

New 

 

 

Open 

 

 

Save 

 

 

Import   

 

Export   

 

Print 

 

 

Exit  

Edit menu  

Keys Command Main bar 

 

Undo 

 

 

Redo 

 

 

Cut 

 

 

Copy 

 

 

Paste 

 

 

Delete (DEL)  

 

Select all  

 

Pointer position  

 

Snap mode  

 

View object  

 

Mouse buttons  

 

Options  
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View menu  

Keys Command Main bar 

 

Redraw 

 

 

Quick redraw  

 

 

Contour direction   

Wire contours   

 

Filled contours   

Machining menu  

Keys Command Main bar 

 

Engraving 

 

?Help menu 

Keys Command Main bar 

 

Help  

Text functions 

Keys Command Text Palette 

 
Distance to top margin  

 
Distance to left margin  

 
Text alignment  

 
Maximum available length  

 
Italics text  

 
Underlined text  

 
Exponent text  

 
Height  

 

To increase the spacing between two characters 

 

 
To decrease the spacing between two characters 
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Zoom/Redisplay  

Redraw 

Due to a large number of changes being made, the 
composition has become illegible. 

Click in the main toolbar. 

Use the keyboard shortcut. 

Click the Redraw or Quick redraw command 

in the View menu. 

Zoom using the mouse’s right button 

1. Configure the right button for the zoom. 

2. Using the mouse's right button, 
• click to double the size of the image on-
screen. 
• double-click to display the work area. 

Zoom tools 

Check the % zoom level % in the status bar. 

Click in the main toolbar or in the View menu. 

Slide the pointer so that the whole area to be enlarged is 
framed. Zoom area  

Back to the previous zoom level Last Zoom 

View all the objects in the work area Max Zoom 

View the whole composition Zoom material 

Select objects before clicking the tool. Zoom selection 
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Undo/Redo a procedure  

You have just made a mistake. 

Cancel the procedure using the Undo 
command. 

Click in the main toolbar. 

Use the keyboard shortcut. 

Click the Undo command in the Edit menu. 

Right-click if your mouse is configured to trigger the Undo 
command. 

You have accidentally cancelled a 
procedure. 

Restore it immediately using the Redo 
command. 

Click in the main toolbar. 

Use the keyboard shortcut. 

Click the Redo command in the Edit menu. 

Managing cancellations 

Each procedure that you carry out is saved 
in the program’s Undo memory. 
You can therefore cancel or restore a series 
of procedures to return to a specific stage 
of preparing a composition. 

 The Edit menu states the last 
procedure, which you can: 
• cancel using the Undo command. 

• restore using the Redo 
command. 

To set the number of procedures saved in the Undo/Redo 
memory, key in the Number of cancellations in the Options 
dialog box's General window. 

If your computer’s RAM is less than or equal to 32 MB: 
• Limit the number of cancellations to 3. 
• Regularly click the Clear Undo Memory command in the Edit 
menu. 

Another way of cancelling a series of procedures is to return to the last saved version of the 

composition. 

This can be done if you have saved the current composition. 

1. Open the Open dialog box:  click in the main toolbar. 

2. A message will ask if you want to save the latest changes carried out: click  No  

3. Open the composition again: click its name in the Recent File List of the File menu. 

You will recover the last saved version of the composition. 
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Save 

Save items regularly in order to keep the latest changes made to the composition. 
If you lose the composition accidentally, saving also allows you to recover most of your work. 

 A message will ask if the latest changes should be saved each time 

• you create a new composition. 
• you open a composition. 
• you exit the program. 

Personal Save 

Always save 
• if you produce a lengthy or complex 
composition. 
• if you have to put your work on hold. 
• if you want to update the relevant file to 
include the latest changes. 

Click in the main toolbar. 

Use the keyboard shortcut. 

If you have already saved the composition, the related file is 
updated to include the latest changes. 
Otherwise, save the composition. 

Automatic Save 

 This function does not replace your 
personal saves; as a matter of fact, 
the latest automatic save does not 
necessarily include the latest 
changes made to the composition. 

The active composition is automatically saved every 20 minutes. 

You can also adjust the automatic save period to a greater or 
lesser interval. 

You have just lost the composition. 

Due to a loss of power, a defect in your 
computer, or a program operating 
anomaly, you have abruptly exited the 
program. 

How can your work be recovered? 

Restart the program: a message will ask whether you want to 
recover the composition. 

You saved just before exiting the 
program: 

 Cancel  Click and open the relevant .gnh file for your 

composition. 

You did not save anything: 

Click: the last automatically-saved version will be opened. 

You will have to redo all the procedures that were not saved. 
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Editing the information about the current composition 

Save the composition to keep the latest features. 

Work time 

Control the time you spend on plate 
production (hours/minutes/seconds). 

 

Tick option in the Options dialog box's Display window. 

Displayed in GravoStyle window top right corner, job timer is 
automatically reset for each new composition. 

Comments 

 

1. Click in the main toolbar. 

2. Type your comments about the current job (ideas, 
instructions, technical data). 

Line break  

3. Click to close the window. 

Additional features 

You will see the work time and the 
comments about the composition, plus: 

Open the Information dialog box: select the Information 
command in the File menu. 

Creation date First file saving date 

Edition date Last file saving date 

Creator Type the operator’s name. 

Customer Type the recipient's name. 

 



GravoStyle 5 User Manual 

32 

 

Printing the composition 

 Before printing, check that your computer and printer are correctly connected and that the 

printer is powered up. 

1. Run the printing: 

Type the hotkey. 

Click in the main toolbar. 

Select the Print command in the File menu. 

2. Set the print parameters: 

Print range Click 

All 

Selection: the objects selected 

Pages: if the printing covers several pages, type the number of the first (From) and last 

(to) pages. 

Quality Click a value falling between your printer’s minimum and maximum resolution. 

Copies Key in a number of copies between 1 and 99. 

If a copy has more than one page, click the Group box to print one copy at a time. 

Print to 
file 

a. Click to retain a print file or to perform delayed printing. 

b. Save the printing in a .prn format file. 

Info Click to print information about the document at the bottom of the page (work directory, 
name of the composition, print scale). 

Print 
position 

Click one of the 5 available positions Center/Top/Bottom/Left/Right. 

Tick box Mirror to print a reversed image. 

Print size Click 

Adjust to page: the printing is adjusted to the page dimensions. 

Scale: the printing is resized according to the percentage entered. 

Collate Click the printing mode for layers: 

All layers one page 

Current layer 

One layer one page 

 Setup   Click to configure your printer. 
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3.  Preview  Click to display the print preview. 

 Print   To run the printing 

 Prev Page   

Next Page   

To scroll through the pages 

 One page/Two pages   To display a single or double page 

 Zoom in   

Zoom out   

To enlarge or reduce the view 

Click in the preview to reduce or increase the print size. 

 Close   To close the print preview 

4.  Print  Click. 

 



GravoStyle 5 User Manual 

34 

Invoicing help 

1. Select the lines of text to be engraved. 

2. Click in the toolbox. 

3. Key in the Price of Plate and the Price per Character to obtain the Total price. 

Nb of Characters Multiplied by character price, used to calculate the price of the text selected. 

Total price Sum between plate price of and price of the text selected. 

4. Click. 

 



Common tasks 

35 

 

Calling out Software support 

Contact Gravograph by email. 

About dialog box displays 
• your dongle's features that will be systematically attached to 
your mail to identify your program version. 
• the terms of the operating licence that protects use of the 
program. 

Click in the 
main toolbar. 

Click the About command in the Help 

menu. 

Codes To meet the requirements of your new engraving applications, upgrade GravoStyle by integrating a 
specific option or a higher program level. 

Ordering a level/option 

Your distributor will forward you the 
codes that allow you to activate the 
option/level ordered into the program. 

1. Designate the Gravograph distributor you contact in 

the About dialog box. 

2.  @Info  Click. 

3. Type the list of the options or the level you want in the 
Content of your message. 

4. Click to email your request. 

Activating a level/option 

 Only modify the codes for 

running a program option or 
level that has been purchased 
legally from Gravograph. 

1. Type each Code in the About dialog box. 
For example, if you have two codes, only fill in the first 
two boxes. 

2.  Validate  Click. 

3.  Close  Click. 
 

@Info To have details about new program features and upgrades, send a sales request. 

1. Designate the Gravograph distributor you contact. 

2. Click to email your request. 

3. Type the Content of your message. 

4. Click. 

@Help  If you find no solution to a problem arose while using the program, call out the technical assistance. 

1. Designate the Gravograph distributor you contact. 

2. Click to email your request. Files describing the program configuration will be attached. 

3. Type the Content of your message that explains the problem encountered. 

4. Click. 

Print  Click to open your dongle's features in Word: you can edit and print this document. 

When you have no Web connection, type your request at the end of the document, print 

and fax it to your Gravograph distributor. 

 





 

37 

Material mode 

Working in Material mode 

Active for each blank composition, this mode is 
basically used to configure the composition according 
to the profile of the piece to be engraved. 

Set your specifications according to the constraints 
hereunder: 

1. Open the Material dialog box: 

Click in the toolbox. 

Click the Material command in the Modify 

menu. 

 Dimensions in relation to the surface, the volume 

and the profile of the piece (plate, non-
rectangular shape, cylinder) 

 Margins delimiting the engraving zone in the 

composition 

2. Set the composition’s dimensions and 
margins. 

 

 Machine choice (maximum engraving area, 

maximum strokes and clearances) 

 Engraving orientation (upside or reversed in 
relation to the material, 180° or 90° rotation) 

 Engraving origin linked to the accessory used to 

clamp the piece on the machine (table, vice or 
cylinder engraving) 

 Parameters for cylinder engraving (piece 

diameter, type of cylinder attachment) 

3. Set the composition’s engraving properties. 

 

The dynamic assistance helps you to optimize the 
composition configuration for safer machining. 

 For example it indicates the maximum number of 

plates in engraving area for Matrix serie. 

 It suggests different solutions to correct possible 

composition overflows outside the engraving area 
(changing origin or orientation, choosing a 
machine with a larger engraving area, automatic 
activation of long plate mode). 

4. Check that the composition’s configuration 
is correct. 

 

5. Click. 
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Entering the dimensions and margins 

 

The exterior frame delimits the composition’s surface area, in 
accordance with its dimensions. 
The dotted frame represents the margins that separate the zone 
reserved for the text from the border designed to immobilize the 
plate. 

You can customize the color of the composition and the margins. 

 If the new dimensions/margins decrease the length of 
a line of text in relation to that of the text typed in, the 
text will automatically be compressed. 

Click the Dimensions and margins tab in the 

Material dialog box. 

Material's dimensions 
 If one of the composition’s dimensions exceeds the height of the 
engraving area, the other has to be less than the engraving 
area’s length (limit of the tool’s movement on the X axis). 
A message will ask you to confirm dimensions selected that are 
greater than the engraving area’s dimensions. 

Yes  Click if you are configuring a composition on a cylinder or a 

long plate. 

 

1. Key in a length no greater than the length of the engraving area. 

2. Key in a height no greater than the length of the engraving area. 

3. Key in a thickness no greater than the depth of the engraving 

area. 



Material mode 

39 

Composition’s margins 
 If you place the text in manual mode, all the margins will be 
cleared. 

Proportional margins Click box Margins auto-correction. 

 

The left and right margins are each equal to 15% of the composition’s 
length. 

 

The top and bottom margins are each equal to 10% of the composition’s 
height. 

Margins equal to the left 
margin 

1. Click box Same margins. 

2. Key in the left margin. 

Different Margins 1. Check that no boxes are clicked. 

2. Key in each margin. 

 

The distance between the left and right margins has to be between 0.01 mm 
and the length of the composition. 

 

The distance between the top and bottom margins has to be between 0.01 
mm and the height of the composition. 

Customizing the standard 
dimensions and margins 

The default dimensions equal 
• the dimensions of the default 
target machine’s area. 
• 1,000 x 1,000 mm, if you 
have not created a target 
machine. 

1. Click the Material tab in the Options dialog box. 

2. Key in the dimensions and margins as described above. 

Click in the main toolbar to create a blank composition from latest 

default dimensions and margins. 
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Engraving properties 

Defining the composition’s engraving properties 

 

1. Click the Engraving properties tab in the Material dialog box. 

2. Set the engraving properties below. 

3. Check that the composition’s configuration is correct. 

 
Designate the active target machine which will actually engrave the current 
composition. Its engraving area delimits the composition’s maximum surface area. 

 Cancel  Click if there isn’t one. Add this target machine, and then designate it in the 

Material dialog box. 

Designate as default target machine  

Click box Set as default machine if you perform engraving regularly using the 

active target machine. 

The machine selected automatically becomes the default target machine in the 
Machines dialog box. 

When you click to validate your composition’s configuration, a message will ask if 

the default target machine’s area has to delimit the maximum surface area for each 
blank composition. 

Yes  The dimensions of the engraving area will become the default dimensions in the 

Options dialog box. 

 
Designate the engraving orientation normal or rotated. 

 
Set the engraving origin center or upper left-hand corner. 

 
If needed, set the parameters for engraving on cylinder. 
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Setting the composition’s origin 

 

1. Click the Engraving properties tab in the Material dialog box. 

2. Select the origin depending on the composition’s position in the engraving area. Click a 
fixed origin (center or left) or on a floating origin (center or left). 

The composition’s origin will become floating when it does not match any fixed origins. This is 
the case when: 
• The plate’s footprint does not make it possible to fix it at the center or in the left-hand corner 
of the engraving area. 
• The composition’s position on the plate offsets its origin in relation to the center or the left-
hand corner of the engraving area. 

 

Machine center 

The center of the composition matches the center of the engraving area. This fixed origin is 
recommended for engraving on a self-centering vice. This accessory makes it possible to 
center the plate in the engraving area. 

 

Machine’s left corner 

The upper left-hand corner of the composition matches the upper left-hand corner of the 
engraving area. This fixed origin is recommended for engraving on plates at low pressure, 
or t-slot or clamping tables, as this accessory makes it possible to set the plate in the upper 
left-hand corner of the engraving area. 

 

Floating center 

Key in the XY coordinates for the center of the composition in the engraving area (the 
default value is zero). 

 

Floating left corner 

Key in the XY coordinates for the upper-left hand corner of the composition. Default 
settings: 
• The X coordinate equals half of the length of the engraving area. 
• The Y coordinate equals half of the height of the engraving area. 

 You can only select a floating origin if the composition’s surface area is less than the engraving 

area. 
Check that the floating origin’s position does not place the composition outside the engraving 
area. If this is detected during transfer for engraving, a message displays asking you to correct 
the floating origin’s XY coordinates. 

  

Correct floating origin 

The upper left-hand corner of the composition (red 
frame) remains within the engraving area (gray surface). 
The plate (green surface) is fixed onto the upper left-
hand corner of the engraving area. 

Incorrect floating origin 

The upper left-hand corner of the composition is 
outside the engraving area. 
Only the portion of the composition inside the 
engraving area will be engraved onto the plate. 
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Designating the composition’s orientation 

1. Click the Engraving properties tab in the Material dialog box. 

2. Click the orientation suited to the material being engraved and the composition's dimensions. 

Any orientation is possible, provided each dimension is less than or equal to the height of the engraving area. 

 
The other dimension will not exceed the height of the engraving area. 

 
Normal if the length of the composition 
exceeds the height of the engraving area. 

90°-rotation if the height of the 
composition exceeds the height of the 
engraving area. 

Upside to directly 
engrave the 
material's surface. 

    

  

  

Reversed to 
engrave materials 
that have a 
transparent upper 
layer (Gravoglas 2). 

    

  

  

 



Material mode 

43 

 

Setting the parameters for engraving on a cylinder 

 Consult the Gravograph manuals enclosed with your machine and the cylinder engraving 

accessory. 

 

Set the dimensions and margins. 

 If one of the composition’s dimensions exceeds the 
height of the engraving area, a message will ask you to 
confirm dimensions selected that are greater than the 
engraving area’s dimensions.   

Yes  Click to configuring the composition on a cylinder. 

 

1. Click the Engraving properties tab in the Material dialog 
box. 

2. Set the composition’s floating origin (default setting: 
center). Key in only its X coordinate in the engraving area. 
The Y coordinate, which equals half the height of the 
engraving area, remains fixed. 

 

3. Click to activate the cylinder 

engraving. 

4. Select the engraving accessory in the Cylinder engraving 
dialog box. 

 

TC for the cylinder attachment 
TS for the pen attachment 

5. Key in the diameter of the cylinder. 

 

It has to be between the 
minimum et maximum 
diameters accepted by the 
accessory selected. 

6. Click. 
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 TS   TC  The name of the active accessory will be displayed as a button in the Machining dialog box. 

 Preview  Click to open the engraving preview. The following are displayed using blue dotted lines 

• the axis of symmetry of the cylinder attachment, for which the 0 point is centered on the height of the 
engraving area (Y coordinate). 
• the successive rotations of the cylindrical part, at a rate calculated based on the part’s diameter. 
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Checking the composition’s configuration 

1. Configure the composition. 

2. Click the Engraving properties tab in the Material dialog box. 

3. Note the comments in the Info zone and act accordingly: 

 
 

Your configuration is correct: the composition (red frame) remains in the 
engraving area (gray surface). 

 
 

The composition is physically outside the engraving area. However, its 
surface area does not exceed the engraving area. 

Correct the composition's orientation or origin. 

Configure the composition 
• for cylinder, if your machine is equipped with this accessory. 

• for long plate. 

 

It is impossible to engrave: the composition’s surface area exceeds the 
engraving area in both length and height. 

Correct the composition's dimensions. 

Designate a target machine that offers a larger engraving area. 

Maximum number of plates If you are producing a Matrix series, this value indicates the total number 
of elementary plates that you can engrave in the engraving area according 
to the standard plate’s configuration. 
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Text mode 

Working in Text mode 

This mode becomes active whenever you create a blank composition. You can type text right away. 

1. Click in the toolbox to activate Text mode. 

2. Activate the mode you will be using to place text. 

3. For each line of text, set the following in the Text palette or in the Rapido: 

 the parameters used to position it in the composition 

 the attributes that determine the text’s appearance (underlining, italics, exponent) 

4. Type the text. 

You can also use the Advanced Text functions (non-horizontal text, Font Editor, etc.). 

 Shifting into Text mode results in all the text belonging to the last Text object modified being 

selected automatically. 
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Placing text in automatic/manual mode 

Automatic mode (active default setting) 

Remain in automatic mode so you can quickly frame the horizontal text in 
the composition. 

The margins delimit the zone reserved for a paragraph of horizontal lines 
of text, systematically distributed and centered between the top and 
bottom margins. 

 Once manual mode is activated, automatic mode can no longer 

be reestablished. 

 Shifting from automatic mode to manual mode converts each 
existing line of text into an independent Text object. 

 

Manual mode 

Activate the manual mode to 
• place several Text objects over the entire surface area of the 
composition. 
• create non-horizontal text using the Advanced Text functions (text in 
an arc, vertical text, etc.). 

The margins are cleared. For each text object, either key in these line 
parameters or position the line in the composition with the mouse. 

Click in the Text palette. 

Click Auto/Manual in the Modify/Text menu. 

Click in the Advanced Text palette. 

 Yes  Click to confirm the activation of the manual mode. 
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Text palette 

This palette offers the line parameters and text attributes commonly used to place and present a line of text. 

Click to use advanced functions in powerful Rapido palettes. 

Line parameters 

 Automatic/manual mode 

 Distance to top margin 

 Distance to left margin 

 Maximum available length 

 Height 

 Left/Center/Right/Full Text alignment 

Text attributes 

 Font 

 Italics text 

 Underlined text 

 Exponent text 

 Manual kerning 
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Rapido palettes 

These four palettes add advanced text attributes and line parameters. 

1. Click in the Text palette. 

2. Click the Display/Hide Rapido command in the Modify/Text menu. 

In the selector, click the relevant color to display a palette. 

 

Green Rapido: basic attributes and 
parameters 

 Font 

 Text alignment 

 Text height 

 Character width 

 Italics/Slant text 

 Active font content 

 

Yellow Rapido: advanced text 
attributes 

 Character rotation 

 Character spacing coefficient 

 Position of the underlining 

 Text entry from right to left 

 Uppercase/Small caps/Lowercase 

 Index or exponent text 

 Text on or under the baseline 

 Auto-kerning 

 

Blue Rapido: advanced line 
parameters 

 Distance to top margin 

 Distance to left margin 

 Maximum available length 

 
Constant/Proportional/Typographical Line 
spacing 

 Compression auto. per line or all lines equal 

Red Rapido: Styles 
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Position between margins 

Positioning a line of text 

The line parameters define the position of a line of text between 
the margins. 
The default sets the characters in a line of text on a horizontal 
baseline  
The length of the baseline is equal to the distance between the 
left and right margins: 
• Its left end is on the left margin. 
• Its right end is on the right margin. 

• The active parameters apply to a new line of text. 
• To modify the parameters of an existing line, click the line first. 

• If the new parameters increase the length of the text typed in 
relation to the length of the baseline, the text is automatically 
compressed. 

 

Set basic line parameters in the Text palette.  Text alignment 

 Distance to left margin 

 Maximum available length 

 Height 

Set advanced line parameters in the Rapido.  Distance to top margin 

 Position of the text on its baseline 

 Line spacing 

 The line parameters react differently depending on whether you place the lines of text 

in automatic mode. 

in manual mode. 

 These parameters also apply to lines of text presented on a non-horizontal baseline (text in arc, 

vertical text, etc.). 
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Aligning the text on its baseline  

 

Line parameter F4 designates the point on the 
baseline where the text is aligned (default setting: centered). 

 
Center alignment: the text is 
displayed on both sides of the 
center of the baseline. Press until the required button is depressed in the Text 

palette. 

Click the alignment selected in the Green Rapido.  
Left alignment: the text is aligned 
with the left side of the baseline. 

 
Right alignment: the text is aligned 
with the right side of the baseline. 

 
To stretch the text from one end of 
the baseline to the other, click Full 
alignment. 

 



Text mode 

53 

Defining the distance from a line of text to the left margin 

 

Line parameter F3 sets the position of alignment point F4 
between the left and right margins. 

By modifying distance F3, you move: 

the center of the baseline  

the left end of the baseline 

the right end of the baseline 

Entering distance F3 in the Text 
palette 

1. Click the icon to designate the calculation mode for distance 
F3: 

from the left margin (default mode) 

from the right margin 

from the left edge 

from the right edge of the composition 

2. Select the numeric value in the editing box. 

3. Key in a value that falls between the left margin and the 
distance from the left edge to the right margin of the 
composition. Validate. 

Setting distance F3 in the 
composition 

Key in the X coordinate for the alignment point. 

or 

1. Display the rulers. 

2. Using the shifting index displayed in the horizontal ruler as a 
reference, click the position of the alignment point. The X 
coordinate will be displayed in the status bar. 
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Defining the maximum available length for a line of text 

 

Line parameter F5 displays the length of the baseline or the 
maximum available length for typing text  
This value is recalculated depending on distance F3. By modifying 
the maximum available length, you move 

the ends of the baseline in relation to its center 

the right end in relation to the left end 

the left end in relation to the right end 

Entering length F5 in the Text palette 
or in the Blue Rapido 

1. Select the numeric value in the editing box. 

2. Key in an F5 length that is at most equal to the default 
length. Validate. 

Forcing auto-compression 

Automatic compression occurs as soon as 
the length of the typed text exceeds the 
length of the baseline. This event is 
indicated by a beeping sound and a 
negative coefficient, which is displayed in 
red. 

This default coefficient is zero. This 
variation in the character width and 
spacing is proportional to the text height. 

1. Select the lines of text. 

2. In the Blue Rapido, click the appropriate compression mode 
button. Validate. 

Compression per line 
By default, the automatic compression coefficient remains specific 
to each line of text. 

Compression all lines equal 
The maximum automatic compression coefficient applies to all 
lines. 
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Defining the height of a line of text 

 

The parameter F12 is measured from the baseline to the top of 
the character; the foot of each lowercase letter placed beneath 
the baseline is generally not taken into account. 
The default setting for value F12 is 10 mm. 

As the text height can vary, the line height is equal to the 
height of the largest uppercase character. 

Entering height F12 in the Text palette 
or in the Green Rapido 

1. Select the numeric value in the editing box. 

2. Key in a value between 0.01 mm and the available height. 

Validate. 

 
The available height is the space remaining between the top and 
bottom margins, in relation to the heights of the existing lines. 

 
The available height is the distance from the baseline to the top 
margin. 

Customizing the default height 1. In the Options dialog box, click the Text attributes tab. 

2. Key in a value between 0.01 mm and the available height 

in the composition. Validate. 
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Defining the distance from a line of text to the top margin 

 

Line parameter F2 defines the position of alignment point F4 
between the top and bottom margins. 

The default setting for value F2 is equal to distance F2 for the 
preceding line, increased by the space produced by the 
proportional line spacing. 

Activate manual mode to define distance F2. 

Entering distance F2 in the Text 
palette 

1. Click the icon to designate the calculation mode for distance 
F2 

from the top margin (default mode) 

from the bottom margin 

from the top edge 

from the bottom edge of the composition 

2. Select the numeric value in the editing box. 

3. Key in a value such as the distance from the baseline to the 
top margin, which should be at least equal to the line 
height envisaged. Validate. 

Setting distance F2 in the composition Key in the Y coordinate for the alignment point. 

or 

1. Display the rulers. 

2. Using the shifting index displayed in the vertical ruler as a 
reference, click the position of the alignment point. The Y 
coordinate will be displayed in the status bar. 

 



Text mode 

57 

Positioning the text on its baseline 

 

The default setting is for the text to rest on the baseline; there is no offset 
between the baseline and text. 

Click the position needed in the Yellow Rapido. Validate. 

Text on the baseline 

Text under the baseline 

To set the offset proportional to the line height, key in a coefficient value of -100% 
to +100%. Validate. 
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Setting the line spacing in a paragraph 

You can set the distance between the baselines for two consecutive lines of text. 

1. Click a line spacing mode in the Blue Rapido. 

2. Key in the line spacing coefficient. Validate. 

 A coefficient that is too low may cause overlapping between the foot of each of the lowercase 
letters placed beneath the baseline and the text on the following lines. 

The line spacing coefficient can be reduced to free up the space required for a new line. 

Proportional line spacing (active 
default setting) 

The line spacing is proportional to the 
average height of two consecutive lines. 
The default line spacing coefficient is 75%. 

In the Blue Rapido, key in a line spacing coefficient value of 0% 
to 400%. 

75% 0% 

Constant line spacing 

The line spacing is a set distance, which is 
set by default at 75% of the height of the 
first line. 

In the Blue Rapido, key in a value that is less than the distance 
between the top and bottom margins. 

Typographic line spacing 

The line spacing is proportional to the 
average height of two consecutive lines. 
The default line spacing coefficient is 
100%. 

Adapted to True Type fonts, this mode 
eliminates the risk of 2 consecutive lines 
overlapping. The line spacing calculation 
takes account of the actual height of the 
characters (including ascenders and 
descenders). 

In the Blue Rapido, key in a line spacing coefficient value of 0% 
to 400%. 

100% 0% 

 



Text mode 

59 

Type 

Typing text 

The cursor, which is represented by a red vertical line, indicates your position in the text. 

 Typing characters 

 Moving around in the text - Selecting text 

 Editing text 

 Spell checking 

 Text in Braille 

Using text from an external document 

This method eliminates any need for you to type the text in GravoStyle. The only drawback is that it cancels 
the text attributes which you redefine. 

1. In your word processing software, open the document that contains the text to be recovered. 

2. Select and copy the text. 

3. Click the composition. 

4. Click in the composition on the spot where you want to insert the text selected  

5. Paste the text:  click in the main toolbar. 

 



GravoStyle 5 User Manual 

60 

Typing characters 

Text Balloon 

This balloon allows you to zoom in on the text you are 

typing. 

1. Click the Text attributes tab in the Options 
dialog box. 

2. Actuate the Bubble time function for a set period 
• of between 1 and 6,000 ms. 
• of 0 to deactivate the balloon. 

Text entry from right to left 
Click in the Yellow Rapido to activate the function. 

Inserting with the mouse a. Display the content of the active font by 
clicking in the Green Rapido. 

b. Click in a line of text. 

c.  Insert  Click. 

Typing an upper case letter 

With the key depressed, type the character. 

Typing in upper case mode 

Press the key again to type in lower case mode.  

Typing figures using the numeric keypad 

Press the key again to deactivate the function.  

Typing a character in the upper left-hand 

corner of a key With the key depressed, type the character. 

Typing a character in the lower right-hand 

corner of a key With the key depressed, type the character. 

Typing an accented character Type the accent and then the character. 

For example: to type ö, then  

Typing a tab 

Unengraved character  
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Moving around in/Selecting text 

Moving around in text  

Using the mouse Click the new position for the pointer (distinct line of 
text, start of line, end of line, or between two 

characters). 

from one character to another 
 

from one line to another 
 

to the start of the line 
 

to the end of the line 
 

to the end of a Text object 
 

to the end of a Text object 
 

Selecting text 

Place the pointer at the start of the selection. 

Selected text is red and grey-highlighted to prevent any confusion with text that has been assigned the red 
path color. 

To select a word 

Double-click that word. 

To select a series of characters in a paragraph 

Slide the text pointer from the first to the last 
character. 

The selection may extend over several lines. 

 

To select the character preceding the pointer 

With the key depressed, press  

To select the character that follows the 

pointer With the key depressed, press  

To select all the characters preceding the 

pointer With the key depressed, press  

To select all the characters that follow the 

pointer With the key depressed, press  
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Editing text 

Place the pointer where you want to edit the text. 

Inserting the text Type the text. 

Inserting a line in the middle or at the 
end of a paragraph  

Deleting the character in front of the 
pointer  

Deleting the character behind the 
pointer  

Unknown character 

1. Delete this character: the key or the combination of keys 
pressed does not match any character in the font selected. 

2. Display the font’s content. 

3. If the active font contains the character sought after, click 
the character to insert it in the text. 

Otherwise, select another font. 

Select the text, if a series of characters are involved (a word or line). 

Replacing the text selected Type the new text. 

Copying/Cutting 

Duplicate the text in the composition. 1. Copy the selection:  click in the main toolbar. 

2. Click the spot where you want to paste the selection. 

3. Click. 

Cutting/Pasting 

Move the text in the composition. 1. Cut the selection:  click in the main toolbar. 

2. Click the spot where you want to paste the selection. 

3. Click. 

Delete Click the Delete command in the Edit menu. 

Press the key. 
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Using the Spell-checker 

1. In the Options dialog box, click tab Spell-Checker. 

2. Click the language of the Dictionary used to check the text. 

3. Click. 

4. Select the text to be checked. 

5. Click in palette Advanced Text. 

The Spelling dialog box opens when an error is found: each unknown word is displayed in box Not in the 
dictionary. 

 Ignore   
Click to skip the correction. 

 Add  
Click to add the unknown word to the dictionary. 

 Change to   
Click to replace the unknown word with the word in box Change: 

Type in the correct. 

Click a word from the list of Suggestions. 

 Suggestion   
Click to display a new list of suggestions. 

 Cancel   
Click to close the dialog box. 
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Typing text in Level 1 Braille 

 

Braille is a system of writing and reading embossed points by 
hand which is used by people with poor eyesight. 
Each Braille character or cell is obtained from a combination of 
6 embossed points. The number and the position of the points 
differentiate one cell from another. 

Typing text in Level 1 Braille 

Each character typed comprises a cell in the 
Braille font selected. 

If they do not appear in the font 
menu, install these fonts in Windows. 

1. Select a font 

Braille, NHBraille for California and USA, 
Simbraille 

Braille 

2. Type the text. You can manipulate this Text object as 
you please. 

3. Display the engraving paths. 

Writing in Level 2 Braille This option allows you to type and translate a word into its 
Braille equivalent in compliance with US A.D.A. standards.  
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Appearance 

Choosing the text’s appearance 

The text attributes determine the appearance of the characters. 
You can apply attributes specific to certain characters in the same line of text. 
• The active attributes are applied to the text subsequently typed. 
• To modify the existing text attributes, select the text. 
• If the new attributes increase the length of the text typed in relation to the baseline, the text is automatically 
compressed. 

Set the basic attributes in the 
Text palette. 

 Font 

 Exponent text 

 Underlined text 

 Italic text 

Set the advanced attributes in 
the Rapido. 

 Character width 

 Character spacing 

 Character rotation 

 Index text 

 Uppercase/lowercase 

 Auto-kerning 

Applying a style. Associate several text attributes to create and save styles common to 
several lines of text. 
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Police 

Selecting the active font 

If the list does not contain the font needed, 
install a Gravograph font. 

1. Click to pull down the font menu in the 

Text palette or in the Green Rapido. 

2. Click the folder that the font needed belongs to. 

3. Click the font in the pull-down alphabetical list. For a 
fast search, type the first letter of the font name. 

Gravograph  Gravograph characters, which were designed for 
engraving, have open contours. 

SL513 fonts group the international characters available in 
the Gravograph fonts. 

True Type  True Type characters are made from closed contours, that 
delimit full surfaces to be hollowed out during engraving. 

Vision Numeric  
Asian fonts for the People’s Republic of China, Japan and 
Korea 

Choosing a font when typing text 

 By default, the first nine characters are 

displayed opposite the font name. 
If the option is active, the text typed in 
the Options dialog box appears as a 
sample. 
Select the text in the composition to be 
displayed as a sample in the font menu. 

Your text is shown as example for each font that 
contains the characters selected. 

 

1. Tick the preference Text sample in Font selector 

tab from Options dialog box. 

2. Close dialog box. 

3. Select the text. 

4. Pull down font menu in Text palette or in 

Green Rapido. 

 

Active font content 
1. Click in the Green Rapido. You can select another 

font. 

2. Select the category of characters to be displayed 
(Latin is the default category). 
The categories suggested belong to the Windows 
classification for UNICODE characters. 

3. To zoom in on a character, place the pointer on it. 

4.  Close  Click to exit the preview. 
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Customizing the default font The default font is the active font for each new 
composition. It is displayed at the end of the fonts menu. 
The default font replaces the missing fonts so that the text 
can be displayed when a composition is opened. 

1. Click the Text attributes tab in the Options dialog 
box. 

2. Select a font. 

Customizing the font menu Click the Font selector tab in the Options dialog box. 

Displaying font sample 1. Click to display the Fonts sample after each font 

name. 

2. Type the text displayed as an example. 

Displaying current fonts Click option 

Last fonts used to display the last fonts used. Key in a 

Number of fonts falling between 1 and 5. 

Favorite fonts to display a set of fonts regularly used: 

click each font to be selected. 
For a fast search, click in the list and type the first 
character in the name. 
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Underlined text 

 

Applying the text attribute 
Click in the Text palette. 

Press the key. 

Modify the position of the underlining 

The underlining is placed underneath the 
baseline at a distance proportional to the 
height of the underlined text. 
The default setting for the space between 
the underlining and the baseline is zero. 

1. Click in the Yellow Rapido. 

2. Key in a coefficient from -250% to +250%. Validate. 
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Italics/Slant text 

 

Applying the text attribute 
Click in the Text palette. 

Press the key. 

Customizing the default slant 

The text’s default slant is 15°. 
1. Click in the Green Rapido. 

2. Key in a slant angle from -80° to +80°. Validate. 

Customizing the default slant 1. Click the Text attributes tab in the Options dialog box. 

2. Key in a slant angle from -80° to +80°. Validate. 
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Exponent/Index text 

 

Implementing exponent text 

 The Exponent attribute 

automatically cancels the Index 
attribute and vice versa. 

Click in the Text palette or in the Yellow Rapido. 

Press the key. 

Switching to index text 
Click in the Yellow Rapido. 

Customizing exponent/index text Click the Text attributes tab in the Options dialog box. 

The default exponent/index text height is 
50% of the F12 value entered. 

Key in a coefficient no greater than 100%. 

The default distance between the baseline 
and the exponent/index text is 50% of its 
height. 

Key in a coefficient 

from 0% to 100% 

from -100 to 0% 
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Character width 

 

Applying the text attribute 

The character width is proportional to the 
text height. The default coefficient is 
100%. 

In the Green Rapido, key in a coefficient from –1,000% to 

+1,000%. Validate. 

Customizing the default width 1. Click the Text attributes tab in the Options dialog box. 

2. Key in a coefficient from –1,000% to +1,000%. Validate. 
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Character spacing 

 

The character spacing is proportional to the text height. The default spacing coefficient is 100%. 

1. Click in the Yellow Rapido. 

2. Key in a coefficient falling between 0% and 500%. Validate. 
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Character rotation 

 

Applying the text attribute 

The default rotation angle is zero. All the 
characters are flat on the baseline. 

In the Yellow Rapido, key in an angle from 0° to 360°. 

Validate. 

Customizing the default rotation angle 1. Click the Text attributes tab in the Options dialog box. 

2. Key in an angle from 0° to 360°. Validate. 
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Uppercase/Lowercase Function 

Click the type of case in the Yellow Rapido: 

 
Lowercase 

 Small caps 

 Uppercase 
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Auto-kerning between characters 

 

Each font has a standard auto-kerning table that 
defines the space for different pairs of characters. 
The space between two characters depends on 
• the width and the spaces to the left and right of each 
character (distance in blue). 
• the space created by automatic or manual kerning 
(distance in red). 

Auto-kerning 

When several spacing modes are applied in 
the same line of text, the button is shaded gray. 

1. Select the text whose spacing you want to correct. 

2. In the Yellow Rapido, click as needed to select 
the kerning mode. 
The buttons with a red dot indicate a mode in 
which auto-kerning is active. 

3. Validate. 

  
Applying auto-kerning 

  
Cancelling auto-kerning 

  
Applying auto-kerning and removing the 
spaces to the left and right of the character 
This mode allows characters to be linked, 
particularly for jeweller fonts (Vanessa for 
example). 

  
Cancelling auto-kerning and the spaces to 
the left and right of the character. 

 

 
Applying a fixed footprint, calculated based 
on the uppercase M 
This mode allows the characters to be aligned 
vertically between 2 consecutive lines of text. 

Spacing 2 characters by hotkeys (manual 
kerning proportional to the height of the first 
character) 

 

 

Text palette displays the final number of spaces 
added or deleted. 

1. Select the character for which you want to set 

the spacing with the next character. 

2. Type or to add or to 

delete as many spaces as Control +/- number 
keyed in Text Attributes tab from Options dialog 
box. 
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Styles 

Click in the Text palette. 

Click the red button in Rapido selector to display the Red Rapido. 

 

Creating a style 1. Define all the text attributes that you want to apply. 

2. Key in the style name in the editing zone. 

3.  Save  Click. 

Creating a style The last style used is active. 

1. Click the style. 

2.  Apply  Click. 

Applying the current style 1. Select the text that has the style to be applied. 

2. Click. 

3. Slide the pointer over the text you want to change the style 
of. 

4. Click once again to deactivate the current style. 

Deleting a style 
1. Click. 

2.  Delete  Click. Validate. 
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Advanced Text 

Using the Advanced Text functions 

Click a function in the Advanced Text palette or in the Modify/Text menu. 

Free horizontal text 

Text in a rectangle 

Slant/Diagonal Text 

Vertical text 

Text on a curve  

Text in an arc 

Text in Columns 

These functions offer new line parameters which 
enable the text to be presented on a non-horizontal 
baseline. 
To modify the parameters of an existing line, click the 
line first. 

Convert to curves 

This function allows text to be converted into 
geometrical shapes. 

Font Editor 

This option makes it possible to create your own fonts 
based on a standard Gravograph font or a set of 
logos. 

Spell-Checker 

When the text has been keyed in, ask the spell-
checker to look for typographical errors. If it detects a 
possible mistake, you can correct it, and then 
continue checking. 
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Designing text in a rectangle 

You can key in text within a rectangle that has dimensions you define. 

 The line parameters are calculated in relation to the edges of the 
rectangle, and not in relation to the composition. 

 

1. Switch to manual mode: click in the Advanced Text palette. 

2.  Yes  Confirm the mode change. 

3. Click in the Advanced Text palette. 

4. Shape the rectangle: 

Slide the pointer and release it when the rectangle reaches the desired size and position. 

Open the Rectangle dialog box: 

a. Click the position of the center of gravity. 

b. Enter the coordinates of the center of gravity in the work area. 

c. Enter the width and the height of the rectangle. 

5. Type the text: you will obtain a Text object consisting of one paragraph. 
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Designing slant/diagonal text 

New line of text 

To select the text, slide the text pointer, following 
the slant of the baseline. 

 

1. Switch to manual mode: click in the Advanced 

Text palette. 

2.  Yes  Confirm the mode change. 

3. Open the Slant/diagonal text dialog box:  

click in the Advanced Text palette. 

4. Provide the alignment point’s position: 

 

a. Key in the X coordinate 
between the left and right 
margins; this value is entered 
in distance F3. 

b. Key in the Y coordinate 
between the top and bottom 
margins; this value is entered 
in distance F2. 

5. Key in an angle value from -180° to +180°. 

This parameter, which has a default 
setting of zero, determines the direction and the end 
of the baseline. 

6. Click the text orientation: 

To slant the text using the same angle 

To restore horizontal text 

7. Click. 

8. Type the text: you will obtain a Text object 
consisting of one paragraph. 

Cancelling slant/diagonal text 1. Click a line of slant/diagonal text. 

2. Click in the Advanced Text palette. 

3. In the Slant/diagonal text dialog box, key in an 
angle of 0. 

4. Click. 
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Other line parameters in the Text palette: The default setting is for the ends of the baseline to be 
on the margins that cut through this line. 

Aligning the text 
The text is displayed on both sides of the center of 

the baseline. 

Left alignment – the text is placed up against the left 
end. 

Right alignment - the text is placed up against the 
right end. 

Distance F3  
Alignment point’s X coordinate 

Distance F2  
Alignment point’s Y coordinate 

Length F5  
If you modify this parameter, you will move 

the ends of the baseline 

the right end 

the left end 

Height F12  Check that the line height is less than the distance from 
the baseline to the closest margin. 
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Designing vertical text 

New line of text 

To select the text, slide the text pointer 
from the top to bottom. 

 

1. Switch to manual mode: click in the Advanced Text 

palette. 

2.  Yes  Confirm the mode change. 

3. Open the Vertical Text dialogue box:  click in the 

Advanced Text palette. 

4. Provide the alignment point’s position: 

 

a. Key in the X coordinate between the 
left and right margins; this value is 
entered in distance F3. 

b. Key in the Y coordinate between the 
top and bottom margins; this value is 
entered in distance F2. 

5. Click. 

6. Type the text: you will obtain a Text object consisting of one 
paragraph. 

Other line parameters in the Text 
palette: 

The default setting is for the ends of the baseline to be on the top 
and bottom margins. 

Aligning the vertical text 
The text is centered on the baseline. 

Top alignment – the text is placed up against the top. 

Bottom alignment - the text is placed up against the bottom. 

Distance F3  Alignment point’s X coordinate 

Distance F2  Alignment point’s Y coordinate 

Length F5  
If you modify this parameter, you will move 

the ends of the baseline 

the bottom 

the top 

Height F12  Check that this value is less than the length resting on the 
baseline in relation to the character heights keyed in. 
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How to design vertical text on a non-vertical baseline 

Click on a line of vertical text. 

Slanted baseline 

1. Click in the Advanced Text palette. 

2. Key in an angle value from -180° to +180° 
in the Slant/diagonal text dialog box. 

3. Click: the baseline will pivot, while 
the text will remain vertical.  

Baseline in an arc 

1. Click in the Advanced Text palette. 

2. Key in the parameter for the text in an 
arc in the Arc dialog box. 

3. Click: the text will remain vertical in 
relation to the baseline. 
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Designing text on a curve  
Function 

You will obtain a 

Text object with a 
single line. 

To select the text, 
slide the text pointer 
along the baseline. 
If you edit the 
shape, the text will 
follow its new line. 

1. Draw the shape that will be used as the baseline (a curve, rectangle, or ellipse). 

2. Check that the direction of this contour matches the display desired for the text. If 
needed, invert the contour's direction. 

 
 

 

The text is displayed 
clockwise on the 
outside of a closed 
contour drawn in a 
clockwise direction. 

The text is displayed 
counterclockwise on the 
inside of a closed 
contour drawn in a 
counterclockwise 
direction. 

The text is displayed on an 
open contour, running from 
the start point to the end 
point. 

3. Switch to manual mode: click in the Advanced Text palette. 

4.  Yes  Confirm the mode change. 

Existing line 

of text 
5. With the key depressed, 

click the line of text, then click the 
shape. 

6. Click in the Advanced Text 

palette. 

 
 

New line of 

text 

5. Click in the Advanced 

Text palette. 

 

6. Click the baseline dotted. 

 

7. Type the text. 
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Moving text 
along curve 

1. Click a line of text on a curve. 

2. Click in the Advanced Text 

palette. 

3. Move the text: 

Slide the text along the 
curve. 

Open the Positioning 

text on curve dialog box: key in 
the distance to shift the text in 
relation to 

the curve start point. 

the current text start point. 

 

 

Aligning the text  on an open contour 

against the left end of the contour 

against the right end of the contour 

centered on the contour 

 on a closed contour 

to the left of the start point 

to the right of the start point 

centered on the top, opposite the start point 
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Text in an arc 

Designing text in an arc 

New line of text 

To select the text in an arc, slide the text pointer 
along the curve of the arc. 

 

1. Switch to manual mode: click in the 

Advanced Text palette. 

2.  Yes  Confirm the mode change. 

3. Open the Arc dialog box:  click in the 

Advanced Text palette. 

4. Construct the arc of a circle to be used as a 
baseline (the small square window displays a 
preview of the arc constructed). 

5. Set the following line parameters: 

Orientation of text in arc 

Start angle – End angle 

6. Type the text: you will obtain a Text object with a 
single line. 

Cancelling text in an arc 1. Click a line of text in an arc. 

2. Click in the Advanced Text palette. 

3. In the Slant/diagonal text dialog box, key in 
an angle of 0. 

4. Click. 

Other line parameters in the Text palette:  

Justifying text in an arc clockwise 
The text is centered on the apex of the arc. 

The text is placed up against the start angle. 

The text is placed up against the end angle. 

Distance F3  X coordinate for the apex or the center of the arc 

Distance F2  Y coordinate for the apex or the center of the arc 

Length F5  
To set length F5 available for the text, modify the start 
or end angle. 

Height F12  Check that the line height is lower than 
• the distance from the arc’s circumference to the 
closest margin, if the text is written outside the arc. 
• the arc’s radius, if the text is written inside the arc. 
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Constructing the baseline for text in an arc 

Regardless of the procedure selected for constructing the arc, you will obtain an arc or a circle with 
• a direction that determines the orientation of the text. 
• an aperture that is defined by the start and end angles. 

 Entering the chord and the height of the arc leads to the corresponding center and radius being 

calculated and vice versa. 
If you define an arc by its chord and its height, access to its center and its radius will be 
prohibited, and vice versa. 

 Reset  Click to cancel the values entered and restore access to all the dialog box parameters. 

Constructing an arc by its chord and 
height 

The chord is the distance between the two 
ends of the arc. 
The height is the distance from the center 
of the chord to the arc’s apex. 
The chord and the height of the arc are 
measured from the arc’s apex, which is 
pinpointed in relation to the composition’s 
left and upper edges. 

1. Provide the position of the apex of the arc in the Text 
palette: 

a. Key in distance F2. 

b. Key in distance F3. 

2. Key in the arc’s chord and the height in the Arc dialog box: 

a. Key in a chord 
• that is at most equal to double the distance from the 
center of the chord to the closest margin (left or right). 
• zero, so you obtain a circle. 
• equal to double the height, so you obtain a semi-circle. 

b. Key in a height that is at most equal to the distance 
from the center of the chord to the closest margin (top 
or bottom). 

Constructing an arc by its center and 
radius 

The center of the arc is located in relation 
to the composition’s left and upper edges. 
The radius is the distance from the center 
of the arc to each point in its 
circumference. 

1. Provide the position of the center of the arc in the Arc 
dialog box. 

a. Key in an x coordinate that is at most equal to the 
distance between the right margin and the left edge. 
This value is entered in distance F3. 

b. Key in an y coordinate that is at most equal to the 
distance between the bottom margin and the upper 
edge. This value is entered in distance F2. 

2. Key in a radius, that is not zero, which at most is equal to 
the distance from the center of the arc to the closest margin. 
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Placing text in an arc 

Orientation 

In the Arc dialog box, click the 
Orientation that matches 
• the display direction for the text in an 
arc. 
• its position in relation to its baseline. 

Text displayed clockwise counterclockwise 

outside the arc 

  

inside the arc 

  

Start angle – End angle 

The arc begins on the start angle and stops 
on the end angle. These angles determine 
the arc’s aperture and length. 
They are calculated automatically in 
accordance with the arc's construction and 
the text orientation. 

Key in a negative value (0 to -180°) or a 
positive value (0 to +180°) in the Arc 
dialog box. 

Start = -90° 

End = +45° 

 
 

Start = +90° 

End = -45° 
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Text in columns 

Designing text in columns 

1. Switch to manual mode: click in the Advanced Text palette. 

2.  Yes  Confirm the mode change. 

3. Click in the composition. 

4. Open the Text in Columns dialog box:  click in the Advanced Text palette. 

5. Key in the Text height. 

6. Click the text in columns creation Mode: 

Setting on baseline to make columns 

Setting in table to make a table 

7. Key in the parameters of the text in columns 

8. Set the engraving parameters for the borders around the text. 

9.  Finish  Click to generate the Text in Columns object. 

10. Type the text. 

11. Display engraving paths. 

 Horizontal line parameters are calculated in relation to the columns, and not in relation to the 

composition. 

How do you convert a Text object into a Text in Columns object? 

1. Click the Text object. 

2. Click in the Advanced Text palette. 

3. Key in the parameters for the text in columns by executing the procedure above from step 5. 
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Setting columns of text 

 

From the first line of text in the first column, the lines of text 
are distributed across several columns. 
The lines can be framed using borders. 

1.  Next>  Go to step Setting on baseline in the Text in Columns dialog box. 

2. In zone First baseline, enter the 
position for the first line of text and the 
total number of lines of text: 

 

a. Click the origin of the first line of text (center, left or 

right) and key in its coordinates  

b. Key in the Number of rows and the Number of 

columns  

3. In Columns area, enter the properties 
for each column created: 

 

a. Key in the Column width. To obtain different width-
columns: 

 Click box Same column width. 

 Select the Column # using the cursor  

 Key in each Column width. 

b. Key in the Text width less than the column width. 

c. Key in the Line spacing between two consecutive 
baselines less than the text height. 

d. Click the Text alignment on its baseline  

You need no Borders: e. Untick box Borders. 

f.  Finish  Click. 

g. Type the text. 

You are engraving the Borders of the 

columns: 

e. Click box Borders. 

f. Key in the Left margin between the left end of the 
baseline and the column’s left border. 

g. Key in the Bottom margin between the baseline 

and the horizontal border separating it from the next line. 

h.  Next>  Click to add borders. 
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Setting text in a table 

 

Each line of text is displayed in a table cell. You define 
the columns and the rows. The borders are added 
automatically. 

1.  Next>  Go to step Setting in a table in the Text in Columns dialog box. 

2. In zone Setting in table, enter the position of 
the first cell and the total number of cells: 

 

a. Click the origin of the first line of text (center, left 

or right) and key in its coordinates  

b. Key in the Number of rows and the Number of 

columns  

3. In Columns area, enter the table properties: 

 

a. Key in 
the table's Frame width. 
or 
the Column width. To obtain different width-
columns: 

 Click box Same column width. 

 Select the Column # using the cursor 

 

 Key in each Column width. 

b. Key in 
the table's Frame height. 
or 
the Cell height. 

c. Click the Text alignment in the column  

4. In zone Cell, enter the cell parameters: 

 

a. Key in 

the Left margin, which is by default equal to 15% 
of the column width. 
or 
the Text width, which is by default equal to 70% of 
the column width. 

b. Key in the Bottom margin between the 
baseline and the cell’s lower border. 

5.  Next>  Click to add the table's borders. 
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Adding borders to text in columns 

1. Place the text in columns or in a table. 

2. Go to step Strokes and borders in the Text in Columns dialog box. 

3. Click 

the type of lines to be marked out or masked  

the border to be marked out or masked (a masked border is shown as a dotted line). 

4. Select the Path that will be used to machine the borders of the text in columns. 

5.  Finish  Click to generate the columns or the table. 

6. Type the text. 
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Typing text in columns 

Typing by column 

Text in columns is displayed from top to bottom and from 
left to right. 

 

1. Click the first line’s baseline. 

2. Type the text. 

3. Press to type the text on the following 

line. 

Selecting a line 

You can edit the text independently of the other lines. 

 

Press until the pointer is placed on the 

baseline. 

Click its baseline. 

 

Offsetting text to the right 

From the line selected onwards, the text in each line 
replaces the text on the following line. 

 

1. Select a line. 

2. With the key depressed, press 

 

Offsetting text to the left 

From the line selected, the text in each line replaces the 
text on the preceding line. 

 

1. Select a line. 

2. With the key depressed, press  
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Font Editor 

Managing your fonts in the Font Editor 

Option for ALL levels 

This option allows you to create your own fonts based on a standard Gravograph font or a set of logos. 

1. Run the Font Editor:  click in the Advanced Text palette. 

2. Create new font or select a font to be edited. 

 You are working in an unlimited work area  
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Creating a font 

1. Open the Font Editor dialog box:  click in the Advanced Text palette. 

2. Click a Gravograph font if you are creating from a model. 

3.  New Font  Click. 

4. In the New Font dialog box, type the Font Name (11 characters maximum). 
The font is saved as a file stored in the FONTS folder. The file name includes FE, followed by the name 
of the font and the .chr extension. 

5. Click. 

6. Edit the new font. 

This appears at the end of the font menu. 
Its name is followed by FE, which identifies it as a font created using the Font Editor. 
The next time GravoStyle is run, the new font will be listed in alphabetical order. 

 Each time you select a Gravograph font to create your own font, the Font Editor saves a copy of 
the Gravograph font. You can use a Gravograph font without modifying it. 
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Editing a font 

1. Open the Font Editor dialog box:  click in the Advanced Text palette. 

2. Click a font with FE in its name (these letters distinguish fonts you created in the Editor from 
Gravograph fonts). 

3. Click. 

4. In the RapidFont dialog box, click the button relating to the procedure that you are going to execute: 

Create a character 

Add a character 

Delete a character 

Auto-kerning 

5. Click: the selected font is updated. 

6. Click to close the Font Editor. 

 To rename the font selected, type the new Font name in the RapidFont dialog box. 
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Creating a character 

1. Open the Font Editor dialog box:  click in the Advanced Text palette. 

2. Click a font with FE in its name (these letters distinguish fonts you created in the Editor from 
Gravograph fonts). 

3. Click. 

4. Delete all the objects in the composition and delete all the guides. 

5. If you are creating a character based on a Gravograph character: 

a. Click in the RapidFont dialog box. 

b. Select a Gravograph font. 

c. In the List of characters, double-click on the character that is going to be used as a model. 

6. Create the character following the recommendations below. 

7. Add the character. 
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 Whether or not you are creating a character with a model, adhere to the following 

specifications in order to create an attractive character. Each character is a curved object that 
you can manipulate as needed. 

The character is placed in the lower left-hand corner of the 
composition. 
The composition’s bottom edge is used as the baseline. 
The horizontal marker delimits its nominal width, including the left 
and right spaces around the character. 
The vertical marker delimits its nominal height, including spaces 
above and below the character. 

 

If you create a character without a model, you have a standard 
surface area of 100 x 100 mm available. 
All Gravograph characters have a nominal height of 100 mm. 
Retain this standard value to obtain a character with an F12 height 
that equals 10 mm. 

 Check that the dimensions of the new character do not 
exceed 199x199 mm. 

 

If you are using a Gravograph character as a model, retain its 
characteristics to create the new character (nominal width and 
height, position in relation to the baseline, spaces around the 
character). These characteristics are set up so that the character will 
display consistently in text. 

 

For an accented uppercase letter, place the accent above the 
horizontal marker. 

For a lowercase letter with a descender (g, p, or q), place the 
descender part of the letter beneath the baseline. 
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Managing a font’s characters 

1. Open the Font Editor dialog box:  click in the Advanced Text palette. 

2. Click a font with FE in its name (these letters distinguish fonts you created in the Editor from 
Gravograph fonts). 

3. Click. 

Adding a 
character 

1. Create the character. 

2. Click in the RapidFont dialog box. 

3. Provide the Unicode or Keyboard Reference used to type the character: 

Key in its Unicode number in the left-hand editing zone: type a six-digit figure 

that starts with "0x". 

Click in the right-hand editing zone and type the key on the Keyboard. 

4. Click. If the character already exists in the font, a message asks if you want 
to replace it: 

Yes  The new character is saved in the font. 

No  Add the character under a different reference. 

5. Click: the selected font is updated. 

Deleting a 
character 

1. Click in the RapidFont dialog box. 

2. In the List of characters, click the character to be deleted. 

3.  Close  Click. 

4. Click: the selected font is updated. 
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Editing a font’s auto-kerning 

Auto-kerning is used to improve the legibility of the characters and the text. 

1. Open the Font Editor dialog box:  click in the Advanced Text palette. 

2. Click a font with FE in its name (these letters distinguish fonts you created in the Editor from 
Gravograph fonts). 

3. Click. 

4. Click in the RapidFont dialog box. 

5. In the Visual Kerning dialog box, set the auto-kerning to the character pairs of your choice. 

 

6. Click to close the dialog box. 

Setting the auto-
kerning for a pair of 
characters 

a. Designate Character 1 in the Visual Kerning dialog box: 

Click and double-click on the character in the List of characters. 

Key in its Unicode number: type the six-digit figure starting with "0x". 

b. Repeat the procedure to designate Character 2. 

c. Set the auto-kerning: 

Click to reduce or increase the value by 1/160th of a mm. 

Key in a positive or negative value. 

d. Click to update the auto-kerning table: 
• If there is not one, the pair of characters is added to the table. 
• If the pair of characters features in the table, its auto-kerning value will be 
modified. 

Editing the Auto-
kerning Table 

Click a pair of characters in the Visual Kerning dialog box. 

This list contains the auto-kerning table for the font, which defines the standard 
spacing for different pairs of characters. 

 

Set the auto-kerning for a pair of characters (see the procedure above). 

 Click to delete the pair of characters selected. 

 

Click here to restore the standard auto-kerning table. 

 

Click here only to delete the whole auto-kerning table for a font containing logos. 
Unlike character fonts, left and right-hand spaces are not necessary for logos. 
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Drawing mode 

Working in Drawing mode 

This mode basically allows geometrical shapes to be placed in the composition. 

Each shape is a curve object consisting of one or two vectorial contours which lines may be warped by 
effects or edited in Point mode. 

1. Click in the toolbox to activate the Drawing mode. 

2. In the Shapes palette or in the Modify/Shapes menu, click the shape to be drawn. The tool selected is 

displayed near the pointer  

3. Draw the shape using the mouse, or key in the parameters displayed using the function key  

Each shape is drawn from a reference point that can match the start point, the center of the shape, or a point 
on its contour. 

Tools which draw a closed contour Tools which draw an open contour 

Arrow 

Rectangle 

Rectangle rounded or broken 

Polygon 

Star 

Ellipse 

Circle 

3-point circle 

Circle Arc 

3-point Arc 

Chord Arc 

Tangent Line 

Tangent Arc 

Tools which draw a closed/open contour Special tools 

Use these tools to quickly retouch contours obtained 
by importing a vector file or by vectorizing a 
bitmap image. 

Curve 

Simple Line 

Double line 

Marker 

Crop on intersection 

Extend an open contour 

Auto-connect 
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Viewing shape contours 

Displaying contour direction and order 

 

1. Select the contour display mode: 

Type the hotkey. 

Click command Contour direction or Wire direction in 

View menu. 

2. Click Arrow direction in View menu. 

When you draw, each contour has 

• an arrow that shows its lines direction. 
• a number that indicates in which order it has been drawn, 
when several contours are created at the same time (double line, 
ridge, etc.). 

 

When you select several contours, a number indicates in 

which order each contour has been selected. 

When you duplicate a contour, a number indicates in which order 
each copy has been created. 

With no selection, a number indicates in which order each 
contour has been created. 

Displaying the contour direction 

The color of the contour direction can be 
modified in the Colors window of the 
Options dialog box. 

Click command Contour direction. 

Tick option Contour direction in the Display window of the 
Options dialog box. 

 

A closed contour drawn clockwise is displayed in blue. 

 

A closed contour drawn counterclockwise is displayed in 
green. 

 

An open contour is displayed in black. To see the contour’s 
direction, locate its start point. 
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Displaying contour points 

Displaying start points 

The start point is the control point that 
marks the start of a contour. It is always 
represented by a large square. 

Tick option Start points in the Display window of the Options 
dialog box. 

The end point is the control point that marks the end of a 
contour. 

 

On a closed contour (circle, ellipse, rectangle, polygon, 
star, arrow, curve), the start point and the end point merge. 

 

On an open contour (circle arc, line, curve), the start point 
and the end point are two distinct extremities. 

Displaying control points 

Contours are drawn from a series of 
control points. 

Tick option Control points in the Display window of the 

Options dialog box. 

 Contours that have curves (ellipses, curves, circles, 
arcs of a circle) are also constructed from point 
handles. 

 

For contours that have regular curves (ellipses, circles, arcs of 
a circle), the control points are represented by small circles. 

 

For other contours (rectangles, polygons, stars, arrows, 
lines, curves), the control points are represented by small 
squares. 
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Placing markers 

The Marker tool is used to place an non-engraved marker, either used by itself or as part of a pair so that 
certain procedures may be executed (mirror along an axis, markings for drilling and overlap zones…). 

 A single marker is a Marker object. A set of grouped markers forms a composite object. 

Choosing a marker 

 

1. With the key depressed,  click in the Shapes palette. 

2. In the Draw a Marker dialog box, type the number matching the type of 
marker. 

3. Click. 

1 2 3 4 5 6 7 8 9 10 11 12 13 

           
 

 
 

Drawing with the 

mouse 1. Click in the Shapes palette. 

2. Click the marker’s position in the composition. 

Key in the parameters 

1. Click in the Shapes palette. 

2. Key in the XY coordinates for the marker. 
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Drawing rectangles 

Drawing a simple rectangle with the 

mouse a. Click in the Shapes palette. 

b. Click the position of the start point in the composition. 

c. Slide the pointer to form a rectangle. 

With the key depressed, draw from the center. 

With the key depressed, draw a square. 

d. Click when the shape has the desired size and position. 

Drawing a rounded/broken 

rectangle with the mouse 

 

1. Click in the Shapes palette. 

2. In the Rounded/chamfered rectangle dialog box, click 
the type of rectangle and key in the radius (a radius of 
zero produces a simple rectangle). 

 

Rounded edges: key in 
• a positive radius for outer rounded edges. 
• a negative radius inner rounded edges. 

 

Broken edges: key in a positive radius. 

3. Click. 

4. Draw the rectangle with the mouse (steps b to d). 
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Key in the parameters 

 

1. Click in the Shapes palette. 

Click in the Shapes palette.  Click. 

2. Open the Rectangle dialog box. 

3. Click the center of gravity’s position. 

4. Key in the center of gravity’s coordinates in the 

work area. 

5. Key in the rectangle’s width and height. 

6. Click the type of rectangle you want and key in the 
corresponding radius, if needed. 

Sharp edges (radius zero) 

Rounded edges: key in 

• a positive radius for outer rounded edges. 
• a negative radius inner rounded edges. 

Broken edges: key in a positive radius. 

7. Click. 
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Drawing polygons 

Drawing with the mouse 

 

1. Click in the Shapes palette. 

2. Click the center of gravity’s position in the 
composition. 

3. Key in a number of sides greater than or 

equal to 3 (triangle).  Click. 

4. Slide the pointer to form a rectangle. 

With the key depressed, draw from the 

center of gravity. 

5. Click when the shape has the desired size and 
position. You mark the start point's position 
simultaneously. 

Key in the parameters 

 

1. Click in the Shapes palette. 

2. Click. 

3. Open the Polygon dialog box. 

4. Key in 

the center's coordinates in the work area 

the polygon’s radius 

the polygon’s angle of rotation 
• a number of Sides greater than or equal to 3. 

5. Click. 
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Drawing stars 

Drawing with the mouse 

 

1. Click in the Shapes palette. 

2. Key in a number of vertices greater than or equal 

to 3.  Click. 

3. Slide the pointer to draw the reference circle. 

4. Click when the circle has attained the desired size and 
position. 

5. Slide the pointer inwards or outwards to form the 
star’s vertices. 

6. Click when the star has the desired size and position. 

 

Key in the parameters 

 

1. Click in the Shapes palette. 

2. Click. 

3. Open the Star dialog box. 

4. Key in 

the coordinates for the center of the star in 

the work area 

the distance from the tip of one branch to 
the center of the star 

the distance from the base of one branch to 

the center of the star 

the star’s angle of rotation, calculated from 
its center 
• a number of Vertices greater than or equal to 3. 

5. Click. 
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Drawing arrows 

Drawing with the mouse 

 

1. Click in the Shapes palette. 

2. In the Type of Arrow dialog box, click shape you want (simple, 

orthogonal, filar).  Click. 

3. Click the position of the start point in the composition. 

4. Slide the pointer to adjust the arrow’s length and direction. 

5. Click the position of the arrow’s tip (if you are drawing a filar arrow, 
go directly to step 8). 

6. Slide the pointer to adjust the width of the arrow and its arms. 

7. Click when the body of the arrow has reached the desired size. 

8. Slide the pointer to adjust the length and aperture of the branches. 

9. Click when the branches have the desired size and position. 

 

Drawing an arrow that 

has the same profile as the 
last one drawn 

1. Click the start point’s position in the composition. 

2. Slide the pointer to adjust the arrow’s length and direction. 

3. Double-click on arrow’s tip. 
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Key in the parameters 

1. Click in the Shapes palette. 

2. Click. 

3. Open the Arrow dialog box. 

4. Click the type of arrow you want. 

5. Key in 

the coordinates for the arrow’s origin in the work area 

the length of the arrow’s body 

the width of the arrow’s body (not applicable to filar arrows) 

the arrow’s angle of rotation 

the distance from the apex of a branch to the arrow’s apex 

the distance between the two branches’ apexes 

the distance from the base of a branch to the arrow’s tip 
(not applicable to orthogonal or filar arrows) 

6. Click. 
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Drawing curves 

 

 To draw a curve with a single point, 

convert a marker into a curve. 

1. Click in the Shapes palette. 

2. Click the position of the start point in the 
composition. 

3. Slide the pointer onto the next point’s position. 

Key in the point’s XY coordinates. 

4. Click to mark the point. 
Simple Click: To mark the apex of a curve 

With the key depressed and clicking: To 

mark the end of a line 

With the key depressed and clicking: To 

mark the end of a curve 

5. Repeat steps 3 and 4 depending on the shape you 
want. 

6. Mark the end of the shape: 
• Double-click for an open contour. 
• Click the start point for a closed contour. 
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Drawing lines 

Drawing with the mouse a. In the Shapes palette, 

click to draw a single line. 

click to draw a double line. 

b. Click the position of the start point in the composition. 

c. Slide the pointer onto the next point’s position. 

Key in the point’s XY coordinates. 

d. Click to mark the point’s position and the direction of the line. 

With the key depressed: Horizontal or vertical line 

e. Repeat steps 3 and 4 depending on the shape you want. 

f. Mark the end of the shape: 
• Double-click for an open contour. 
• Click the start point for a closed contour. 

 

Drawing a double line 

 

1. With the key depressed, click in the Shapes 

palette. 

2. In the Double line dialog box, click the type of line angle 
(sharp, broken, rounded). 

3. Key in the distance for each line in relation to the pointer’s 
path. 

4. Click the type of link between ends: 

none (two open contours running in opposite directions) 

angle (closed contours) 

rounded (closed contours) 

5. Click. 

6. Draw the shape with the mouse (steps b to f). 
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Drawing ellipses 

Drawing with the mouse 

1. Click in the Shapes palette. 

2. Click the center of gravity’s position in the composition. 

3. Slide the pointer to form the ellipse. 

With the key depressed: To draw a circle 

With the key depressed: To draw from the center 

4. Click when the shape has the desired size and position. 

Key in the parameters 

 

1. Click in the Shapes palette. 

2. Open the Ellipse dialog box. 

3. Click the center of gravity’s position. 

4. Key in the center of gravity’s coordinates in the 

work area. 

5. Key in the ellipse’s width and height. 

6. Click. 
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Drawing circles 

 Regardless of the procedure chosen, 

• the start point is placed at the base of the circle. 
• the circle is drawn clockwise. 

Drawing with the mouse 

1. Click in the Shapes palette. 

2. Click the center of gravity’s position in the composition. 

3. Slide the pointer to form the circle. 

4. Click when the circle has the desired size and position. 

Key in the parameters 

 

1. Click in the Shapes palette. 

2. Open the Circle dialog box. 

3. Click the center of gravity’s position. 

4. Key in the center of gravity’s coordinates in the 

work area. 

5. Key in the circle’s radius. 

6. Click. 
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Drawing circle arcs 

Drawing with the mouse 

 

1. Click in the Shapes palette. 

2. Click the position of the arc's center in the composition. 

3. Slide the pointer to draw the reference circle. 

4. Click to mark the arc’s diameter and start point. 

5. Slide the pointer to form the arc. 

With the key depressed, draw clockwise. 

6. Click to mark the arc's end point. 

Key in the parameters 

 

1. Click in the Shapes palette. 

2. Open the Arc dialog box: the lower right preview 

displays the arc built. 

3. Key in the coordinates of the arc's center in the work 

area. 

4. Key in the arc’s radius. 

5. Click to draw the arc Clockwise or counterclockwise. 

According to the direction chosen, the preview displays the arc 
in green or in blue. 

6. Key in the arc's start angle and end angle 

(from 0° to 360°). 

7. Click. 
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Drawing arcs and circles based on 3 points 

Circles based on 3 points 

Drawing with the mouse 

1. Click in the Shapes palette. 

2. Click the position of the start point in the composition. 

3. Click the second point. 

4. Slide the pointer to form the circle. 

5. Click the third point. 

Key in the parameters 

 

1. Click in the Shapes palette. 

2. Open the Circle from 3 points dialog box. 

3. Key in the coordinates for each point in the 

work area. 

4. Click. 
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Arcs based on 3 points 

Drawing with the mouse 

 

1. Click in the Shapes palette. 

2. Click the position of the start point in the composition. 

3. Click the arc’s second point. 

4. Slide the pointer to form the arc. 

5. Click the end point. 

or 

1. Click the start point. 

2. Click the second point used as the end point. 

3. With the key depressed, slide the pointer to form 

the arc. 

4. Click the position of the arc’s apex. 

Key in the parameters 

 

1. Click in the Shapes palette. 

2. Open the Arc from 3 points dialog box. 

3. Key in the coordinates for each point in the 

work area. 
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Drawing arcs using the chord 

Click in the Shapes palette. 

Drawing with the mouse 

 

1. Click the position of the start point in the 
composition. 

2. Click the end point; the chord is the distance 
between the arc's extremities. 

3. Key in the Arrow or arc height in the Arc from 
chord dialog box. 

Key in the parameters 

 

1. Open the Arc from chord dialog box. 

2. Key in 

the coordinates of each point 

the arc height 

3. Click. 
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Drawing tangent lines/arcs 

Draw two shapes which lines include curve 
segments (ellipses, arcs, circles, curves). 

Link these shapes with a tangent line or 
arc. 

 

Tangent line 

 The line will not be drawn if it is 

not tangent to the objects 
selected. 

1. Click in the Shapes palette. 

2. On the first object, click the point the tangent is being 
applied to. 

3. On the second object, click the point the tangent is being 
applied to. 

Tangent arc 

If a message indicates that the 
arc is not tangent to the objects 

selected, click and correct the arc’s 
radius. 

1. Click in the Shapes palette. 

2. Key in the arc’s Radius: it must be at least equal to the 
distance between the two points the tangent is being applied 
to. Validate. 

3. On the first object, click the point the tangent is being 
applied to. 

4. On the second object, click the point the tangent is being 
applied to. 
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Cropping two shapes where they intersect 

Cut a shape along the 
lines of a 
superimposed shape. 

  
  

1. Draw two superimposed shapes. 

2. Click in the Shapes palette. 

3. Click the portion of the shape to be cropped. Its contour is eliminated up to the point where it intersects 
with another shape. 

 If you crop a closed contour, the result is an open contour. 
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Extending an open contour 

Stretch an open 
contour with a line 
onto the opposite 
contour. 

   

1. Click in the Shapes palette. 

2. Click the contour's end point. 

3. Click the contour where the selected one should stop: 
• a line extends the previous segment (same direction). 
• the new end point is set on the second contour which is displayed in red. 

 If an error message indicates that the open contour will not be extended, position its end point 

in Point mode. 
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Auto-connecting open contours 

Auto-connecting an open contour 

Selection Auto-connection 

 

Connect the ends of an open contour to close it. 

Example for auto-connection settings 

1. Switch to 

Drawing mode. 

or 

Point mode. 

2. Click an open contour. 

3. Click in the Shapes palette or in the Points 

palette. 

 

Configuring the auto-connection  

The dimensions featured in the graphics are produced using the Dimension tool. 

 

Regarding the in-between distance, decide how you 
will connect the ends. 

1. Open the Auto-connexion dialog box: key 

depressed,  click. 

2. Set parameters in relation to the auto-connection 
mode you choose (linking or merging): 

 

Ends will merge into a single point: 

 

a. Untick box Separately. 

b. Key in the merging distance at least equal to 
the distance between ends. 

 

Ends will be linked with a curve: 

 

a. Tick box Separately. 

b. Key in the linking distance greater than the 
distance between ends. 

 

Ends will be merged or linked: 

 

a. Untick box Separately. 

b. Key in the merging distance. 

c. Key in the linking distance greater than the 
merging distance. 

 

 

3. Click. 
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Setting the auto-connecting of an open contour (example)   

 

Auto-connection settings 

Distance between ends Merging distance Linking distance Result 

Smaller than merging 
distance 

 

= 17 

 

= 20 

 

Merging into a single 
point 

Separately 

Between merging 
distance and linking 
distance 

 

= 15 

 

= 20 

 

Connection with a line 
Separately 

Smaller than linking 
distance 

 
 

= 20 

 

Connection with a 
curve 

Separately 

Greater than linking 
distance 

 
 

= 15 

 

No connection 
Separately 
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Selection mode 

Working in Selection mode 

This working mode basically allows you to place and manipulate objects to be engraved in the composition. 

Click in the toolbox to activate the Selection mode. 

Using this pointer, select some objects so that the following actions can be applied to them: 

Simple operations Advanced operations 

 Cutting/Pasting, Copying/Pasting 

 Deleting 

 Grouping/Ungrouping 

 Positioning in workspace 

 Transforming 

 Aligning 

 Exporting 

 Duplicating 

 Measuring 

 Converting into curves 

 Effects 
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Placing objects in the composition 

Enhance the composition with text, shapes or images. 

You can also import objects designed using external programs (bitmap images, vectorial drawings, volume 
surfaces). 

Simple text objects These objects are lines or paragraphs of horizontal text which 
you type. 

Advanced text objects Bring up the Advanced Text functions to display the text on a 
non-horizontal baseline. 

Geometric shapes Use the Drawing tools to draw rectangles, circles or stars. 

Symbols Use the library of standard objects. 

Task tool objects Use the Task tools to produce professional objects. 

Bitmap images Using a scanner, reproduce an image printed out on paper or on 
film on-screen. 

When you select one or several objects, the properties of the selection are displayed in the status bar. 

 

Text/Curve/Composite/Image Type of the selected object 

This will provide you with information on how you can edit the 
object. 

For a multiple selection, this definition is replaced by the number 
of objects (2 at least). 

{W, H, D} Width, Height, Depth 

[Cx Cy Cz] Centre coordinates useful to align, warp or shift the object in 
the work area. 

These data will not appear for a multiple selection. 
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Placing symbols 

The program offers a symbols library that you can enhance with your own creations. 

Any symbol stored in the library can easily be found and placed in the composition. 

Opening the Logos dialog 
box 

1. Click in the toolbox. 

Click the Symbols command in the Modify menu. 

2. Click in the Symbols dialog box: the list of symbols folders 
available is displayed. 

Placing a symbol in the 
composition 

1. Open the Symbols library. 

2. Click the folder (MARKERS, ENVELOP, CONNECTOR). 

3. Click the symbol in the right preview. 

4. Click. 

5. Click in the composition to place the symbol. 

Adding a symbol to the 
library 

1. Click the object (except for bitmap images) to be converted to a symbol. 

2. Open the Symbols library. 

3. Click the folder where the symbol will be stored. 

4.  Add  Click. 

5. Type the Name of the symbol in the dialog box open. 

6. Click. 

Managing symbols 1. Open the Symbols library. 

2. Click the folder which contains the symbol desired. 

3. Click the symbol in the right preview. 

Move within the library Drag and drop the symbol onto a folder and validate. 

 Delete   Click and validate. 

 Rename  Click: type the new name and validate. 
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Add a folder 1. Open the Symbols library. 

2. Right-click. 

3. Click the Add a folder command in the contextual menu. 

4. Type the Name of the folder in the dialog box open. 

5. Click. 

6. Move or add the symbols of your choice into the new folder. 

Delete a folder 

 This operation also 

deletes all the symbols 
stored in the folder. 

1. Open the Symbols library. 

2. Right-click the folder to be deleted. 

3. Click the Delete a folder command in the contextual menu. 
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Importing objects 

The Import command allows objects designed in external programs (2D or 3D CAD, bitmap drawings, 
vectorial drawings) to be placed in the composition. 

1. Open the Import dialog box: 

Type the hotkey. 

Click the Import command in the File menu. 

2. Locate the spot where the file to be imported is ( DRAWS is the default folder). 

3. Click the file format. 

4. Select the file to be opened: click its name or type it in the Name box. 
To search quickly, click in the list and type the first character of the name. 

5.  Open  Click. 

6. Click in the composition to place the object. 

To bring up the Windows contextual help, click this box, then a zone in the dialog box. 

How to import a vectorial drawing from Corel Draw using Copy/Paste 

a. Open the Corel Draw file which encloses the drawing to be recovered. 

b. Check that it contains 10000 objects maximum; if needed, simplify the drawing to decrease the 
number of objects. 

c. Select all the objects in the drawing. 

d. Copy the selection. 

e. Click the GravoStyle window. 

f. In the composition, click where you want to paste the selection. 

g. Click in the main toolbar: the drawing is imported under Windows MetaFile format which accepts 

vectorial contours. 

To edit the objects comprising this drawing, convert it into curves. 

What can you do if the vectorial contours in an imported WMF file are not correctly reproduced? 

You may recover the bitmap image possibly used as a model to draw these, if you saved it in the WMF file. 

a. Click the Insert object command in the File menu. 

b. Open the WMF file. 

c. Redraw contours using the Vectorize image function or Drawing tools. 
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Selecting objects 

Click a snap mode for a sharp selection. 

Consult the status line which displays the selection's properties. 

Selecting an object 

 

Click the object’s contour: its contour and the 
selection handles are displayed in red. 
The selection color can be modified in the Colors 
window of the Options dialog box. 

Selecting a group of objects 

 

1. Slide the pointer so that all the objects to be 
selected are framed. 
Check that the objects’ contours are fully included 
within the dotted selection frame. 

2. Release the selection: selection handles should 
appear around the group of objects. 

or 

With the key depressed, click the contour of 

each object to be selected. 

Selecting all the objects in the composition 

With the key depressed, press key  

Select the Select All command in the Edit menu. 

Deselecting an object or a group of objects that 
have been selected 

Click outside the object or the group of objects. 

Deselecting an object in a multiple selection 

With the key depressed, click the contour of 

the object selected. 

Viewing the selection 

 To speed up each procedure, avoid clicking 
the View Object command. 

Click the View Object command in the Edit menu. 

Press the key. 

 

View object: only the selection’s frame is 
displayed. 

 

View object: the selection remains visible. 
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Copying/Cutting/Pasting - Deleting objects  

Select some objects. 

Copying/Pasting 

Duplicate an object in the 
composition. 

1. Copy the selection:  click in the main toolbar. 

2. Click. 

3. Move the copy superimposed on the selection. 

4. Use the keyboard shortcut to display the copy and the 

selection. 

Cutting/Pasting 

Move an object in the 
composition. 

1. Cut the selection:  click in the main toolbar. 

2. Click. 

Deleting Click the Delete command in the Edit menu. 

Press the key. 
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Grouping objects  

Use the Group command to manipulate several objects as a single object. If the selection contains 
• different types of objects, you will obtain a composite object. 
• curve objects, you will obtain a curve object. 

Ungroup to manipulate each object separately. 

Group 

1. Select some objects. 

2. Click in the toolbox. 

Ungroup 

1. Click the group of objects. 

2. Click in the toolbox. 
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Grouping by engraving path 

Group several objects so they can be assigned the engraving path of the first 
object selected. 
If you ungroup the objects, each one will retain the path assigned to the group. 

 

The path of the first object selected is applied to any selected. 

 

Grouping selected objects and retaining each engraving path: 

With the key depressed, click in the toolbox. 

 

Grouping by surface 

Group two superimposed closed contours when they delimit a surface to be 
engraved. 
The surface of the curve object obtained is equal to the surface of the grouped 
objects, minus where they intersect. 
You can thus engrave an object in relief by giving it an external contour and an 
internal contour. 

 

Grouped objects 

The path of the first object selected is assigned to the curve object obtained. 

 

Non-grouped objects 

Each object has its own engraving path. 
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Exporting objects 

This function allows objects placed in the composition to be run in external programs (2D or 3D CAD, bitmap 
drawing, vectorial drawing, text processing). 

1. Select the objects to be exported. 

2. Open the Export dialog box: 

Type the hotkey. 

Click the Export command in the File menu. 

3. Locate the folder where the file will be saved ( DRAWS is the default folder). 

4. Click the file format. 

5. Type the file name in the Name box. 

6. Click. 

To bring up the Windows contextual help, click this box, then a zone in the dialog box. 

 



Selection mode 

135 

 

Converting into curve object 
Function 

1. Select the object to be converted. 

2. Click in the Advanced Text palette. 

Use this function to 

Manipulate a text object like a 
curve object 

Each character becomes an 
independent curved object. 

 You will no longer be able to 
edit the text. 

 

 

Convert a marker into a curve 
with a single point 

 

Edit various objects comprising 
a complex object 

 You will no longer be able to 

edit the object’s properties. 

 To separate the objects comprising it, ungroup the converted 

object as many times as necessary. 
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Set in work area 

Placing objects in the work area 

Snap Mode Rulers Grid Guides Layers 

 

The work area is the place where you create and manipulate objects in the composition. Its background 

color can be modified in the Colors window of the Options dialog box. 
In the status bar, click icon: 

 to limit the work area’s surface area to the zone between the composition’s margins. 

You can only create and manipulate objects between the margins. Should any objects overflow the work 

area, the icon becomes red  

 to work in an unlimited work area. 

Objects can be created and manipulated outside the composition, but you must place them within the 
composition’s surface area and thickness to engrave them. 
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View in the work area 

 Display XY 2D view before activating a work mode. 

Displaying a predefined view Click a View in the View menu. 

With the key depressed, press the key related to the 

view number ( to ). 

Displaying a customized view 1. Click the View box in the status bar. 

Click the View command in the View menu. 

2. Click the view to be displayed. 

3. Key in the viewing angle for each axis. 

4. Click. 

2D views are used to place and manipulate objects in the composition. 

2D XY: flat view of the composition’s 
surface 

 

2D YZ: sectional view of the 
composition’s height and thickness  

2D XZ: sectional view of the 
composition’s length and thickness 

 

3D views are recommended for perspective viewing of objects and engraving paths. 

3D XYZ engraver: 10° angle view 

 

3D ISO XYZ: 45° angle view 
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Snap mode 

To perform certain procedures such as selection, you have to snap the pointer, or in other words, position it 
over an element displayed in the work area (guide, point, or contour). 
To facilitate this action, several snap modes are available. 

 

1. Display the Snap palette. 

2. Click the button for the mode you want. Each mode 
designates the element capable of snapping or attracting the 
pointer. 

3. Move the pointer onto an active snap element. 

A circle will be displayed as soon as the pointer enters the snap 

element’s magnetic field. 
If the pointer is not correctly positioned, click another button in 
the palette. 

Customizing the snap distance This parameter delimits the magnetic field around the snap 
element. The default distance is 8 mm. 
The lower this value is, the harder it is to position the pointer on 

the snap element. 

1. In the Options dialog box, click the Display tab. 

2. Key in a Snap distance falling between 1 and 10 mm. 
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Rulers 

The work area is a plan. 
• its origin (0,0,0) is set by default in the lower left-hand corner of the composition. 
• its XYZ axes are respectively located on the composition’s length, height and thickness. 

Display the horizontal and vertical 
rulers 

They allow you to view the origin and XY 
axes of the work area. 

Tick box Rulers in the Display window of the Options dialog 

box. 

Follow the pointer’s movements tracked by the shifting indices 
displayed in rulers: they indicate its XY coordinates, in 
accordance with the active measuring unit. 

Modifying the work area’s origin 1. Display the rulers. 

2. Click. 

3. Slide the dotted axes. 

4. Release them when the origin reaches the desired position. 
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Grid 

The grid is a series of dotted lines that 
allow objects to be positioned precisely in 
the work area. 

Use grid points to draw shapes with the 
mouse (here, a circle from 3 points). 

 

Using the grid 

The grid’s color can be modified in the 
Colors window of the Options dialog box. 

1. Display the Snap palette. 

2. Click snap mode. 

3. Click the Grid tab in the Options dialog box. 

4. Tick box Enabled. 

5. Tick box Visible. 

Customize the default grid 

The default grid interval is 1 mm along 
each axis and its origin (0, 0, 0). 

1. Click the Grid tab in the Options dialog box. 

2. Key in 
• the XYZ Step (distance between two points in the grid) on 
each axis. 
• the XYZ Start coordinates for the grid’s origin. 
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Guide lines 

Using guide lines 

Use guide lines to align objects with the mouse. 

1. Create as many guide lines as necessary. Their color can 
be changed in the Colors window of the Options dialog 
box. 

2. Activate the guide lines: click snap mode  

3. Move an object over a guide line using the mouse: the 
object pauses momentarily each time its edges or center 
touch the guide line. 

  

Creating a guide line using the mouse 1. Display the rulers. 

2. Slide a horizontal/vertical guide line, working from the 
horizontal/vertical rulers. 

3. Release the guide line when it reaches the desired 
position. 

Key in the coordinate X for a vertical guide line, Y 

for a horizontal guide line. 

Entering the parameters for each guide 
line 

 Close  Click to exit the dialog box. 

1. Open the Edit Guide lines dialog box. Select the Guide 
lines command in the Modify menu. 

2. Click the Type of guide line 

 

3. Key in the Position for the new guide line. 

4.  Add Click. 

5.  Next>  Click to add the following guide line, click and 

repeat the procedure from step 2 onwards. 



GravoStyle 5 User Manual 

142 

Moving a guide line Slide the guide line within the work area. 

or 

1. Double-click on an existing guide line. 

2. In the Edit Guide lines dialog box, key in the new 
Position. 

3.  Edit  Click. 

Deleting a guide line Slide the guide line on the ruler. 

or 

1. Double-click on an existing guide line. 

2.  Delete  Click in the Edit Guide lines dialog box. 

Delete all  Click to delete all the guide lines created. 
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XYZ coordinates 

To position certain elements (guides, an object’s origin, determining points in a shape’s line), you can set their 
coordinates in the work area. 

Marking with the 

mouse 

1. Display the rulers. 

2. Move the pointer while using the shifting indices displayed in the rulers as 
references. 

3. Click when the pointer reaches its new position. Its XYZ coordinates are 
displayed in the status bar. 

Entering the 

coordinates 1. Open the Position a Point dialog box. 

2. Click box Relative coordinates to place the point in relation to its initial 
position. 

3. Place the point: key in 

• either the Cartesian coordinates  

• or the Polar coordinates, radius and angle  

3. Key in Coordinate  

4. Click. 
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Layers 

Use layers to superimpose objects. You can place certain objects in front of or behind others, depending on the 
order of the layers. 
There is no limit either to the number of layers or to the number of objects placed on each layer. 

Layers are selected and managed in the work area's Layer bar. 

Adding a layer Click in the Layer bar: the new layer is 

stacked on top of the preceding layer and 
becomes the active layer. 

Click to delete the active layer and all the 

objects it contains. 

Selecting a layer Click the Layer in the Layer bar: you can 
manipulate the objects placed on the active 
layer, without modifying the other layers. 

No procedure on the other layers is possible, 
and these are inactive. 

Inactive layers and their objects are invisible. 

Editing a layer properties 

Layer 1 Visible 

 

Layer 2 Visible 

 

Layer 3 Visible 

 

Double-click a layer: 

• Type the Layer name that will be shown in 
Layer bar. 

• Tick box Visible 

to hide the layer that will remain invisible, 

even when you display all layers. 

to display it with all visible layers. 

Displaying visible layers 

 

Tick box at the end of the Layer bar: all 

visible layers and their objects are shown. 

You work only on the active layer. 

 
Here, layer 2 is invisible. 

Displaying the active layer 

 Display all the layers in the engraving preview. 

Tick box at the end of the Layer bar: the 

other layers will be hidden. 
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Moving objects from one layer to another 1. Select some objects. 

2. Cut the selection:  click in the main 

toolbar. 

3. Click the layer where you want to paste 
the selection. 

4. Click. 
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Transform 

Transforming an object 

1. Select an object. 

2. In the Transform palette or in the Modify/Transform menu, click the tool for the transformation to be 
carried out. The tool selected will be displayed near the pointer. 

3. Execute the transformation either with the mouse, or by entering the parameters displayed using function 

key  

Certain transformations are calculated from the center of warping in the object selected. 

This reference point can be the same as the start point or the center of the object, but can also be a point 

outside the object’s contour. 

Move 

Resize 

Pivot 

Stretch 

Horizontal mirror 

Vertical mirror 

Mirror along an axis 
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Moving an object 

Check the movement distance in the status line. 

Moving using the mouse 1. Select an object. 

2. Slide the object. 

With the key depressed, move the object either horizontally 

or vertically. 

With the key depressed, move a copy of the object. 

3. Release the object when it reaches its position. 

In the Precise Positioning dialog box, set the object’s new 

position. Validate. 

 

a. Click Move to in order to calculate the movement in relation to 

the work area's origin. 

b. Click to designate the origin of the object. 

c. Key in its coordinates on the XY axes or the Z axis. 

 

a. Click Relative distance to calculate the movement in relation 
to the object’s lower left-hand corner. 

b. Key in movement distances on the XY axes or the Z axis. 

Moving using the Move tool 1. Select an object. 

2. Click in the Transform palette. 

3. Click the object. 

4. Slide the object. 

With the key depressed, move either horizontally or vertically. 

5. Click when the object has reached its position. 

Moving using the keyboard 

 

Press the arrow keys in the numeric keypad to move the selected object 1 
mm vertically or horizontally. 

Customizing the movement distance: 

1. In the Options dialog box, click the Display tab. 

2. Key in an Arrow movement between 1 and 10 mm. 
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Resizing/Stretching an object 

Check the scale coefficient in the status line. 

Resizing using the mouse 

 

1. Select an object. 

2. Point on a selection handle, located 
• in a corner: to retain the proportions. 
• on an edge: to modify the length or height. 

3. Slide the object. 

With the key depressed, resize from the center of 

the object. 

With the key depressed, make the object’s size 

vary in increments of 100%. 

4. Release the object when it has attained the desired size. 

In the Scale dialog box, key in 

• either the Scale coefficient on each axis. 
• or a dimension Width/Height/Depth. Click the 

Keep proportions box to retain the ratio between the 

dimensions. 
Validate. 

Resizing using the Scale tool 1. Select an object. 

2. Click in the Transform palette. 

The scale center is displayed in the center of the 
object. 
To move it, slide the scale center and release it when it 
has reached the desired position. 

3. Click the object. 

4. Slide the object. 

With the key depressed, make the object’s size 

vary in increments of 100%. 

5. Click when the object has attained the desired size. 
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Pivoting an object 

Check the angle of rotation in the status line. 

Pivoting using the mouse 

 

1. Select an object. 

2. Place the pointer on the rotation handle. 

3. Slide the object. 

With the key depressed, make the object pivot in increments 

of 15°. 

4. Release the object when it reaches its position. 

Key in the angle in the Rotation dialog box. Validate. 

Pivoting using the Rotation 
tool 

1. Select an object. 

2. Click in the Transform palette. 

The center of rotation is displayed in the center of the object. 

To move it, slide the center of rotation and release it when it has 
reached the desired position. 

3. Click the object. 

4. Slide the object. 

With the key depressed, make the object pivot in increments 

of 15°. 

5. Click when the object has reached its position. 

In the Precise Rotation dialog box, key in 

• the angle of rotation 
• the XY coordinates of the center of rotation. Validate. 
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Mirroring an object 

Vertical or horizontal mirroring 1. Select an object. 

2. In the Transform palette, click the button for the desired 
symmetry. 

With the key depressed, mirror a copy of the selection. 

 

Vertical mirror: vertical symmetry on the center of the 

object 

With the key depressed, vertical symmetry on the 

selection’s right-hand edge. 

 

Horizontal mirror: horizontal symmetry on the center 

of the object 

With the key depressed, horizontal symmetry on the 

selection’s bottom edge. 

Mirroring along an axis you have 
defined 

 

1. Place two markers to form the axis of symmetry. 

2. Select the object, and then the markers. 

3. Click in the Transform palette. 

With the key depressed, mirror a copy of the selection. 
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Align 

Aligning objects 

1. Select some objects. 

2. In the Align palette or in the Modify/Order menu, select the tool related to the operation to be 
executed: 

Horizontal centring 

Vertical centring 

Align on top 

Align on bottom 

Align on left 

Align on right 

Horizontal balancing 

Vertical balancing 

Width spacing 

Height spacing 

Vertical auto-sizing 

Horizontal auto-sizing 

Full auto-sizing 

Align on the horizontal axis 

Align on the vertical axis 

Align on the Z axis 
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Centering objects 

1. Select some objects. 

2. In the Align palette, click the button for the centering you want. 

Vertical centering on the center of the first object selected 

 

Horizontal centering on the center of the first object selected 

 

  To center objects in terms of their XY coordinates, click each button. 
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Aligning objects on an edge 

1. Select some objects. 

2. In the Align palette, click the button for the alignment you want. 

Left alignment 

on the left end of the first object 
selected. 

 

Right alignment 

on the right end of the first object 
selected. 

 

Top alignment 

on the top of the first object selected. 

 

Bottom alignment 

on the base of the first object 
selected. 
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Balancing objects in the composition 

1. Select some objects. 

2. In the Align palette, click the button for the layout you want. 

Balancing objects vertically between the composition’s top and bottom edges 

 

Balancing objects horizontally between the composition’s left and right edges 
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Spacing objects 

1. Select some objects. 

2. In the Align palette, click the button for the distribution you want. 

Width spacing using a constant horizontal space between the objects selected. 

 

Height spacing using a constant vertical space between the objects selected. 
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Auto-sizing to match an object 

1. Select some objects. 

2. In the Align palette, click the button for the resizing you want. 

Horizontal auto-sizing 

The width of the first object selected determines the width of the other objects selected. 

 

Vertical auto-sizing 

The height of the first object selected determines the height of the other objects selected. 

 

Full auto-sizing 

The dimensions of the first object selected determine the size of the other objects selected. 
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Aligning an object on an axis 

1. Select an object. 

2. In the Align palette, click the button for the alignment you want. 

3. On the object’s contour, click the first point to be aligned. 

4. Click the second point to be aligned. 

Horizontal alignment 

 

Vertical alignment 
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Aligning objects on the Z axis 

1. Select objects. 

2. Extend the work area. 

3. Display a 2D view. 

4. Click in the Align palette. 

5. In the Z Alignment dialog box, click the start zone for the Z movement (the Z position for each zone is 
displayed as an indication only): 

Top (default) 

Middle 

Bottom 

6. Key in the new Z coordinate in box Move towards. 

7. Click. 
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Duplication 

Duplicating an object 
Function 

In the Duplicate palette or in the Modify/Duplicate menu, select the tool for the duplication to be 

executed: 

Free duplication 

Linear duplication 

Circular duplication 

Duplication on a curve 

Duplication with shading 
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Free duplication 

 

 

 

1. Select an object. 

2. Click in the Duplicate palette. 

3. Click the contour of the object. 

4. Slide the copy. 

With the key depressed, duplicate either horizontally or 

vertically. 

5. Click when the copy has reached the desired position. 

Key in the copy’s XY coordinates. 

6. Repeat steps 4 and 5 as needed. 

7. Double-click to complete the duplication. 

 You can also move a copy of the selection using the Move 

tool. 
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Linear duplication 

1. Select an object. 

2. Open the Linear Duplication dialog box:  click in the 

Duplicate palette. 

3. Key in the columns and rows in the Linear Duplication dialog 
box. 

4. Click. 

5. Click the selection. 

 

Duplicating 

with the mouse 

6. Slide the copies with dotted contours. 

 

7. Release them when you have reached 
the desired position. 
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Entering the 

duplication 
parameters 

6. Open the Linear Duplication 

dialog box. 

7. Click the Columns/Rows tab: key in 
the number of columns and rows. 

8. Set the distance between copies: 

 

Click the Delta tab and key in the 

horizontal/vertical distance between 
2 copies. 

 

Click the Offset tab and key in the 

horizontal/vertical distance between 
the bottom left-hand corners of the 2 
copies. 

 

9. Click. 
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Circular duplication 

 

 

1. Select an object. 

2. Click in the Duplicate palette. 

3. In the Circular Duplication dialog box, click box Rotation to 

retain the duplicated object’s initial direction. 

pivot each copy of the object. 

4. Key in the number of copies desired. Validate. 

5. Click the contour of the object to be duplicated. 

6. Slide the copies with dotted lines. 

7. Release them when you have reached the desired position. 

 



GravoStyle 5 User Manual 

164 

 

Duplication on a curve 

Duplicate an object following a regular 
progression on one or several contours 
(useful to distribute drill points along a 
signage logo lighted with LED bulbs). 

  

Selection Duplication 

1. Draw a shape. 

2. Draw the open contour which is used as the duplication support (arc, curve, line). 

3. Check that the direction of this contour matches the duplication direction. If needed, invert the contour's 
direction. 

4. With the key depressed, click the shape, and then the open contour. 

5. Open the Duplication on curve dialog box:  click in the Duplicate palette. 

6. Key in the Distance between the centers of the two copies or the Number of copies desired (initial shape 
and shapes duplicated). 

7. Click box Rotation to 

retain the duplicated object’s initial direction. 

pivot each copy of the object. 

8. Click. 

 The initial shape will be automatically centred on the open contour's start point. 
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Duplication on a curve with shading 

Distribute intermediate copies 
between two shapes along a 
contour. 
Duplicated objects have the same 
shape but different sizes. 

  

Selection Duplication 

1. Draw two shapes with the same type, but different sizes. 

2. Draw the open contour which is used as the duplication support (arc, curve, line). 

3. Check that the direction of this contour matches the duplication direction. If needed, invert the contour's 
direction. 

4. With the key depressed, click the first shape, the second shape, and then the open contour. 

5. Open the Duplication resizing on a curve dialog box:  click in the Duplicate palette. 

6. Key in the Number of copies (start and end shapes, intermediate shapes). 

7. Click box Rotation to 

retain the duplicated object’s initial direction. 

pivot each copy of the object. 

7. Click box Equidistant copies to place them at equal distances on the curve. 

8. Click. 

 The start and end shapes will be automatically centred on the open contour's start and end 

point. 
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Measure 

Measuring an object 
Function 

1. Click snap mode for precise measurement. 

2. In the Measure palette, select the tool for the procedure to be executed: 

Distance 

Perimeter 

Angle 

Footprint 

Bounding box 

Surface area 

Dimension 

Tool simulation 
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Measuring the size 

Footprint 

The dimensions are displayed in the status 
line. 

 

1. Click in the Measure palette. 

2. Slide the pointer so that the objects are included in the 
crossed frame. 

Surface area 

 

1. Click in the Measure palette. 

2. Click the object and read the measure in the status line. 

Bounding box 

Correct a contour dimensions with the 
bounding box, if the selection frame 
overflows the actual object size. 

You will handle the contour with more 
precision. 

 

 

1. Click in the Measure palette. 

2. Click the object. You will obtain a frame. 

3. Delete the bounding box, which is now superfluous. 

 Use this function to correct this calculation error 
caused by the wrong position of point handles. 
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Measuring a distance/perimeter/angle 

Distance 

The distance is displayed in the status line. 

 

1. Click in the Measure palette. 

2. Click a first point. 

3. Slide the pointer onto the second point. 

Perimeter 

 

1. Click in the Measure palette. 

2. Click the object and read the measure in the status line. 

Angle 

The angle is displayed in the status line. 

 

1. Click in the Measure palette. 

2. Click a first point. 

3. Slide the pointer onto the second point. 

4. With the key depressed, point at the angle to be 

measured. 

5. Click the angle’s apex. 
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Dimension 

Measuring a dimension 

Measure a distance and draw the 
corresponding dimension at the same time. 

 

Drawing with the mouse 

You will obtain a Dimension object with 
lines featuring the following: 
 a dimension line that ends in two 

symbols (pink). 
 a dimension mark at each end of the line 

(green). 
 a dimension value (blue). 

Double-click on the object to edit its 
properties in the Dimension options 
dialog box. 

1. Click in the Measure palette. 

2. Click the first point. 

3. Slide the pointer onto the second point. 

4. Slide the dimension mark so it is positioned in relation to the 
object measured. 

5. Click when the dimension mark reaches the position needed. 

6. Display the engraving paths. 

Defining dimension properties 1. Open the Dimension options dialog box: key 

depressed, click in the Measure palette. 

2. Set the dimension line’s properties. 

3. Set the dimension value’s properties. 

4. Click. 
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Setting the dimension line properties 

1. Open the Dimension options dialog box: key depressed,  click in the Measure palette. 

2. Click tab Geometrical properties. 

3. Click the Dimension type in relation to the distance measured 

horizontal 

vertical 

aligned 

4. Define the appearance of the 
Dimension symbol at each end of 
the dimension line. 

a. Click to display the symbol’s icon: 

 

 

b. Key in the Size of the symbol. 

5. Define the properties of the 
Dimension line. 

a. Set its position in relation to the dimension marks: 

 

b. Assign the engraving path color to the dimension line 
and symbols. 

6. Define the properties of the Extension 
line. 

7. Set the dimension value’s 
properties. 

a. Click to display the symbol’s icon: 

 

b. Assign the engraving path color to the marks. 

c. Key in the Line extension beyond the dimension line. 

d. Key in the Line offset in relation to the measurement’s start 
point. 
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Setting the dimension value properties 

1. Open the Dimension options dialog box: key depressed,  click in the Measure palette. 

2. Click tab Text properties. 

3. Define the Dimension text 
apparency. 

a. Select a font. 

b. Assign the engraving path color to the text. 

c. Key in the Height of the text. 

4. Click the Text position in relation to 
the dimension line. 

 

5. Click Text orientation in relation to 
the dimension line. 

 

6. Define the content of the Additional 
Text. 

7. Set the dimension line’s 
properties. 

a. Type the Prefix or Suffix the dimension value. 

b. Click the Precision of the dimension value (number of 
digits following the decimal point). 

c. Select the Unit of the dimension value. 
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Effects 

Applying an effect to contours 
Function 

The Effects tools enable the contours of curve objects to be transformed. 

 To apply an effect to text, convert it into curves first. 

In the Effects palette or in the Modify/Effects menu, select the tool for the effect to be applied. The tool 
selected is displayed near the pointer. 

Union 

Intersection 

Subtraction 

Exclusion 

Offset 

Placing into an envelope 

Convert into a shape 

Segmentation 

Vectoring 

Reversing contour direction 

Overlap markers 
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Boolean effects between contours 

These tools enable curve objects to be generated from the intersection of two or more contours. 

 Ungroup these objects to make them independent. 

1. Display the start points to view the curve objects 

generated by the effect. 

2. Select two objects which contain contours. 

3. In the Effects palette, click the button for the desired 
effect. 

Selection: 

Circle (green) 

Double closed line (pink) 
 

Union 

This effect joins the objects selected together into a single object. 

 

Intersection 

This effect creates a new object where the objects selected intersect. 
 

Subtraction 

This effect hollows out the first object selected, following the 
second object’s contours. 

Select the objects in the correct order. 

Object 1: closed double 
line (pink) 

Object 2: circle (green) 
 

Object 1: circle (green) 

Object 2: closed double 
line (pink) 

 

Exclusion 

This effect creates new objects by hollowing out the selected objects. 
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Offset on contours 

This function reproduces a contour's internal or external line. 

  

1. Select an object which contains contours. 

2. Open the Offset dialog box:  click in the 

Effects palette. 

3. To keep the object intact, click box Keep 

initial curves. 

4. Key in the Offset distance in relation to the 
origin contours. 

5. Click the type of contours. 

6. Click the type of angle. 

7. Click. 
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Placing an object in an envelope 

Use this function to force an object’s contours to assume a predefined shape. 

Placing an envelope 

1. Click in the toolbox. 

2. Double-click the Symbols folder. 

3. Click the Envelop folder. 

4. Click an envelope in the library. 

5. Click. 

Placing an object in an 
envelope 

 Convert the text into 

curves. 

1. Select the object and then the envelope. 

2. Click in the Effects palette. 

3. Delete the envelope if it is no longer needed. 

 

How do you force the 

object to faithfully follow 
the envelope?  

 

a. Segment the envelope to refine the 
precision of its line. 

b. Place the object in the envelope. 

 
 

Creating an envelope 1. Draw 4 open contours. 

2. Center the start and end points to give the appearance of a closed contour. 

3. Select the contours in the following order: 1 + 2 + 3 + 4 

4. Group the selection. 

5. Add the new symbol in the Envelope folder of the Symbols folder. 
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Converting into a shape 

This function converts a contour into a simple shape. 

1. Select an object which contains contours. 

2. Click in the Effects palette. 

3. Click the desired shape: 

 

4. Click. 
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Reversing the direction of contours 

This command reverses the direction of each contour selected. 

 

Selection Reversal 

1. Display contour direction. 

2. Select an object which contains contours. 

3. Click in the Effects palette. 
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Segmenting a contour 

This function is used to 
break down a contour 
into line segments 
whose precision you 
define. 

   

Selection Segmentation Chord error (zoom) 

1. Select an object which contains contours. 

2. Click in the Effects palette. 

3. In the Segmentation dialog box, key in 
• the Max. length (L1, L2, L3) of a segment generated from a curve. 
• the Max. chord error (E1, E2, E3) or maximum offset for a segment in relation to the initial curve. 

4. Click. 

 Display control points to view the new segments. 
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Vectoring a contour 

This function is used to break down a 
contour into curved segments whose 
precision you define. 

 

Selection Vectorization 

1. Select an object which contains contours. 

2. Click in the Effects palette. 

3. Key in the Chord error or maximum offset for a segment in relation to the initial curve. 

4. Click. 

Switch to Point mode to view the new segments and their point handles. 
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Locating contour overlaps 

1. Select an object which contains contours. 

2. Click in the Effects palette: a marker will appear on each overlap point. 

A single marker is a Marker object. A set of grouped markers forms a composite object. 

Use this function 

To locate contours to be closed 

When you assign an engraving path to a closed contour, you may view on 
screen that the surface area it delimits will not be engraved. 
That means that the contour is still open: close it using functions Connect/Auto-
connexion. 

In the case opposite, engraving paths are displayed: the right circle is plain, the 
left one remains empty and has a marker. Actually, its ends are perfectly 
superimposed but not linked. 

 

To identify superimposed curve objects 

In the case opposite, four markers appear above the rectangle. Actually, two 
similar rectangles are perfectly superimposed. 

This mistake often happens when you copy and paste: the copy is pasted above 
the selection, you view only one object on screen. Move the copy just after you 
have pasted it. 

 

Locating overlaps on a contour line 

This phenomenon generates engraving errors in each zone delimited by the 
contour. 

 Retouch the object in Point mode to eliminate overlaps. 

In this case, a filling path is assigned to a closed curve: only the lower surface 
area is hollowed out, as the curve’s line forms a loop. 

To solve this problem, you can cut the curve into two closed contours on the 
overlap marker (in red). 
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Point mode 

Working in Point mode 
Function 

This mode allows you to retouch a vectorial contour line by editing its points. 

Click in the toolbox to activate the Point mode. 

Using this pointer, you can 

 Select points 

 Move a point 

 Modify a point’s attributes 

• By clicking a tool in the Points palette, you can: 

Manage points Connect points Manage contours 

Add 

Delete 

Refine a contour 

Simplify a contour 

Connect 

Disconnect 

Auto-connect 

Move 

Delete 

Modify the nature of a point Produce an angle from a 
point 

Convert a segment 

Continuous point 

Start point 

Rounded 

Chamfered 

Into a line 

Into an angle 

Into the arc of a circle 

Into a curve 

Align points Cut a contour Project a point onto a guide 

Vertically 

Horizontally 

Cut 

Cut and crop 

Divide 

horizontally 

vertically 

orthogonally 
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Characteristics of a point 

Click a contour: the direction and the control points of the contour selected are displayed. 

Control points 

These points are located on the contour. The section of a contour in between two control points forms a 
segment. 

  

 

The start point is the control 
point which marks the start of 
a contour. 
The end point is the control 
point that marks the end of a 
contour. 

A tangent point is a control point 
located between two segments of an 
arc. 

An angle point is a control point on 
which two segments form an angle. 

Point handles 

If the contour selected has curve segments, the curve handles are displayed. These points are represented by 
small circles located outside the contour. 
Adjust the curvature and the lines of adjacent segments by sliding the handles. 

 

  

Single handle Double handle Curve handle 

 Handles must not warp the contour’s size. If this calculation error occurs, add control points or 

generate a bounding box. 

   
 

Selection Actual size of the contour Editing in Point mode Addition of points 
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Selecting points 

Click the snap mode 

to select a contour. 

to select a point. 

Selecting a contour Click the contour. 
If the contour is grouped, you automatically select all the group’s 
contours. 

Selecting contours belonging to 
different objects 

With the key depressed, click each contour. 

Selecting a point Click the point, which is displayed contrasted on a black 
background. 

Selecting points 

With the key depressed, click each point. 

Slide the pointer so that all the points to be selected are 
framed. 

Deselecting a point or a selection of 
points 

Click outside the selection. 

Deselecting a point in a selection of 
points 

With the key depressed, click a point selected. 
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Changing a point’s attributes 

Click a contour. 

Position in relation to 
the contour 

1. Double-click on a point. 

2. In the Point Attributes dialog box, click option 

 

Control on contour, to make it a control point. 

 

Handle out of contour, to make it a curve handle. 

XYZW coordinates 1. Double-click on a point. 

2. In the Point Attributes dialog box, key in its XYZ coordinates in the work 
area. 

3. Key in the W coordinate, if a point handle is involved. This coordinate 
determines the curvature of the segment checked by the handle. Key in a 
value: 
• near 0, to obtain a line. 
• at least equal to 1, to accentuate the curve by bringing its apex closer to the 
handle. 
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Changing the nature of a point 

Click a contour. 

Designating the start point for a closed 
contour 

 You cannot designate a new start 

point for an open contour. However, 
you can reverse the contour’s 
direction in order to reverse the start 
point and the end point. 

1. Click the control point selected as the start point. 

2. Click in the Points palette. 

Converting into a control point/point 
handle 

1. Click a point. 

2. Modify the point’s position in relation to the contour 
in the Point Attributes dialog box. 

Converting into a continuous point 

This command transforms a control point into 
a tangent point. 

 

1. Click a control point between two curve segments. 

2. Click in the Points palette. 

Each handle is repositioned so it is tangent to the adjacent 
segments. 
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Adding/Deleting a point 

Click a contour. 

Add 

 

1. Click the position of the new point: a guide will appear on 
the contour. 

2. Click in the Points palette. 

Hit the key. 

The new point is represented by a blue circle.  

Delete 

 The start and end points cannot be 

deleted. 

1. Select the point to be deleted. 

2. Click in the Points palette. 

Hit key  or  
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Positioning points 

Click a contour. 

Moving a point using the 
mouse 

1. Slide a point. 

2. Release the point when it reaches its new position. 

Key in the point’s XYZ coordinates. 

 You can key in the point’s XYZ coordinates in the Point Attributes 

dialog box. 

Aligning points 1. Select at least two points. 

2. Click the button for the alignment you want in the Points palette. 

Aligning horizontally 

on the Y coordinate of the 
first point selected 

 

Aligning vertically on 

the X coordinate of the 

first point selected 

 

Centering two points Align the points vertically and horizontally. 

Key in the same XYZ coordinates. 
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Projecting a point onto a guide 

1. Create guides which will be used as projection axes. 

2. Click a contour. 

3. Select some points. 

4. In the Points palette, click the button for the type of projection you want. 

5. Click the guide on which the points are going to be aligned. 

 

Horizontal projection of the curve handle 

 

Vertical projection of the start point 

 

Orthogonal projection of the end point 
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Producing a segment from a point 

The new segment replaces the point selected. 

Click a contour. 

Producing an arc segment 

This function generates control points at 
the ends of the segment, as well as the 
handle that will control its curvature. 

1. Click an angle point. 

2. Click in the Points palette. 

3. Key in the segment’s Radius: 

 

Key in a positive radius to orient the segment 
towards the outside of the contour. 

 

Key in a negative radius to orient the segment 
towards the inside of the contour. 

 

Producing a line segment 

This function generates control points at 

the ends of the segment. 

1. Click an angle point between two line segments. 

2. Click in the Points palette. 

3. Key in a positive Radius. Validate. 
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Transforming a segment 

Click a contour. 

1. In the Points palette, click the icon for the segment to be produced. 

2. Click each end of the segment. 

3. Slide the pointer to form the new segment. 

4. Click when the segment attains the desired position and size. 
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Managing contours 

Click a contour. 

Move 

1. Click in the Points palette. 

2. Click a contour. 

3. Slide the contour. 

4. Click when the contour reaches the desired position. 

Delete 

1. Click in the Points palette. 

2. Click a contour. 
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Connecting/Disconnecting two points 

Click a contour. 

Connecting 

Use this command to 
• close an open contour. 
• connect two open contours. 

 To connect several contours in one 

operation, use Auto-connect 
function. 

1. Select two open contour ends. 

2. Click in the Points palette. 

Disconnecting 

Use this command to 
• cut an open contour into two open 
contours. 
• open a closed contour. 

 To disconnect all the points of a 
contour in one operation, use 
Divide function. 

1. Click a control point, between two control points. 

2. Click in the Points palette. 

 Ungroup these objects to make them independent. 

 



Point mode 

193 

Auto-connecting open contours 

Auto-connecting different open contours 

 

Serie of black contours 

 

Multiple selection 

 

Auto-connection 

 

Single blue contour 

 

Connect their ends 
• to close each contour. 
• to link contours together. 

Use this function to close all open contours of an 
imported vector file (for example, DXF objects 
designed using Autocad). 

Example for auto-connection settings 

1. Check that each contour has the same direction. 
If needed, invert the contour's direction. 

2. Switch to Point mode. 

3. Select contours in the contour order expected. 

4. Click in the Points palette. 

 

Configuring the auto-connection  

The dimensions featured in the graphics are produced using the Dimension tool. 

 

Regarding the in-between distance, decide how you 

will connect the ends. 

1. Open the Auto-connexion dialog box: key 

depressed,  click. 

2. Set parameters in relation to the auto-connection 

mode you choose (linking or merging): 

 

Ends will merge into a single point: 

 

a. Untick box Separately. 

b. Key in the merging distance at least equal to 
the distance between ends. 

 

Ends will be linked with a curve: 

 

a. Tick box Separately. 

b. Key in the linking distance greater than the 
distance between ends. 

 

Ends will be merged or linked: 

 

a. Untick box Separately. 

b. Key in the merging distance. 

c. Key in the linking distance greater than the 
merging distance. 

 

 

3. Click. 
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Setting the auto-connecting of different open contours (example)   

 

Auto-connection settings 

Distance between ends Merging distance Linking distance Result 

Smaller than merging distance 

 

= 2 

 

= 3 

 

Merging into a single 
point 

Separately 

Between merging distance 
and linking distance 

 

= 1 

 

= 7 

 

Connection with a 
line 

Separately 

Smaller than linking distance 

 
 

= 2 

 

Connection with a 
curve 

Separately 

Greater than linking distance 

 
 

= 1 

 

No connection 

Separately 
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Refining/Simplifying a contour 

Click a contour. 

Refining a contour 

Add points according to a regular 
progression. 

 

 

Click in the Points palette. 

Each new point appears mid-way between two control points. 
If the contour has curve segments, a point handle is also added 
between two control points. 

Simplifying a contour 

Delete superfluous points, particularly to 
lighten the contours of a vectorized image 
or of a text converted into curves. 

Click in the Points palette. 

To delete points according to a regular 
progression: 

 

1. Key depressed,  click in the Points palette. 

2. Key in a Precision level that respects the contour’s original 
line; a value that is too high may warp the initial curves or 
replace them with lines. 

3. Click. 
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Cutting a contour 

This procedure allows the contour selected to be cut into open or closed contours. A start point appears at the 
start of each contour generated. 

 Ungroup these objects to make them independent. 

Click a contour. 

Cutting an open contour 

 

1. Click in the Points palette. 

2. Slide the pointer onto the contour. 

 

If you slide the cutter onto a point of the contour, you 
will obtain 2 open contours. 

To obtain several open contours, slide the cutter over 2 

or more points of the contour. 

Cutting a closed contour 

 

1. Click in the Points palette. 

2. Slide the pointer onto the contour. 

 

If you slide the cutter onto a point of the contour, you 
will obtain 2 open contours. 

To obtain several contours, slide the cutter over 2 or 
more points of the contour. 

 

To obtain closed contours: 

1. With the key depressed,  click in the 

Points palette. 

2. Slide the cutter over 2 or more points on the 
contour. 
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Cutting and cropping 

 

 Click in the Points palette. 

1. Click the first cutting point. 

2. Click the second cutting point. 

 If you cut a closed contour, the deleted contour 

is indicated using a red asterisk. 

To delete the opposite contour,  click while 

keeping pressed. 
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Dividing a contour 

Disconnect each 
point of the 
selected contour 
in one operation: 
each segment 
becomes an open 
contour. 

    

1. Click a contour. 

2. Click in the Points palette: each segment between two control points becomes an open contour. 

 Ungroup these objects to make them independent. 
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Using an image 

Using a bitmap image 

A bitmap image is a photo or drawing generated from a pixels grid, or points on the screen, with different 
colors. 

Placing the image in the composition  Import the relevant file (that the image is 
saved in a recognized bitmap format). 

 Digitize the original on paper using a 

scanner. 

 Create a blank image using the Bitmap 
Editor. 

Displaying the image in the work area 

 For optimal use, the image must have 16.7 

million colors and a minimum resolution of 
300 DPI. If needed, improve the quality of 
the image in the Bitmap Editor. 

1. Click the Display tab in the Options dialog box. 

2. Tick option Bitmap Images, unless you are 

manipulating a bulky image on-screen (the image 
is replaced by a crossed frame, display will be 
faster). 

Bitmap Images Bitmap Images 

Processing the image for engraving  Vector the image as contours. 

 Process the image using PhotoStyle. 
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Scanning an image 
Function 

The scanner allows a printed image to be reproduced on paper or film in the form of a grid of colored 

points called pixels. 

Selecting the scanner 

If you have plugged a TWAIN-compatible 
scanner into your computer, the program 
will identify it automatically. 

1. Select the Select scanner command in the File menu. 

2. In the Select Source dialog box, click the scanner used. 

3. Click. 

Start digitization 

Once the procedure has been executed, 
the image is displayed in the program. 

1. Start the digitization program that controls your scanner: 

Click in the toolbox (only click once: give the 

scanner time to start up). 

Click the Digitize command in the File menu. 

2. Specify the digitization parameters. The final image quality 
depends on: 
• the quality of the original 
• the scanner’s technology 
• the settings selected (brightness, contrast, resolution in 
DPI) 
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Vectorize 

Vectorizing an image 
Function 

This function is used to reproduce a bitmap image as contours. 

1. Place the image in the 

composition. 

2. Click the image to select it. 

 If no image is selected, digitization will automatically 

run before vectorization. 

3. Launch vectorization: 

Click in the toolbox. 

Click the Vectorize command in the File menu. 

4. Set the vectorization parameters. 

5. Configure the color reduction. 

The Vectorization dialog box indicates the execution of the 

procedure ( click to cancel): 

• the percentage of contours executed out of the total number. 
• the number of the current contour and the vectorization stage. 

You will obtain a composite object. 
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Setting the vectorization parameters 

Click the Vectorization parameters command in the File menu. 

With the key depressed,  click in the toolbox. 

 Default values  Click to restore the recommended values. 

 Check that the following parameters do not create a number of points likely to slow down 
vectorization, display, manipulation and engraving calculations. 

Quality 

Key in a value between min. max. 

Allowance 
Precision of the contour line to 
1/10th of a pixel 

0.1 3 

Noise filtering 
Eliminating interference pixels 

0 3 

Smoothing (Curve/Angle) 
Vectorization into curves or 
angles 

-1 +1 

Mode 1. Click Center line to vectorize the image 

in contours. 

in lines (tick Fast to simplify and speed up vectorization). 

2. Key in the Max. thinning, or maximum thickness of the line to 
vectorize as a line. Lines with a greater thickness are vectorized as 
contours. 

Zone 

1. In the Spot filtering setting, key in the width of the zones that 

are not to be vectorized. 

2. Click to vectorize 

on the black or color parts of the drawing. 

on the black, white or color background. 
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Reducing the colors to be vectorized 

1. Vectorize the image selected. 

2. Designate the colors to be vectorized in the Color reduction dialog box. 

Nb of colors  The number of initial colors is displayed in the box. 

Reset  Click to restore the initial colors. 

Automatic 
reduction 

3. Open the Setup color reduction dialog box: Options  click in the Color reduction 

dialog box. 

4. Adjust the Sensitivity or tolerance in terms of color recognition. 

5. Click box Contour destruction 

to limit the color zone to its exact contour. 

to extend the color zone to the neighboring pixels; 

Set the Sensitivity for contour destruction. 

Set the Sensitivity of fusioning areas for the shades with the dominant color. 

6. Click box to deactivate or activate the Preprocessing 

• Suppression of anti-aliasing: connect the transition shades between 2 colors to 
one of these colors. 
• Noise suppression: eliminate interference pixels 

7. Click. The number of colors is recalculated following implementation of the 
preceding settings. 

Manual 
reduction 

3. In the Nb of colors box, key in the number of colors to be vectorized. 

4. Select the colors to be merged: key depressed, click each color in the 

color chart or in the image preview. 

5.  Fusion  Click. The image is recalculated depending on the dominant colors. 

6. Select the colors to be vectorized: key depressed, click each color in the 

color chart or in the image preview. 

7. Click. 
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PhotoStyle 

Processing an image in PhotoStyle 
Option for ALL levels 

This option allows a bitmap image (photo, drawing, plan) to be reprocessed so the object to be engraved can 
be produced. 

Depending on its color, each pixel in the image on-screen is converted: 
• into a white pixel or an engraving point. 
• into a black pixel or an unengraved point. 

How do you delimit the surface of the image to be processed? 

Draw a closed contour around this zone. 
Select the image and the mask. 

Launch PhotoStyle: the portion of the image located 
outside the mask is converted into an unengraved 
black background. 

  

1. Place the image in the 

composition. 

2. Click the image to select it. 

3. Run PhotoStyle: 

Click in the toolbox. 

Click the PhotoStyle command in the Modify menu. 

 If no image is selected, the PhotoStyle Wizard will 

automatically run before PhotoStyle. 

In the PhotoStyle Wizard dialog box, 

click and digitize the image. 

click and import the image. 

4. Apply the opposite settings in the 
PhotoStyle dialog box: 

5.  Preview  Click to see the result. 

6. Click. The logo is displayed in 

the work area. 

 Setting engraving parameters 

 Making image treatments 

 Depending on whether the settings applied increase or 

decrease the final number of points, the object may be 
displayed in a size that is quite different from the size 
of the original image. The size of the object on-screen 
is not representative of its engraving size. 

 Perform an engraving test to assess the quality of the 
logo. If the result is not acceptable, delete the logo and 
restart the procedure. 
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PhotoStyle dialog box 
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Setting engraving parameters 

 

Each engraving resolution corresponds to a step distance between two engraved points. A 1.25 
mm step produces 8 points/mm. 
The more you increase the step, the more you reduce the number of points/mm and the quality of 
the engraving. 

Click an engraving resolution in the PhotoStyle dialog box. 

Click option Customize step and key in the step value. 

Standard 

Fast 

Thin 

Step = 0.425 mm 

 

The image default dimensions display in the PhotoStyle dialog box. 

Click box Keep scaling 

to enter the engraving height and width. 

to enter one dimension only. PhotoStyle calculates the other dimension proportionally. 

 For an optimum engraving, resize the image in PhotoStyle and keep the final logo size 
in the composition. 
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Making image treatments 

Converting colors 

 

This procedures allows you to simulate each image color by using 
a geometric pattern in black and white. 

Click Halftone type in the PhotoStyle dialog box: 

Bethesda 

Weston Knight 

Northfolk 

Applying effects 

 

Negative 

Depending on the material used, click to process the logo as a 
negative. 
By reversing the engraving points (white) and unengraved points 
(black), this command allows contrast effects to be engraved on a 
two-layer material with a light surface and a dark background (for 
example, Gravoply white on black) or on light paper with a stylus 
tool: the engraved points appear in the dark color and the 
unengraved points in the light color. 

 

 

Brightness 

Slide the cursor from -50% to +50% to regulate the 
level of image luminosity. 

 

 

Contrast 

Slide the cursor from -50% to +50% to regulate the 
variation in luminosity between light and dark zones. 

 
Soften 

Click to decrease the transition between light and 
dark zones. 

 
Sharpen 

Click to increase the transition between light and dark 
zones. 
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Adding a frame to the image 

Add a frame around the logo 
designed in PhotoStyle. 

 For quick machining, this 

frame is made of contours 
that you edit in Point mode. 

   

 Add a frame  Click in the PhotoStyle dialog box. 

1. Click a frame. 

Click to delete the frame  

2. Key in the margin percentage occupied by the frame in the final image surface. 

3. Enter the parameters for the type of frame: 

 

Key in the number of concentric curves around the image. 

 

Key in the number of intervals per side between 2 frame corners. 

 

Key in the number of concentric curves around the image. 

Key in the period number between 2 frame corners. 

4. Click. 

5.  Preview  Click in the PhotoStyle dialog box. 
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Bitmap Editor 

Retouching an image in Bitmap Editor 
Option for ALL levels 

1. Place the image in the 

composition. 

2. Click the image to select it. 

 If no image is selected, create a blank image 

automatically displayed in Bitmap Editor. 

1. Click in the toolbox. 

2. Enter the properties of the New Image: 

a. Key in the Width and Height (64x48 mm are default). 

Tick box Keep ratio to retain the width/height ratio. 

b. Click the number of Colors 2, 256 or 16.7 millions. 
Select 16.7 million colors so you can have access to all 
of the Bitmap Editor’s functions. 

3. Click and move to step 4. 

3. Display the image in Bitmap Editor. Double-click the image. 

Click in the toolbox. 

Click the Bitmap Editor command in the Modify menu. 

4. Retouch the image: 

5. Save the image. 

6. Exit Bitmap Editor: the 

image retouched is displayed in the 
work area. 

 Edit the image 

 Modify colors 

 Select the zone to edit with a mask 
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Guided tour of Bitmap Editor 

Editing an image Managing images 

Editing colors Using a mask 
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Bitmap Editor Menus 

File menu 

New 

Open 
Save 
Save as 

New image 

Opening a .bmp file 
Saving when working 
Saving an image 

Info Image 
Print preview 
Print 

Characteristics of the current image 
Printing the image 

Exit Closing the window and quitting the program 

Edit menu 

Undo Undo the last procedure 

Cut 
Copy 
Paste 

Editing the selection 

Conversion menu 

8-bit grayscale levels 
Conversion into 32 bits 

Grayscale levels 
Increasing the number of colors 
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Bitmap Editor Toolbars 

Image bar 

Edit an image Adjust colors Edit the selection 

Selecting the active color 

in the colors palette 

with the dropper 

Drawing 

a line 

a broken line 

a filled polygon 

a rectangle 

a filled rectangle 

an ellipse 

a filled ellipse 

Painting 

using the fine brush 

with the brush 

with the spray 

with the paint pot 

Manipulating 

Warp 

Sharpen 

Soften 

Effects 

Setting the number of colors 

Greyscale 

Histogram 

Halftone 

Halftone with diffusion 

Negative 

Correction 

Drawing the contour 

Filling the selection 

Filling outside the selection 

Cropping the image 
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Mask bar 

Create a mask Warp the mask 

with the magic wand 

from a symbol 

from a polygon 

from a free-form shape 

Delete the mask 

Move 

Rotate 

Horizontal alignment 

Vertical alignment 

Stretch horizontally 

Stretch vertically 

Vertical projection 

Horizontal projection 

Vertex 
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Common tasks in Bitmap Editor 

Saving while 
working 

Save regularly if you are creating a time-consuming or complex image, or if you have to 
stop in the middle of work. 

Use the keyboard shortcut. 

If the image has already been saved, the .bmp file of the same name is updated with 
the latest changes. Otherwise, save the image using the dialog box that opens. 

Undoing the last 
procedure 

Use the keyboard shortcut. 

Zooming Zoom using the mouse’s right-hand button 

Click to double the size of the image on-screen. 

Click a tool in the Zoom bar: 

Slide the pointer so the zone to be enlarged is framed. 

Increase the zoom 

Decrease the zoom 

Display the image at its maximum size 

Display the image at its initial size 

Cancel the zoom 

Print the image 1. Select the Print command in the File menu. 

2.  Properties  Click to configure the active Windows printer. 

3. Define the printing parameters. 

4. Click. 

Print preview 1. Select the Print preview command in the File menu. 

2. Click box Full page to print the whole image at the center of the page, 

regardless of its dimensions. 

3. Set the size of the image to be printed: click box Keep ratio to 

retain the ratio between the dimensions and to key in one of the dimensions. 

key in the Width and the Height. 

4. Click box Center image to 

• center the image on the page. 
• print only the portion of the image displayed in the Bitmap Editor window. 

5. Click. 
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Image files 

Managing images 

 New image 

 Saving an image 

 Opening a .bmp file 

Characteristics of the current image 

1. Open the Image Info dialog box: select the Image info command in the File menu. You will see: 
• the file access path 
• the image’s dimensions in points 
• the image’s dimensions in millimeters 
• the number of colors in the image: 256 colors or 16.7 million colors (True colors). 

2. Click. 
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New image 

Creating a blank image 

Save the image under a name other than 
[UNTITLED], which is assigned by default 
to each new image. 

1. Select the active color which will be the background color. 

2. Activate the New command: 

Use the keyboard shortcut. 

Select the New command in the File menu. 

3. Key in image's dimensions. 

4. Click the number of colors desired 2, 256, 16.7 millions. 

Select 16.7 million colors so you can have access to all of the 
Bitmap Editor’s functions. 

For a 16 or 256 grayscale image, click box Grayscale. 

5. Click. 

Creating an image based on an 
existing image 

You will obtain a copy that you can modify 
while keeping the original intact. 

1. Open a .bmp file. 

2. Save the image under a different name. 
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Saving the image 

Save the image on a diskette or a hard drive so it can be retained and modified subsequently. 
The image is saved as a .bmp file with the same name. 

1. Open the Save As dialog box: 

Use the keyboard shortcut. 

Select the Save as command in the File menu. 

2. Locate the folder where the file will be saved ( DRAWS is the default folder). 

3. Type your comments. 

4. Type the name of the image in the Name box. 

To replace an existing file, click its name in the list. 

To save a new file, delete the "*" character and key in a new name. 

5.  Save  Click: the file name will be displayed in the title bar. 

To bring up the Windows contextual help, click this box, then a zone in the dialog box. 
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Opening a BMP file 

Opening one of the last four files 
opened 

Click its name in the Recent File List of the File menu. 

Opening a composition or a model 

To bring up the Windows contextual 

help, click this box, then a zone in the 
dialog box. 

1. Open the Open dialog box: 

Use the keyboard shortcut. 

Select the Open command in the File menu. 

2. Locate the spot where the file to be opened is ( DRAWS is 
the default folder). 

3. Select the .bmp file to be opened: 

Click the file name. To search quickly, click in the list and 

type the first character of the name. 

Type its name in the Name box. 

4.  Open  Click: the file name will be displayed in the title bar. 
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Image 

Editing an image 

Selecting the active color Drawing 

in the colors palette 

with the dropper 

a line 

a broken line 

a filled polygon 

a rectangle 

a filled rectangle 

an ellipse 

a filled ellipse 

Painting Manipulating 

using the fine brush 

with the brush 

with the spray 

with the paint pot 

Warp 

Sharpen 

Soften 

Effects 
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Selecting the active color 

Available colors bar 

 

Click one of the four colors. 

Press the Space key to switch the colors, the first one being 

the active color. 

Dropper 
1. Click in the Image palette. 

2. Place the dropper on the color you want to select. 

3. Click. The color selected will become the active color. 

Creating a shade 

The resulting shade is displayed in the 
available colors bar. 

With the key depressed, click each color to be mixed. 

Release the key before clicking the last color to be mixed. 

256-color image 
1. Click in the Image palette. 

2. Click the box which contains the color you want. 

16.7-million color image 
1. Click in the Image palette. 

2. In the Color correction dialog box, select a color: 

Click a zone in the color wheel. 

Key in the RGB Parameters: 

R (red) between 0 and 255 
G (green) between 0 and 255 
B (blue) between 0 and 255 

3. Select a shade in this color (the shade obtained is displayed 
in the Chosen Color box): 

Click a shade in the color range. 

Key in HSV Parameters: 

H (hue) between 0 and 359 
S (saturation) between 0 and 255 
V (brightness) between 0 and 255 

4. Click. 
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Drawing in the image 

1. Select the active color (the surface of the filled shapes is filled in using the active color). 

2. Click the tool for the appropriate shape to be drawn in the Image palette. 

3. Draw the shape: 

Line 
a. Click to mark the start of the line. 

b. Slide the pointer to the other end. 

c. Release it to mark the point’s position. 

Rectangle 

Circle/Ellipse 

a. Click to mark the shape’s start. 

b. Slide the pointer to draw the shape. 

c. Release it when the shape attains the desired size and position. 

Broken line 

Polygon 

a. Click to mark the shape’s start. 

b. Slide the pointer to the next point. 

c. Click to mark the point’s position. 

d. Repeat steps 2 and 3 as many times as necessary. 

e. Click using the mouse’s right-hand button to mark the end of the line. 
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Painting the image 

Painting with: 1. Select the active color. 

2. Click the tool in the Image palette. 

The Paint pot replaces a color with 

the active color. 

3. Click the zone where you want to pour the paint. 

The Fine brush paints a 1-pixel line. 

The Brush paints a line based on a 

series of filled circles. 

The Spray gives you the impression 
you are painting using a spray gun or can. 

3. Place the pointer on the spot where you want to start 
painting. 

4. Slide the pointer onto the zone to be painted. Release it at 
the end of the procedure. 

Configuring the Brush 1. Open the Brush Configuration dialog box: key 

depressed, click in the Image palette. 

2. Set the Brush Size, between 1 and 64: you can view the 
line thickness in the preview. 

3. Click. 

Configuring the Spray 1. Open the Spray Configuration dialog box: key 

depressed, click in the Image palette. 

2. Set the General parameters: 
• Spray size, between 1 and 64 pixels 
• Spray rate: slide the cursor or click the ruler to set the 
paint’s flow rate. 

3. If you are in the 16.7 million colors setting, key in a 
Number of colors that falls between 1 and 16 and define 
each color in the Color list. 

a. Click a color. 

b. Click box Chosen color to change the color in the Color 
correction dialog box. 

c. Set the Color weight in relation to the other colors in 
the list. Slide the cursor or click the ruler. 

4. Click. 
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Warping the image 

1. Open the Image deformation dialog box: click in the Image palette. 

2. Click the Operation and key in the warping Parameters. 

3.  Apply  Click to preview the result. The image Size is displayed in millimeters and pixels. 

Reset  Click to change the result, and restart the procedure. 

5. Click at the end of the procedure. The dialog box will close and the warping is applied to the image. 

Operation Key in Key in (in pixels or in mm) 

Resize 

This procedure duplicates or deletes 
the pixels required to obtain the 
dimensions entered. 

coefficient 
Variation X, over the image’s 
width 
Variation Y, over the image’s 
height 

dimension 
Size X or the image’s width 
Size Y or the image’s height 

Resample 

This procedure minimizes defects 
(staircase effects) caused by 
resizing. It calculates the position 
and the color of the missing pixels. 

coefficient 
Variation X, over the image’s 
width 
Variation Y, over the image’s 
height 

dimension 
Size X or the image’s width 
Size Y or the image’s height 

Horizontal skew coefficient Offset X distance Offset X 

Vertical skew coefficient Offset Y distance Offset Y 

Rotation an Angle between 0° and 360°. 

Vertical or horizontal 
mirror/flip 
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Applying an effect in Bitmap Editor 

 Check that the image has 16.7 million colors. 

Soften 
1. Click in the Image palette to soften the image. 

2. Slide the pointer onto the zone to be smoothed out. The 
shade of the pixels is adapted to create a transition between 
two colors. 

Sharpen 
1. Click in the Image palette to sharpen the image. 

2. Slide the pointer onto the zone to be accentuated. The shade 
of the pixels is modified to increase the contrast between two 
colors. 

Filters 
1. Open the Image filtering dialog box: click in the 

Image palette. 

2. Select an effect: 

Embossing Creates a relief effect 

Soften Softens the image by creating transition shades between 2 colors 

Color pencil effect Finds the contours 

Edge enhance Enhances contours 

Sharpen Sharpens the image by eliminating transition shades between 2 
colors 

Laplace Not yet documented. 

 3.  Test  Click to preview the result. 

Reset  Click to change the result, and apply another effect. 

4. Click at the end of the procedure. 
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Colors 

Editing image colors 

Setting the number of colors 

Greyscale 

Histogram 

Halftone 

Halftone with diffusion 

Negative 

Correction 
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Setting the number of colors 

Increasing 

This procedure increases the number of colors to 16.7 million. Execute this conversion to apply an effect to the 
image. 

Select the Convert into 32 bits command in the Conversion menu. 

Reducing 

Open the Color reduction dialog box: click in the Image palette. 

Reset  Click to restore the initial colors. 

Automatic reduction 

1. Select the colors to be processed: key depressed, click each 

color in the current Palette or in the image preview. 

2. Process the colors selected: 

Delete  Click to delete them. 

Fusion  Click to merge them and and generate a dominant color. 

3.  Automatic reduction  Click. 

4. Click. 

Manual reduction 

 Default values  Click to restore 

the initial settings. 

1. Open the Options dialog box:  Options  click. 

2. Adjust the Sensitivity or tolerance in terms of color recognition. 

3. Click box Contour destruction 

to limit the color zone to its exact contour. 

to extend the color zone to the neighboring pixels; 

Set the Sensitivity for contour destruction. 

Set the Sensitivity of fusioning areas for the shades with the 
dominant color. 

4. Click box to deactivate or activate the Preprocessing 

• Suppression of anti-aliasing: connect the transition shades 
between 2 colors to one of these colors. 
• Noise suppression: eliminate interference pixels 

5. Click. 

6.  Reduce colors  Click in the Color reduction dialog box: the number of 

colors is recalculated following implementation of the preceding settings. 

7. Click. 
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Grayscale 

Conversion into grayscale 

This procedure converts the number of 
colors to an equal number of grays. 

Click in the Image palette. 

Reduction to 256 grayscale 

This procedure reduces the number of 
colors to 256 grayscale. 

Select the Grayscale 8 bits command in the Conversion 
menu. 
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Histogram 

This graphic shows the image’s grayscale distribution. The vertical axis indicates the percentage of pixels for 
which the color matches a grayscale indicated on the horizontal axis. 
The functions relating to the histogram allow the image’s brightness to be modified. 

1. Convert the image into grayscale. 

2. Click in the Image palette. 

3. Click the function that you want to apply. 

Equalization This function modifies the color of the pixels so they can be redistributed equally 
between dark and light grayscale tones. 

Specification This function allows a bitmap image to be opened which has a grayscale distribution 
that will be applied to the current image. 

Stretching This function modifies the color of the pixels so that the image contains all the 
grayscale tones. 

4. Click the Histogram view which you want to examine 

classic: weight of each grayscale tone 

simultaneous: total grayscale weight 

5.  Apply  Click to display the result in the preview. 

6. Click. 
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Halftones 

Halftone in black and white 

This procedure converts the colors into 
black and white motifs. 

Click in the Image palette. 

Halftone with diffusion 

This procedure converts the colors into 
grayscale motifs. 

1. Click in the Image palette. 

2. Key in a number of gray tones between 2 and 64. 

3. Click. 
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Negative 

Switching to a negative for an image or zone selected replaces each color with its opposite. The effect obtained 
is comparable to that of a photographic negative. 

Click in the Image palette. 
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Color correction 

1. Open the Correction of colors dialog box: click in the Image palette. 

2. Click the tab for the correction function. 

3. Key in the parameters for the correction function. 

4.  Apply  Click to preview the result. 

5. Click. 

Brightness/Contrast 

Brightness Lightens/Darkens the image 

+100% = pure white 
-100% = pure black 

Contrast Increases/Decreases the variation in luminosity between light and 
dark zones. 

HSV 

On-screen, a color may be defined from 
three components: 

Increases/Decreases 

H (hue) between 0 and 100% Shade of the color or gray 

Shifts all the colors up or down the red/green/blue range. 

S (saturation) between 0 and 100% Color’s purity 

0 = bright colors 
100% = grayscale 

V (luminance) between 0 and 100% Brilliance of the color on a scale running from black to white 

0 = pure black 
100% = pure white 

RGB 

On-screen, a color is reproduced from 
three primary colors: 

Increases/Decreases the level of 

R between 0 and 100% red 

G between 0 and 100% green 

B between 0 and 100% blue 
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Mask 

Using a mask 

The mask is a closed contour which is used to select a part of the image so it can be edited. 

Creating a mask 
with the magic wand 

from a symbol 

from a polygon 

from a free-form shape 

Delete the mask 

Warping the mask 
Move 

Rotate 

Horizontal alignment 

Vertical alignment 

Stretch horizontally 

Stretch vertically 

Vertical projection 

Horizontal projection 

Vertex 

Editing the selection 
Drawing the contour 

Filling the selection 

Filling outside the selection 

Cropping the image 
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Creating a mask 

Creating a 
polygonal mask 1. Click in the Mask palette. 

2. Click to mark the start of the shape. 

3. Slide the pointer onto the next point. 

4. Click to mark the point’s position. 

5. Repeat steps 2 to 4 as many times as necessary. 

6. Right-click to mark the end of the line. 

Creating a free-
form mask 1. Click in the Mask palette. 

2. Click the image. 

Creating a mask 
with the magic 
wand 

1. Click in the Mask palette. 

2. Click the color to be selected. 

3. Key in the selection parameters in the Magic Wand dialog box: 

Preview  Click to preview the mask. 

a. Click box to deactivate or activate the Preprocessing 

• Suppression of anti-aliasing: connect the transition shades between 2 
colors to one of these colors. 
• Noise suppression: eliminate interference pixels 

b. In the Parameters zone, adjust the Sensitivity or tolerance in terms of 
color recognition. 
Click box Contour destruction 

to limit the color zone to its exact contour. 

to extend the color zone to the neighboring pixels. 

c. Indicate if 1-pixel thin contours will be 

Drawn in the line of the mask 

Ignored 

d. Click. 

Choosing a mask 
from the collection 

 Symbol library  Click 

and open the .hpg 
file under HPGL 
Vectors format 
you will use as a 
mask. 

1. Click in the Mask palette. 

2. Double-click on a shape. 

If you select a polygon, key in the Number of edges and click  

3. Slide the pointer onto the image to draw the mask. 

4. Release it when the mask attains the desired size and position. 

Displaying/Hiding 
the mask Click in the Mask palette. 

Deleting the mask 
Click in the Mask palette. 
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Warping the mask 

Move 

Rotate 

Horizontal alignment 

Vertical alignment 

Stretch horizontally 

Stretch vertically 

Vertical projection 

Horizontal projection 

Vertex 

1. Create a mask. 

2. Click a warping tool in the Mask palette. 

3. Click the mask. 

4. Slide the pointer to warp the mask. Release it at 
the end of the procedure. 

 You can move the mask using any tool in the 
Mask palette. 

Configuring Vertex tool 

This tool is used to warp the mask from the points 
selected. It allows a star-shaped or cross-shaped 
mask to be created from a circle or polygon. 

1. Create a mask. 

2. Click in the Mask palette. 

3. In the Ngon mask dialog box, key in 
• every in a series of points (in this case, 4) 
• the number of points to Select (in this case, 1) 
• from point # (number of the first point) to 
point # (number of the last point) 

4. Validate. 

5. Click the mask’s contour. 

6. Slide the pointer to warp the mask. 

 

Selection 

 

Warping 
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Editing the mask selection 

Create a mask. 

Cropping the image 
Click in the Mask palette: the selection using the mask becomes the current image. 

Copying/Pasting 

1. Copy the selection: use the keyboard shortcut. 

2. Move the mask to the spot where you want to duplicate the selection. 

3. Paste the selection in the mask: use the keyboard shortcut. 

Cutting/Pasting 

1. Cut the selection: use the keyboard shortcut. 

2. Move the mask to the spot where you want to move the selection. 

3. Paste the selection in the mask: use the keyboard shortcut. 

Painting 1. Select the active color. 

2. Click the tool in the Image palette: 

Drawing the contour with the brush 

Filling the selection 

Filling outside the selection 
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Create Task objects 

Creating Task objects 

In the Tasks palette or in the Modify/Tasks menu, click the tool for the object to be created. 

Constructing dials 

The Dials option allows linear, circular or free-form 
graduations to be produced. 

Placing drilling points 

This function enables guides to be placed in the 
composition so that fastening holes can be drilled. 

Defining Text variables 

Using variables simultaneously allows a series of 
identical plates to be created and allows text entry for 
all of these plates to be automated. 

Producing a Matrix series 

The Matrix function allows a series of identical small 
plates to be engraved on a single large plate. The 
composition is used as a model to create the series of 
plates. 

Optimizing cutting in advanced mode 

This option distributes the objects to be cut in 
accordance with parameters set by the user. 

Optimizing cutting in automatic mode 

This option distributes objects to be cut within the 
composition so that losses of material can be reduced. 

Writing in Level 2 Braille 

This option allows a word to be typed and translated 
into its Braille equivalent in accordance with American 
A.D.A. standards. 

Producing a bar code 

This option allows text to be typed and transcribed 
into bar codes. 

Producing a ridge 

This option generates a surface from a contour. 
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Placing drilling points 

1. Open the Drilling dialog box:  click in the Tasks palette. 

 

  

2. Click the 
drilling 
zone: 

On material 

 

On selection  

 

3. Click the 
drilling 
type: 

Standard drilling 

 

resizable Circles to be cut 

 

4. Key in the 
drilling 
depth and 
width. 
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5. Place the 
drilling 
points: 

Preset layout 

a. Add or delete the points of your choice: 

Click a type of point. 

 

Click in the preview. 

 

b. Key in the distance from drilling points 
to 
• top and bottom edges of the 
composition (by default, equal to top 
margin). 
• left and right edges (by default, equal 
to left margin). 

c. Click. 

Free setting 

a. Click. 

b. Position the drilling point: 

Click in the composition. 

Key in its XY coordinates. 
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Writing in Level 2 Braille 
Option 

Creating a Braille object 

The set height for Braille text is 18 
points, or approximately 8.5 mm. 
The text will be machined, hollowed 
out or in relief, in accordance with a 
predefined tool path. 

1. Open the Level 2 Braille dialog box:  click in the Tasks 

palette. 

2. A message asks whether manual mode should be activated:  Yes  

 click. 

3. Designate the Braille standard in relation to your geographic 
zone. 

4. Type the text in the editor. 

5. Click the engraving path: 

 

Raised engraving with tool #9 

The frame delimits the surface area to be hollowed out. 
The cell points are machined as smooth domes on the material’s 
surface. 

 

Indented engraving with tool #8 

The cell points are drilled. 
Fiberglass beads are embedded in the points to form the text’s relief. 

 

6. Click. You will obtain a complex object. The original text is 
displayed as an indication only. 

7. Display engraving paths. 

Transcribing text in Level 2 
Braille 

1. Select the text. Even if you only select one line in a paragraph, all 
the lines will be converted into Braille. 

2. Execute the Creating a Braille object procedure. The text 
selected is displayed in the editor in the Level 2 Braille dialog box. 

To retain standard text, click box Keep the original text. 

Reestablishing the original text 1. Double-click on the Braille object. 

2. Right-click in the editor of the Level 2 Braille dialog box. 

3. In the contextual menu, click Select All. 

4. Right-click in the text editor. 

5. In the contextual menu, click Copy. 

6.  Cancel  Click. 

7. Paste the text:  click in the main toolbar. 
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Producing a ridge 
Function 

Create a closed contour around 
a contour. 
• Ridge an open contour, you 
will obtain a closed contour 
which follows the same line. 
• Ridge a closed contour, you 
will obtain a curve object 
consisting of two closed 
contours. 

Then you can engrave surfaces 
obtained from 
• text typed a 1 line-Gravograph 
font 
• single lines drawing 

 The text is automatically 

converted into curves. 

Object: Text typed with the Gravograph-New Hermes AVANT GARDE 
1L filar font 

 

 

Cutter: the surface of the characters can be engraved. 

1. Click the object to select it. 

2. Open the Ridge dialogue box:  click in the Tasks palette. 

3. To keep the object intact, click box Keep current curves. 

4. Click the type of line angle. 

5. Enter the distance of each of the surface’s edges in relation to the contour line. 

6. Click the type of angle at the ends. 

7. Click. 
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Automatic material optimization  
Option 

Reduce material scrap 
by setting pieces to be 
cut over a defined area. 

Run an automatic 
optimization to 
distribute objects from 
the bottom left corner of 
the composition, using 

10°-rotation with a fixed 
spacing of 0.5 mm. 

  

1. Convert the text into curves: optimization is applied only to curved objects. 

2. Select the objects to be cut. 

3. Click in the Tasks palette. 
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Advanced material optimization 
Option 

Distribute the objects to be cut in defined area using your optimization settings: 
• optimisation surface (composition or selected shape) 
• object orientation (rotation, symmetry, embedding, spacing) 

  

1. Convert the text into curves: optimization 
is applied only to curved objects. 

2. Decide what the optimization surface will 
be: 

3. Open the Material Optimization dialog 

box:  click in the Tasks palette. 

• Optimization is performed in the composition: select the 
objects to be optimized. 

• Optimization is performed within a predefined surface 
area: 

a. Draw the closed contour that defines the optimization 
area. 

b. Select this area, then the objects to be optimized. 

 

Here, the rectangle is the optimization area containing 
the characters converted to curves, and a star. 

4. Click the optimization surface: 

 

On material (by default) 

The objects are distributed within the surface area 
delimited by the composition’s margins. 

 

On first contour selected 

The objects are distributed within the closed 
contour you drawn. 

 

5. Click the optimization origin: 

 

Optimisation starts by default in the top left 
corner of the selected surface. 
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6. Click the distribution direction in the 
optimization surface: 

 

Horizontal distribution (by default) 

 

Vertical distribution 

 

7. Click the optimization options: 

 

Mirror 

Using symmetry, an object may be turned around 
or reversed within the optimization surface. 

 

In-hole 

Small objects may be placed into non-engraved 
areas, inside larger objects. 

 

The top part of an accented or punctuated 
character (letters i, è) may be embedded in 
another character (letters g, p). 

 

8. Click the type of rotation: 

 

Free (by default) 

Each object pivots according to an ideal angle for 
occupying the optimization surface. 

 

Step angle: key in the angle. 

With an interval of 5°, objects pivot according to 
an angle taken from the series 0°, 5°, 10°, 15°, 
20° up to 360°. 

 

Angle list 

Key in one or more imposed Angles by separating 

two values using the (;) character. 

 

None 

Each object retains its original orientation. 

 

9. Set the space between two objects: 

10. Set the Resolution between 0.1 

and 0.6, for fine or fast optimization. 

11. Click. 

 

a. Key in the tool 
diameter. 

b. Key in the 
clearance, or 
distance between 
2 cuttings. 
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To perform a different optimisation, keep objects selected and edit settings in Material 

Optimization dialog box. 

  

Accented or punctuated characters (i, è) are 
partially ungrouped so that the whole 
optimization surface may be filled. 

If the optimization surface is insufficient, 
several objects will be rejected. 

Either define more efficient optimization or resize the 
optimization surface. 
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Dials 

Producing a dial 
Option for ALL levels 

For a free-form scale 

a. Draw the shape that is going to be used as the scale support. 

b. Click the shape to select it. 

1. Open the Dials Wizard dialog box: click in the Tasks palette. 

The preview allows you to view the object’s construction. Click in to update the preview. 

2. Set the properties of the scale support. 

3. Configure the scaling marks. 

4. Set the dial's engraving properties. 

5. If needed, key in the dial’s text. 

6.  Finish  Click to generate the Dial object. 

7. Display engraving paths. 
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Properties of the scale support 

1. Go to step 1 in the Dials Wizard. 

2. Enter the parameters for the Support and the Scaling mode chosen (free shape, line or circle). 

3. Click the direction of the support, which determines the start point’s and the scale direction. 

clockwise (default direction) 

counterclockwise 

4.  Next>  Click to configure the scaling marks. 

Free shape (unavailable when no selection) 

This support is enabled if you select the shape before creating the dial. 

 

a. Enter the parameters for the Scaling mode authorized: 
• Distance between 2 strokes 
• Number of strokes 

b. Move on to step 4. 

 

Line (default support) 

a. Key in the XY coordinates for the line’s Origin. 

b. Key in the line’s slant Angle. 

c. Click a Scaling mode. 

d. Key in the parameters in relation to the mode chosen: 

Mode Parameters keyed in Parameter auto-calculated (in red) 

 

Distance between 2 strokes 

Number of strokes 

 

Support length 

 

Distance between 2 strokes 

Support length 

 

Number of strokes 

 

Support length 

Number of strokes 

 

Distance between 2 strokes 
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Circle 

a. Key in the XY coordinates for the arc’s Centre (default is the composition's lower left corner). 

b. Key in the arc' Radius. 

c. Click a Scaling mode. 

d. Key in the parameters in relation to the mode chosen: 

The arc begins on the start angle and 
finishes on the end angle, which 
determine the aperture and the length 
of the arc. 

The default support is a semi-circle: 
the start angle is 0, the end angle is 
180°. 

Use the trigonometry guide opposite to 

enter the start and end angles. 

 To have a circle, enter equal 
angles. 

 

Mode Parameters keyed in Parameter auto-calculated (in 
red) 

Clockwise Arc with 
• starting angle of +45° 
• end angle of +225° (or -125°) 

 

Start angle 

End angle 

Number of strokes 

 

Distance between 2 strokes 

 

Start angle 

Distance between 2 

strokes 

Number of strokes 

 

End angle 
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Start angle 

End angle 

Distance between 2 
strokes 

 

Number of strokes 
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Properties of the scaling marks 

1. Go to step 2 in the Dials Wizard. 

2. Define the properties for each set of marks: 

a. Select the number # of 
the set. 

 Repeat this procedure for each set of marks (10 

maximum). 

b. Click the Position on the support: 

outside (by default) 

centred 

inside 

c. Click the Profile: 

linear (by default) 

triangular 

flat 

rectangular 

d. Key in the Scale Height and Width 
(except for linear marks). 

 

e. Click to add text to the set of 
marks. 

f. Key in the Text height. 

g. Key in the Text/Scale Space. 

 

 

3. Enter the Sequence of marks which make up the scale: type in order the number # of each set. 

 

Linear dial with 11 strokes, built from 2 sets of marks according to 
sequence 001 

Set Profile Position Height Width 

#0   5 mm _ 

#1   4 mm 2 mm 

4.  Next>  Click to define the dial's engraving properties. 
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Dial engraving properties 

1. Go to step 3 in the Dials Wizard. 

2. Enter the Toolpath. 

3. Click Underline to machine the scale support: 

simple (by default) 

double: key in the distance between the two engraved lines. 

4. If there is no text, click to generate the dial  Finish   

If you have associated text with the scale, set the text's engraving properties: 

a. Click the text’s alignment in relation to the scale: 

on baseline (by default) 

on each scale top 

on the highest scale top 

b. Click the text’s orientation in relation to each scaling mark: 

orthogonal (by default) 

horizontal 

key in the text's slant Angle. 

c. Select the font that will be used to display the text. 

d. Select the toolpath that will engrave the text. 

e.  Next>  Click to input the scale text. 
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Dial text 

1. Go to step 4 in the Dials Wizard. 

2. Provide the text you want to associate with the scale. 

3.  Finish  Click to generate the dial. 

 The text is displayed over the graduation depending on 

• the support's direction (clockwise or counterclockwise) 
• the engraving properties (alignment and orientation) 

Automatic numbering a. Click to generate a logical series of numbers. 

b. Key in 

the Start value 

the Step or difference between two values 

the Nb of decimal digits fixed per number 

c. Click box 

Numbering each stroke to number all the scaling 

marks, even if no text is associated with them: numbers are 
not displayed for marks which do not accept text. 

Delete non-significant zero to eliminate superfluous 

decimals. 

Text variables 

 Add usable variables before 

associating them with a dial. 

a. Click to load an existing text variable. 

b. Select a list of names or an incrementation. 

Each value in the variable (number or line of text) is attached to 
a scaling mark. 

No text 

Click to pull up each button. 
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Text variables 

Using text variables 

Using text variables enables you to simultaneously create a series of identical plates and to automate text 
entry for all of these plates. 

1. Produce the composition which is used as a model for the series of plates. The plates share the 
parameters and the text of the master plate. 

2. Open the Variables dialog box:  click in the Tasks palette. 

3. Add the text variables. 

4. Save these variables. 

5. Insert the variables created in the text. 

To engrave a set of plates for apartment doors, 
you create: 
• a list of names that contains the name of 
each occupant in an apartment. 
• an incrementation that corresponds to the 
numbering of the apartments. 

After inserting the two variables in the master 
plate’s text, each plate in the series will display a 
name extracted from the list of names and an 
apartment number produced using the 
incrementation. 
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Creating a list of names 

This variable is a list of values relating to the same subject and is typed as a series of lines of text. 

Creating a list of names in the variables 
table 

 

1. Add the variable. 

2. In each cell in the column, type a value to be inserted in 
each plate. 

Opposite, Name variable is a names list which groups 5 
apartment occupants. 

Extracting a list of names from a text file 

 

1. Create the text file: 

a. Open the WordPad text editor. 

b. Type a value. If you group several lists of names (for 
example, names and ages), type a value for each list, 
typing a space between two values to separate them. 

c. Type the lines separator: input a line break (or 
carriage return). 

d. Repeat steps a and b until you have entered the final 
piece of data in the list. Do not key in a line break at 
the end of the text. 

e. Save the text as a .txt file. 

f. Click to exit WordPad. 

2.  Import  Click in the Variables dialog box and import the 

.txt file. 

3. A message will ask if you want the list of names to be 
extracted automatically. 

You request automatic extraction: 

Click. The list of names will be added to the variables 
table. 
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You want to perform manual extraction: 

 Manual extraction is recommended if 

the file combines several lists of 
names. 

 Cancel  Click. The text is displayed in the View file zone. 

4. In the Extraction mode zone, key in the Starting line 
where the extraction will begin. Each line of values is 
preceded by a row number. 

5. Tick the values extraction mode. Click: 

Separator 
The values are extracted 
column by column. Each 

column, which is delimited 
by a separator character, 
corresponds to a new list 
of names. 

Click a Column 
separator character. 

Click a Line separator 
character. 

Constant width 
The values are extracted 
line by line. Each line is 
limited by a number of 
characters which you 
define. 

Key in the number of 
characters in the Column 
format box. 
If the lines have different 
widths, key in the number 
of characters for each line, 
separated by a comma. 

6.  Preview  Click to view the values extracted in the 

Extraction preview. 

7. Click. Each list of names is added to the variables 
table. 
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Creating an incrementation 

This variable is a logical series of numbers calculated based on its first and last numbers, and its step, which 
determines the difference between two consecutive numbers. 

1. Add the variable. 

2. Open the Series dialog box:  Series  click. 

3. Click the Incrementation format: 
 

 

Numeric (default setting): series 
of numbers 

Pull up buttons Alphabetical and 
Alphanumeric. 

 Alphabetical: series of letters 

 Alphanumeric: series of 
numbers consisting of letters and 
figures (useful for generating 
serial numbers) 

 

4. Key in the incrementation parameters: 

 If you do not follow each procedure, the Start 
and End numbers will automatically be reversed. 

 

Start value 

 

Step 

 

 

End value or 
Number of numbers (click the 
parameter used) 

 

Generating increasing incrementation 

 

Key in an End value higher than the 
Start value. 

 

Key in a positive Step. 

 

Generating decreasing incrementation 

 

Key in an End value lower than the 
Start value. 

 

Key in a negative Step. 
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5. Key in the incrementation options: 

Setting a fixed number of figures per number 

 

a. Click box Constant number of digits in 
the Series dialog box. 

b. Type a character # per figure 

in the Format box. 

Opposite, Apt variable is a numeric 
incrementation: 

its start value is 1. 

its end value is 10. 

its step is 1. 

each number has 2 characters 

(##). 

Inserting text 

Type the text before or 

after each value. 

6.  Preview  Click to check the list of numbers: 

Example with a numeric incrementation    Values 

The incrementation stops on the last multiple preceding 
the End value, if this is not a multiple of the Step. 

18 25 2 18, 20, 
22, 24 

The incrementation stops on the Start value if the Step is 
greater than the difference between the Start and End 
values. 

18 19 2 18 

7. Click. The variable column is filled in with the list of numbers. 

Editing the incrementation 

1. Right-click its name in the first row of the variables table. 

2. Click the Series command in the contextual menu. 

 



GravoStyle 5 User Manual 

258 

Managing text variables 

Open the Variables dialog box: place the pointer on the variables table. 

Variables 

The first row of the table displays the name of the variables ready for insertion in the master plate’s text: each 
column contains values for the variable. 

Adding 

The values for the new variable will fill the 
corresponding column in the variables 
table. 

1. Right-click. 

2. Click the Add a variable command in the contextual menu A 
blank column is displayed in the variables table. 

3. Type the name of the variable (VAR is the default name). 
Validate. 

4. Create a list of names or incrementation. 

Deleting 

The column selected will disappear from 
the variables table. 

1. Right-click the name of the variable to be deleted. 

2. Click the Delete a variable command in the contextual 
menu. 

Renaming 1. Right-click the name of the variable to be renamed. 

2. Click the Rename a variable command in the contextual 
menu. 

3. Type the new name for the variable. Validate. 
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Values 

The first column in the table will display the number of plates in the series: each row contains values that may 
appear in the text of one plate from the series. 

Editing a value 1. Double-click on the value’s cell. 

2. Type the new value. 

Selecting a value Click the cell containing the value. 

Selecting a series of values 

The selection can spread across several 
columns and over several rows. 

Slide the pointer from the first cell to the last cell. 

Selecting a row of values Click the row number. 

Deleting 1. Select one or more values. 

2. Right-click. 

3. Click the Delete command in the contextual menu. 

or 

2. Press the key. 

Duplicating 

Duplicating a row of values allows several 
series of identical plates to be produced 
simultaneously 

To view the number of copies per row 

duplicated, click box Resume. 

1. Select one or more values. 

2. Right-click. 

3. Click the Copy command in the contextual menu. 

4. Click the cell from which the selection will be duplicated. 

5. Right-click. 

6. Click the Paste command in the contextual menu. 

Moving 1. Select one or more values. 

2. Right-click. 

3. Click the Cut command in the contextual menu. 

4. Click the cell from which the selection will be inserted. 

5. Right-click. 

6. Click the Paste command in the contextual menu. 
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Inserting a variable in the text 

Inserting in the text 1. Add the variables. 

2. In the master plate’s text, click the spot where you want to insert a 

variable. 

3. Define the variable's attributes. 

4. Click in the Tasks palette. 

5. Click the name of a variable (incrementation or list of names). 

6. Click: the name of the variable is displayed between brackets || 

7. In the Show state list in the Variables dialog box, click the number 
of the plate to be displayed (0 for the master plate): the name of each 
variable is replaced by the value associated with the plate displayed. 

Deleting a variable inserted 
in the text 

The variable’s values will no 
longer be featured in the series 
text, but the variable will still be 
in the variables table. 

1. Display the master plate. Double-click on the plate displayed. 

2. Select the name of the variable and the brackets || around it. 

3. Press the key. 

The composition opposite is used as a 
master plate. The text contains 
• the list of names |Nom| 
• the incrementation |Apt| 
• fixed text " - " separating the two 
variables 

 

Here, plate 6 is displayed. 

 

If a variable does not contain a value 
associated with the plate displayed, the 
zone that is reserved for it will remain blank. 
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Matrix Series 

Producing a Matrix Series 
Option 

Function 

The Matrix function allows a series of identical elementary plates to be engraved on one or more support 
plates. 

1. Produce the composition, which is used as a master plate for 
producing the Matrix series. The elementary plates share the 
master plate’s parameters and text. 

2. Configure the master plate in Material dialog box. 
Info zone displays the Maximum number of plates in the 
engraving area in relation to the dimensions and the 
orientation of the master plate (0°, 180° or 90°). 

3. If needed, insert an incrementation or a list of names in 
the text. 
Using a variable lets you automate the numbering or the text 
typing over the plates series. 

 

4. Open the Matrix dialog box:  click in the Tasks 

palette. 

If you clicked a 90°-orientation, you will be asked if 

you want to apply this parameter immediately. 

Yes  Click: elementary plates are correctly rotated in Matrix 

preview. 

5. Distribute the elementary plates over each support plate. 
You can choose a distribution in either static mode or dynamic 
mode, depending on whether you want to edit the text for 
certain plates or the distribution of all the plates. 

6. Set the cutting parameters for the elementary plates. 

 

7. Generate the plates in the series. 

Plates are displayed using the active engraving orientation. 

No need to set their orientation when you will the engraving 
properties. 

 

The composition below illustrates each stage of configuration in Matrix mode on an IS200 machine (225x80 
mm). 
This master plate with dimensions of 30 x 10 mm contains the text of the incrementation |NUM1|. This 
variable automatically numbers the plates in the series. 

 

 



GravoStyle 5 User Manual 

262 

 

Distributing elementary plates for a Matrix series 

The preview in the Matrix dialog box displays the distribution and the orientation of the elementary plates on 
each support plate. 
You will view 
• the size of a support plate (dark grid), by default equal to the dimensions of the active engraving area. 
• the final number of elementary plates needed (white rectangles), between 1 and the maximum number of 
elementary plates. 

After setting the distribution parameters, you will 

 Set the cutting parameters for the elementary plates 

 Generate the plates in the series 

1. Activate the distribution 
mode for the elementary 
plates: click box Dynamic 
Matrix, depending on 
whether you want a static 
or dynamic distribution. 

Dynamic Matrix: dynamic distribution (by default) 

Select dynamic mode to produce a series with over 500 identical plates. 
You can change the distribution of the elementary plates at any time, but 
the text remains fixed. 
It displays a single support plate for quickly checking the series on-screen. 

Dynamic Matrix: static distribution 

It is preferable to select static mode if you are producing a small series of 
plates, some of which have to be customized. 
Although the distribution of the plates remains fixed, you can change the 
text, size or position of an elementary plate independent of the other plates. 
Static mode displays all of the support plates, which can slow down display 
of the series of plates. 

2. Key in the dimensions of 
a support plate: 

Width Height 

3. Set the number of 
elementary plates per 
support plate: 

 If you key in a higher 

number per row or 
column, the maximum 
number of plates is 
retained. 

Click the last plate in a 
column/row to add or delete the 
column/row of plates. 

 

or 
• Key in Nb. X at most equal to the number of plates per row displayed in 
the preview. 
• Key in Nb. Y at most equal to the number of plates per column displayed 
in the preview. 

4. Key in Nb. of Layers or 
number of support plates. 

Upon machining, the machine is commanded to pause so the support plate 
can be changed. 

 To delete the current series, key in a number equal to 1 in the 

Nb. X, Nb. Y and Nb. Layers boxes. 
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5. Select the type of 
distribution for 
elementary plates in the 
Optimization zone: 

Click Yes for standard distribution. 

 

Click No to choose a distribution. Click the Presentation required: 

from top to bottom, left to right (by default) 

from top to bottom, right to left 

from bottom to top, left to right 

from bottom to top, right to left 
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Cutting elementary plates for a Matrix series 

1. Define the distribution of the elementary plates on each support plate. 

2. In the Matrix dialog box, set the cutting parameters, that will change the distribution of elementary 
plates. 

3. Generate the plates in the series. 

a. Click the type of Cutting Axes. 

b. Click a Tool path for a total or partial 
cutting. 

None (by default) 

Total 

Partial 

c. Key in the Border to offset the elementary 
plates in relation to the top and left edges of 
the support plate. 

This makes it possible to avoid having the cutting 
tool cut the accessory that holds the support plate 
(in particular a clamping table).  

d. Key in the Space between plates so that the 
cutting tool can pass through. 

 

 If the cutting parameters increase the support plate’s surface area and make it larger than the 

active engraving area, the Matrix distribution will be corrected: 
• the number of elementary plates per support plate is reduced. 
• the number of support plates is increased so it equals the total number of elementary plates. 

 

Partial cutting with a border and spacing between the plates 
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Generating the plates for a Matrix series 

Display engraving paths. 

Static series 

 To edit the Matrix 

parameters, immediately 
cancel the creation of the 
series. 

Click in the main 

toolbar until the master 
plate is displayed again. 

1. Set the distribution and the cutting for the elementary plates in the 
Matrix dialog box. 

2. Click: a number of layers equal to the number of support plates 

is created in the work area. 

3. In the Layer bar, click the layer for the support plate to be displayed. 
This contains 
• a Text object for each elementary plate. 
• possibly, a complex object grouping the cutting axes. 

 

Click the appropriate Text 

object to edit the text for an 
elementary plate. 

 

Click the appropriate Text 

object to manipulate an 
elementary plate (delete, move, 
resize, etc). 

 This kind of operation alter 

the distribution of the 
elementary plates in the 
support plate displayed. 
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Dynamic series 

1. Set the distribution and the cutting for the elementary plates in the Matrix dialog box. 

2. Key in the support plate’s number in the Layer View box. 

3. Click: the support plate contains a complex object that groups together the text of the elementary 
plates and possible cutting axes. 

Double-click on this object to edit its properties. The text remains fixed for the whole series. 

 

 View the whole series of plates in the engraving preview: the numbered support plates are 

displayed in the order in which they are engraved. 
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Bar Code 

Producing a Bar Code 
Option 

This option allows text to be typed and transcribed for bar codes. 

1. Open the Bar Codes dialog box:  click in the Tasks palette. 

2. Set the bar code’s properties. 

3. Set the code’s advanced parameters. 

4. Type the text to be transcribed in the bar code. 

5.  Finish  Click: you will obtain a complex object. Double-click on the object to edit its properties. 

6. Display engraving paths. 
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Setting code properties 

1. In the Bar Code/Choice of standard dialog box, click the Code. 
Note that certain codes require a Required nb of characters in the text to be coded. 

2. Key in the position or XY coordinates of the object’s origin. 
The object’s origin is its bottom left-hand corner. The default setting matches the work area's origin 
(coordinates 0,0). 

3. Click the code’s Orientation. 

4. Assign the Color for the bar filling. 

Tick option Invert Color to obtain raised bars by hollowing the external surface area. 

5. To see the start and end of the code, click box Margin Indicator. 

If box Show text is ticked in the Advanced parameters dialog box, the characters <> are displayed 

for indicative purposes under the bar code. 

6.  Next>  Click. 
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Setting bar parameters 

1. In the Advanced Parameters dialog box, set the parameters associated with the code selected: 

Size Y Bar height 

Min. bar width (1mm is default) Proportional variation of bar width and space interleave 

Space interleave (0 is default) Automatic interval between bars 

2. Click box Show text to display the following under the bar code for indicative purposes: 

• the margins indicators. 
• the text and the optional characters. 
Key in Text Height (12 pixels is default). 

3.  Next>  Click. 

DataMatrix parameters 

Min. bar width Size 

Square Tick the box to generate squared or rectangular symbols. 

Security level Key in a value adapted to the symbol shape. 
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Keying in bar code text 

1. Key in the text to be coded in the Code zone of the (Code name) Advanced Norme dialog box: 

Type the text. 

Use a text variable. 

2. Click the related box to add the optional characters (checksum, space, asterisk, etc.). 

If box Show text is ticked in the Advanced parameters dialog box, some characters are displayed 

for indicative purposes under the bar code. 

3.  Finish  Click. 

 Finish  The button will not be available, if the text does not comply with the entry instructions and the 

number of required characters set by the code selected. Make the corrections required to create the object. 

Using a Text variable 

This text entry mode allows you to code a series of serial numbers generated from an incrementation or 
from a names list. 

 Add the usable variable prior to transcribing it into a bar code. 

a. Click box Use text variable: you will no longer be able to type text in the Code zone. 

b. Select a variable: its name is displayed in the Code zone. If you have not added the variable to be 
coded, select the default variable, called CODEB1. 
Add this variable which is automatically displayed in the variables table. 

c.  Verify  Click to check that each value complies with the bar code standards (letters or numbers supported, 

uppercase or lowercase, number of characters required, etc.). 
The report in the Verify norm dialog box lists the wrong values overall the values of the variable. 
Edit these values in the variables table according to norm specifications described at the top of the report. 
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Engrave the composition 

Engraving the composition with an IS machine 

Assigning a toolpath to an object Decide which process is to be used for engraving an 
object by associating it with a tool. 

Defining the engraving properties Set the mechanical parameters involved in the 
physical execution of the engraving. 

Advanced engraving management Create and assign professional tool paths to curve 
objects. 

Tool Database This library references each tool available for 
engraving, as well as its physical and mechanical 
properties. 

Engraving preview View the composition in the engraving area and 
examine the engraving paths assigned to the objects 
selected. 

Engraving on a long plate This option allows a composition with a surface area 
that exceeds the area of the machine to be 
configured. 

Engraving on a cylinder The Cylinder Engraving mode allows a composition 

intended for engraving on a cylinder to be configured. 

Wysiwyre 2D render Simulate the engraving of the composition in the 
material of your choice. 

Transferring for engraving Transfer the composition data from the computer to 
the engraving machine. 
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Engraving path 

Assigning an engraving path to an object 

Assigning a tool path 

 

1. Open the Machining tools palette:  click 

in the toolbox. 

Each color corresponds to a path. 

2. Define the properties of each path. 

3. Display engraving paths. 

4. Group contours by engraving surfaces. 

5. Select an object or select text. 

6. Double-click a color in the Machining tools 
palette. Laser Colors palette. 

7. Repeat steps 4 and 5 for each object to be 
engraved. 

Defining a tool path properties 

 Changing the tool currently engraving is 

indicated by the tool name being displayed on 
the machine’s LCD screen. 

a. Click a Tool path in the Tool properties dialog 
box. 

b. Select the path type. 

c. Set the machining properties. 

d. Click. 

Save these properties. 

Displaying engraving paths 

 

Type the hotkey or click the command in the View 
menu: 

Wire contours to display the 

contours in the color of the path that is assigned to 
it. 

 

Filled contours to display the 

surfaces and contours in the color of the path that 
is assigned to it. 

 Engraving paths are also displayed in the 
engraving preview. 

Renaming a path 1. Right-click its name in the Machining tools 
palette (Tool followed by a number is the 
default name). 

2. Type a name that states the path executed 
(plotting, drilling or filling). Validate. 
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Designating the type of tool path 

1. Click a Tool color in the Path Properties dialog box. 

2. Click the Path Type tab. 

3. Click a tool in the list of Available tools: the Tool profile displays the features of the tool selected 
(diameter, truncation, etc). 

If you need, click to add a tool. 

4. Key in the engraving depth. 

5. Click the path type: 

 

Plotting 

The tool only engraves the object’s contours. 

 

Drilling 

The tool drills the material at drilling points or on markers. 

 

2D at bottom 

2D on surface 

The tool hollows out the surface of the object and then engraves the finishing 
contours. Key in the 2D filling parameters. 

6. Click. 
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Creating a filling path Function 

This tool path allows surfaces delimited by closed 
contours to be engraved. 

Check the filling in the engraving preview. The path 
is correct when: 

• the object’s line is accurately reproduced. 
• the surface of the object does not contain any 
white zone that has not been hollowed. 
• the hollowing appears regular and uniform. 

 

1. Designate the tool path type: perform steps 1 to 4, then indicate if contours are reproduced on the 

surface or at the bottom, especially for conical tools which cut is wider on surface than at bottom. Click 
the path type: 

  

2D on the surface reproduces the object’s 
contours at the engraving tip. 

2D at the bottom reproduces the object’s contours 
at the bottom of the engraving when using a 
material that has a transparent surface (Gravoglas). 

2. Click the 2D Filling mode: 

  

 

 

Hatch using rectilinear paths oriented 
according to a sweep angle between 0° and 
90°. 

 

Island using concentric 
paths outwards from the 
centre with connection 
between contours. 
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3. Key in an Overlap between 10% and 80%. This percentage determines the extent to 

which a hollowing line overflows onto the preceding line, proportional to the tool’s diameter. The 
difference between this percentage and 100% provides the pass width, or the distance between 2 
hollowing lines. 

  

Pass width = 80% 
Overlap = 20% 

Pass width = 50% 
Overlap = 50% 
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Defining the toolpath machining properties 

1. Click a Tool color in the Tool Properties dialog box. 

2. Click the Machining Properties tab. 

3. Define the machining properties in the passes table: the default table settings are the parameters set in 
the Machining parameters window of the Options dialog box. 

a. Set the number of passes to be executed (pass  is executed by default). Each tool path is 

engraved on one or more passes in accordance with a set of parameters and options that depend on 
the mechanical performance of your machine. 
A pass is the equivalent of a tool path for engraving the objects to which it is assigned. Several 
passes may be required to clear away the chips produced during preceding passes or for gradually 
achieving a given depth (engraving on fragile material). 
• Click next number to create a pass (4 maximum). 
• Click previous number to delete a pass. 

b. Set the machining parameters for each path pass: 

 

Speed on the XY axes 

 

Speed on the Z axis 

 

Click to select the desired speed. 

 

Engraving depth 

Key in a suitable value depending on whether the engraving is executed 
with or without a nose. 

 

Low time-dwell 

 

Click to select the length of the time-dwell. 
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c. Click the related button to activate or deactivate a machining option: 

 

Spindle motor rotation 

Material is taken out by the rotation of the tool, which is driven by the spindle motor. 
Tool rotation is not necessary for engravings where there is no drilling, or where no 
material is taken out. 
For example, engraving with a diamond, where the tool scratches the material’s 
surface, or with a pen, where the line is marked in ink. 

 The tool only physically begins rotating if the spindle motor’s rotation is 

activated in the Machining dialog box and execution of the engraving is 
started on the machine. 

 

Lubrication 

This option triggers the lubrication system, which is useful for extending the tool’s 
lifespan and for improving the engraving quality. 

 

Pause between tools 

This option generates an automatic pause between the paths executed featuring in 
the Tools list. 
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Tool engraving properties 

Defining the engraving properties with an IS machine 

1. Open the Machining dialog box: 

Type the hotkey. 

Click in the main toolbar. 

Click the Machining command in the Machining menu. 

2. Define the toolpath engraving properties (speeds, depth, dwell, etc.): 

3. Define the general engraving properties (origin, orientation, options, etc.): 

Click to validate the new properties. 

 Preview  Click to display the engraving preview. 

 Run  Click to transfer the composition to the machine. 
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Defining the general engraving properties 

A. Open the Machining dialog box. 

B. Set the engraving parameters: 

Flat engraving or Engraving on a cylinder 

Engraving on a cylinder is automatically activated if 
you have defined the cylinder parameters in the 
Material dialog box. 

 TS   TC  To modify the cylinder engraving 

parameters, click the button with the name of the 
accessory in the Machining dialog box. 

 

Click Flat To restore flat engraving 
(vice, low-pressure or clamping 
table). 

 

Origin 

1. Click to select an origin different from the one 
chosen in the Material dialog box. 

2. If you have chosen a floating origin, key in its 
coordinates 
X, distance from the origin to the 0 point on the 
X axis. 
Y, distance from the origin to the 0 point on the 
Y axis. 

Orientation 

Click to select an orientation from the one chosen in 
the Material dialog box. 

Z-clearance 

Measured from the Zref point, this parameter 
defines the distance over which the tool is raised 
between an engraved line and the following line. 
To understand the effect of the Zref setting on 
clearance, refer to the user manual enclosed with 
your IS machine. 

This parameter can be edited in 
Machining dimensions. 

Key in a movement value that is at least equal to 
the material’s maximum thickness. 

• To engrave a planar surface, key in a movement 
value that is low but is sufficient to avoid engraving 
a line between two independent lines. 

• To engrave a surface with several reliefs, key in a 
maximum movement value so that the tool will 
never come into contact with the material during its 
horizontal movements. 

 Key in a clearance value that complies with 

the technical characteristics of your 
engraving machine. Adapt the Z-clearance 
to each new Zref setting. 
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C. Set the engraving options: 

Spindle motor rotation 

 The tool only physically begins rotating if 

the spindle motor’s rotation is activated in 
the Machining dialog box and execution of 
the engraving is started on the machine. 

Click to start or stop the spindle motor. 

Material is taken out by the rotation of the tool, 
which is driven by the spindle motor. 
Tool rotation is not necessary for engravings where 
there is no drilling, or where no material is taken 
out. 
For example, engraving with a diamond, where the 
tool scratches the material’s surface, or with a pen, 
where the line is marked in ink. 

Lubrication 

This option triggers the lubrication system, which is 
useful for extending the tool’s lifespan and for 
improving the engraving quality. 

Automatic plates loader (A.P.F.) 

This option becomes available as soon as you have 
produced a Matrix series. 

Click to activate the automatic loading of the plates 
for the series. 

Tool changer 

Not yet documented. 
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Toolpath properties 

Defining toolpath engraving properties 

1. Click a Tool color in the list in the Machining dialog box: each path used in the composition is 
identified by its color and number in the Tool properties dialog box. 

2. Define its machining properties in the passes table: the default table settings are the parameters set in 
the Machining window in the Tool Properties dialog box. 

a. Set the number of passes to be executed. 

b. Set the machining parameters for each path pass. 

c. Set the machining options. 
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Description of toolpath engraving parameters 

These parameters must be adapted to the mechanical performance characteristics of your Gravograph 
machine, as well as to the characteristics of 
• the material engraved (thickness, strength, flatness) 
• the engraving tool (diameter, type, grinding angles) 
• the composition (series production, fonts, height of the characters). 

 Set these parameters in accordance with the technical characteristics of your IS machine. Refer 
to the Gravograph manual enclosed with the machine. 

Speed on the XY axes 

This parameter defines the tool’s horizontal movement 
speed (in mm per sec.) when marking the material. 

Modifying the current speeds 

1. Click the icon in the passes table. 

2. Key in Speed XY or Z Min. Med. Max. 

Default  If this button is present, click it to restore 

the standard values. 

3. Click. 

Speed on the Z axis 

This parameter defines the tool’s drop speed (in mm 
per sec.) when drilling the material. 

Engraving depth 

This parameter, which is measured from the Zref 
point, defines the distance the tool drills into the 
material. Refer to the installation guide delivered with 
your Gravograph-New Hermes machine to understand 
the influence of the Zref setting on the engraving 
depth and to make this mechanical adjustment to the 
machine. 

Use of a nose is advised, unless the nose poses the 
risk of scratching the engraved material. The depth-
regulating nose does not require a precise Zref 
adjustment and allows a precise, constant engraving 

depth to be created over the whole engraved surface 
(materials with variable thicknesses). 

 For an engraving with a depth-regulating 
nose, key in a value of 0.00 in the passes 
table and adjust the engraving depth on the 
machine. 

 For an engraving without a depth-regulating 

nose, key in a value between 0.01 and the 
material thickness in the passes table. Adjust 
the engraving depth to each new Zref 
setting. 

Low time-dwell 

This parameter defines a stand-by time (in seconds) 
between the end of the drilling and the start of 
marking the material. 
As soon as the engraving depth is attained, the low 
time-dwell is triggered. The tool holder remains 
immobile, while the tool’s rotation removes chips 
produced by drilling the material. 
At the end of the time-dwell, the tool holder will move 
horizontally to engrave the line. 

Modifying the current time-dwell 

1. Click the icon in the passes table. 

2. Key in time-dwell Min. Med. Max. 

Default  If this button is present, click it to restore 

the standard values. 

3. Click. 
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Customizing toolpath engraving parameters 

 Set the parameters below in accordance with the technical characteristics of your IS machine. 
Refer to the Gravograph manual enclosed with the machine. 

1. In the Options dialog box, click the Machining parameters tab. This window allows the following 
parameters to be customized: 

 Speed on the XY axes 

 Speed on the Z axis 

 Low time-dwell 

2. If you wish to trigger this time-dwell, click box Activate. 

Otherwise, do not modify the values for this parameter. 

3. For each parameter, key in the minimum, medium or maximum value. 

4. For each parameter, click the active default value in the passes table: min, medium or max. 
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Displaying the engraving preview 

 Preview  Click in the 

GravoStyle Machining dialog box 

CAM Machining dialog box 

The engraving area is represented by a white rectangle. 
The composition’s surface is delimited by a dotted red frame. 

 

For complex compositions, the engraving preview can display the engraving order of 
• the support plates for a Matrix series 
• the panels for a long plate 

The engraving preview also helps you to check any overflows outside the engraving area. 
This problem may be caused by the positioning of an object outside the composition or an incorrect 
configuration of the composition. 
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Long plate 

Producing a composition on a long plate 
Option 

Function 

This configuration enables a composition to be engraved that has 
• a surface area which is, at most, equal to the engraving area. 
• a dimension which exceeds the height of the engraving area. 

1. Configure the composition: 

 

Key in the dimensions. 

• If the length is greater than the height of the engraving area, you will 
obtain a horizontal long plate. 

• If the height is greater than the height of the engraving area, you will 
obtain a vertical long plate. 

 
The engraving orientation is 

 

normal for a horizontal long plate. 

 

90°-rotation for a vertical long plate. 

 

The engraving origin must be the machine’s left-hand corner. 

 

In the Info zone, a message will warn you that the long plate 
configuration is activated automatically (the maximum number of plates 
is zero). 

2. Place the objects to be engraved in the composition. 

3. Define the long plate. 

4. Execute the panels engraving. 

The composition below illustrates each step involved in long plate configuration. 
What is involved is a horizontal long plate with dimensions of 300x80 mm, engraved on an IS200 machine 
(225x80 mm). 

 

 Configuration on a cylinder and Matrix series are not allowed in Long Plate mode. 
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Defining the long plate 

After placing objects in the long plate, open the 

GravoStyle Machining dialog box 

CAM Machining dialog box 

The Long plate definition dialog box will 
open. This preview allows you to: 
• check the long plate’s positioning in the 
engraving area. 
• manage the number of panels required to 
execute full engraving. 
• reposition the cutting lines between the 
panels. 

The engraving area is represented by a 
brown frame. 
Each panel is delimited by a dotted red 
cutting line which is its top edge. 

 

4 panels in the initial definition 
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Edit the cutting lines to redefine the size of 
a panel and avoid having certain objects 
straddling two panels. 

Click to validate the new panels. 

 

5 panels after editing the cutting lines 

 Preview  In the Machining dialog box, 

click to display the engraving preview. The 
numbered panels are displayed in the order 
of engraving. 
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Editing the cutting lines 

1. Zoom in the Long plate definition dialog box. 

2. Create or reposition a cutting line. Following these procedures, the number of panels is recalculated for 
full engraving of the composition 

3. Click to validate the new panels. 

Moving a cutting line using the mouse 

 

a. Click right-hand end of an existing cutting line: the pointer 

indicates that you can move the cutting line. 

b. Slide the right-hand end of the cutting line vertically. 

c. Click to mark its position on the right-hand edge of the 
composition. 

d. Validate. 

 The position of the cutting line is set as soon as the 
size of the panel equals the engraving area. 

Entering the position of a cutting line a. Double-click on the value that is displayed near the left-hand 
edge of the panel. 

b. In the Edit Cutting Line dialog box, key in the cutting 
line’s new position. 

c. Click. 

Drawing a straight cutting line 

 

a. Click the left-hand end of an existing cutting line:  the 
pointer indicates that you can create a new panel. 

b. Slide the left-hand end of the new cutting line vertically. 

c. Click to mark its position on the composition’s left-hand 
edge. 

d. Slide the pointer to draw the cutting line. 

 If the new cutting line is near an existing cutting line 

and if the size of the panel does not exceed the 
engraving area, the preceding cutting line will be 
deleted. 

Drawing a broken cutting line a. Click several times to draw a broken line avoiding the 
objects’ contours. 

b. Click to mark the position of the right-hand end on the 
plate’s right edge. 

 



Engrave the composition 

289 

 

Engraving on a long plate 

Preparing the engraving 

 

1. On the plate, mark the cut line coinciding with the top 
edge of each panel using the felt marker. 

2. On the machine, fit the specific long plate engraving 
table (consult your Gravograph distributor). 

3. Set up sufficient space for moving the plate at the front 
and rear of the machine. 

4. Set the plate so that the largest dimension is parallel to 
the table’s left edge. 

Executing transfer before engraving Transfer the composition to the machine. 

 Tool path sel If you select the paths to be transferred, note 

that the panels featuring the paths are selected by default. 
Each path has the name and number of the Tool, and the 
number of the layer [], followed by the number of the panel 
Pan on which it is located. 

Launching engraving on the machine 

 

1. Key in a maximum value for the TIME OUT. This period 
allows the machine to be kept in receive status while 
the transfer is being performed. To set the TIME OUT, 
consult the Gravograph manual enclosed with your 
machine. 

2. Hit the key to launch the engraving. The LCD 

screen will display the following message: 

<OFFSET PLATE> 
xxxx,xx mm 

3. Release the plate. 

4. Align the top edge of the first panel on point 0 in the 
table. 

5. Set the plate. 

6. Press the key once again. 

The machine will engrave the panel and then stop (the tool 
will return to the engraving origin). 

For the following panels, repeat the procedure from step 2. 
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If you note a fault during engraving, immediately press this key to suspend the engraving. 

Press a button on the joystick to execute a new pass on the current panel. 

 These actions are only possible during engraving. 
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Wysiwyre 2D render 

Displaying Wysiwyre rendering on the material 

New render 

If needed, compare 
several renders. 

1. Display the current composition in the Wysiwyre window: 

Click in the toolbox. 

Click command Wysiwyre in the Modify menu. 

2. Set the rendering parameters: 

 Material 

 Engraving width 

 Background color 

 Fill color 

 Shape of the plate 

 

Wysiwyre 
preferences 

Save the rendering 
parameters as 
preferences so they 
can be applied to 
each new render. 

1. Open the Preferences dialog box: 

Use the keyboard shortcut. 

Select the Preferences command in the File menu. 

2. Click. 
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Wysiwyre window 

Displaying a render Comparing renders 
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Wysiwyre menus 

File menu 

Close 

Print 

Close the active render 

Print the active render 

Info 
Preferences 

Information on the active render 
Save the rendering parameters as preferences 

Recent files List of the last four files open 

Exit Close and quit the program’s window 

Materials menu 

Tools menu 

Engraving width Set an engraving width equal to the size of the tool 

Display menu 

Tool bar 
Status bar 

Display or hide the tool bar 
Display or hide the status bar 

Background color 
Fill color 
Shape 

Adjust the background color 
Adjust the finishing color 
View the shape of the plate 

Window menu 

New window 
Reorganize the icons 
Cascade 
Tile 

Compare several renders for the same composition 

Help menu 

Help sections Open the on-line Help 

About Wysiwyre Information about the program 
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Choosing the material to be engraved 

1. Open the Material Choice dialog box: 

Click on the range in the tool bar. 

Click the generic name in the Materials menu, and then on the range in the related sub-menu. 

2. In the dialog box for the range, click the material you want (in this case, Gravoglas textured ref.188). 

Note that the characteristics of the material are displayed (properties, applications, engraving depth). 

 

3. Click. The material selected is displayed in the name of the active render. 
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EEC materials 

GravoPLY I 

METalLeX indoors 

METalLeX outdoors 

METalLeX hard coat 

MELaMINe 

GravoGLAS Surface Mat 

GravoGLAS Surface Glossy 

GravoGLAS TEXture 

GravoGLAS Sub-surface Mat 

GravoGLAS Sub-surface Glossy 

Gravoply Design Translucid 

GravoXAL 

GravoSTRal 

GravoMETal 

GravoFOIL 

GravoPLaST 

USA materials 

2-PLeX Matte surface 

2-PLeX Glossy surface 

2-PLeX Metallics surface 

2-PLeX Textured 

2-PLeX Matte sub-surface 

2-PLeX Glossy sub-surface 

2-PLeX Metallics sub-surface 

ARCHitectural GAUGe 

GravoPLY 

METalLeX II 

METalLeX 

GravoPLY.020 &.040 

Gravotac 

PHENOLIC 

Fluorescent Acrylic 

ACRYLIC 

SANDMASK 

Calendered VYNIL 

Reflect VINYL 

Trophy Brass 

COLored ALUminium 

COLored STeeL 

Shared materials 

GravoPLY II 

Gravoply Design/II Granites 

Gravoply Design/II Mat Decor 

Gravoply Design/II Woods 

Gravoply Design/II Tech Patterns 

ALUminium ANOdisal 

Premium Lead Brass 
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Setting the engraving width 

1. Open the Tool Size dialog box: 

Click in the toolbar. 

Click the Engraving Width command in the Tools menu. 

2. Key in a value between 0.01 and 10mm, depending on the tool’s diameter and the engraving depth. 

3. Click. 
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Displaying the background color 

1. Open the Color dialog box: 

Click in the toolbar. 

Click the Background Color command in the Display menu. 

2. Slide the Red/Green/Blue cursors until you obtain the color you want in the color chart. 

 

3. Click. 
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Filling in the finishing color 

1. Open the Fill Color dialog box: 

Click in the toolbar. 

Click the Fill color command in the Display menu. 

2. Slide the Red/Green/Blue cursors until you obtain the color you want in the color chart. 

 

3. Click. The objects engraved are filled in using the finishing color (simulation for BRASS or 
GRAVOGLAS materials). 
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Viewing the shape of the plate 

1. Open the Shapes dialog box. Select the Shape command in the Display menu. 

2. Click the shape required (default shape: Rectangle). 

3. Click box Plate contour to delimit the composition using a dotted line around the plate. 

4. Click. 

 

 If the objects spill out of the plate, exit Wysiwyre and correct the composition. 
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Comparing several Wysiwyre renders 

Displaying renders 

To activate a render, click its window or its 
name in the list in the Window menu. The 
render selected is displayed in the 
foreground. 

1. Click the New Window command in the Window menu. 

2. Define the parameters of the new render. 

3. Arrange the windows in cascade or tile mode. 

Information about the active render 

This command displays the dimensions of 
the composition and the material. 

1. Open the Information dialog box: 

Click in the toolbar. 

Use the keyboard shortcut. 

Select the Info command in the File menu. 

2. Click. 

Printing the active render 
1. Click in the toolbar. 

Click the Print command in the File menu. 

2.  Properties  Click to configure the active Windows printer. 

3. Define the print parameters. 

4. Click. 
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Transfer for engraving 

Transferring the composition to the IS machine 

 Before making the transfer, check that: 
• the computer and your machine are correctly connected. 
• your machine is powered up. 
• your machine is not in the process of making an engraving. 
If you have not installed your machine, follow the installation procedure and advice provided in 
the Gravograph manual enclosed. 

1. Select the objects to be engraved (all by default). 

2. Open the Machining dialog box. 

3. Designate the active target machine; choose the machine that is actually going to engrave 

the current composition. 
If there is none, add this target machine. 

4. Select paths to be transferred. 

5. Configure the transfer. 

6. Define the properties for tool engraving. 

7.  Run  Click: the progression bar indicates the percentage of data transferred. 

To stop the transfer  

8. On the engraving machine, execute the pre-engraving settings (consult the Gravograph manual for your 
machine). 

9. Run the engraving from your machine’s control panel. 

 The order of creation and selection of the paths determines the engraving order. In terms of 

engraving, closed contours are given priority over open contours. 

 Changing the tool during engraving is indicated by the tool’s name being displayed on the 
machine’s LCD screen. 

 Any modification made to the composition will only apply to the engraving following a new 
transfer that deletes the previous one. 
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Selecting the engraving paths to be transferred 

1.  Tool path sel  Click in the 

 

GravoStyle Machining dialog box: the Path selection dialog box displays the list of tool 
paths assigned to the objects selected. Each path has the name and number of the Tool, well 
as the number of the layer [] on which it is located. 

 

CAM Machining dialog box: the Path selection dialog box displays the list of tool paths 
assigned to the objects preselected. 

2. Select the paths to be engraved (all by default): key depressed, click to deselect or select a 

Toolpath. 

All  Click to select all the paths. 

None  Click to deselect all the paths. 

3. Click. 

4.  Preview  Click to see the paths in the engraving preview. 
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Configuring transfer to the machine 

These options determine the conditions under which transfer of the composition takes place once you have 

clicked  Run  in the 

GravoStyle Machining dialog box 

CAM Machining dialog box 

Transfer mode Click the mode you want. 

Test: the data transferred are displayed in the Test window. 

Click to close the window  Close  

Port: you will send the composition to the active target machine. 

Grouping paths by transfer 
file 

1. Collate  Click. 

2. Click the box for the type of grouping: 

None to transfer to a single file the paths selected in the Path 

selection dialog box. 

By layer to transfer to a distinct file the paths in each layer. 

All layers are transferred to a single file. 

Managing transfer files 

If you have carried out several 
consecutive transfers, you can 
define their order of engraving. 

1.  Spooler  Open the Windows manager window for the target machine. 

2. Right-click an engraving file. 

3. In the contextual menu, click 
• Suspend printing to temporarily interrupt transfer to the machine. 
• Cancel printing to cancel the transfer. 

XY overflow 

During transfer, this simulation 
indicates any overflow of the 
composition in relation to the 
engraving area. 

This problem may be caused by 
positioning of an object outside 
the composition or an incorrect 
configuration. 

 Back for correction  Click to edit the composition. 

Continue  Click to force the transfer. 
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CAM Machining 

Advanced tool engraving management  
Function 

1. Produce your composition. 

2. Convert to curves the text objects and complex objects. 

3. Click in the toolbox. The composition is displayed in the CAM window. 

 

This environment grants you more 
flexibility and more productivity in 
managing, optimizing and simulating 
toolpaths. 

The toolbox offers a quick access to path 
creation, tool management and control 
over objects to be machined. 

Add as many paths as required from 
Create toolpath window. 

Manage paths in Toolpath list. Show or 
hide some paths to combine or compare 

them and to transfer the paths to be 
machined. 

Define the path calculation 
preferences to assign your personal 
parameters and options to each new tool 
path. 
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CAM Toolbox 

 

Creating a toolpath 

 

Managing toolpaths 

 

Using Tools Database 

 

Creating a special tool 

 

Grouping/Ungrouping objects 

 

Locating overlaps in contours lines 

 

Optimizing tool choice 

 
Measuring objects 

 

Editing contours to be machined 
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Toolpath 

Creating a toolpath 

 

1. Using the CAM pointer, select the 

objects you want to assign the future path to 
(all the objects in each layer are selected by 
default). 

2. Open the Create toolpath dialog box: 

click in the toolbox. 

3. Open a library of available paths 

(click to display or hide the types of 
path). 

4. Add each useful tool path. 

a. Select its type: 

Double-click the path. 

Right-click a path, and then the 

Compute command in the contextual 
menu. 

b. Define the path’s properties. 

 

Open the Toolpaths list: click in the 

toolbox. 

Each new path is stored in the group for 

the layer on which the selection is placed. 

Manage your paths in the Toolpaths list: 

1. Right-click a path in Toolpath list. 

2. Click an operation in context menu: change 
path properties, run path simulation at 
screen or send it to machining. 

Test a path 
• in the Tool Choice Optimization dialog box. 
• in the work area using the tool cursor. 

 Each path created is saved in the 
DRAWS folder as a file with the name of 
the composition, followed by the path 

creation number (plate.000, plate.001, 
etc.). 
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Machining properties 

Defining toolpath machining properties 

1. Set the path calculation preferences. 

2. Create a new path or edit the properties of an existing path. 

3. In the dialog box for the path, click the tab displaying the 
properties to be defined (depending on the path, the dialog box 
will propose a variable number of tabs). 

a. Set the standard properties (tool choice, depth, group 
or object machining, resolution). 

b. Key in the pass parameters (number or depth, 
conventional or climb milling, pass width, etc.). 

c. Set the tangent entry or exit properties (Expert mode 
with collision control). 

4. Click. 

 For further information on the 

properties specific to a path, 
click the type of path. 

 Plotting 

 Vinyl 

 Drilling 

 Cutting 

 Milling 

 Sweeping 

 Contouring 

 Simple sequence 
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Setting the standard toolpath properties 

In the dialog box for the path created, click the General tab. 

Designate the engraving tool. If 
there is none, add the tool. 

 Only tools capable of 
machining the path created 
are displayed. 
To see if the tool is suitable 
for the path, optimize the 
choice of tool. 

1. Click to open the Tool Database. 

2. Display the Available tools. 

For a quick selection, display the tools in terms of 

profile. 

3. Double-click a tool. 

Adjust the path’s resolution 
depending on its complexity and 
the machining quality required. 

For a small object, a message 
which suggests increasing the 
precision automatically may 
appear. 

Key in a Accuracy with a value between 1 and 0.0001 mm (maximum 
resolution). 

Slide the cursor to shift the value. 

A value of around 0.0001 increases the path’s fineness by multiplying the 
number of machining segments. 

Decide whether the path calculation 
has to take the selection into 
consideration as a unit or as a 
series of different objects. 

Click to activate or deactivate the Grouping option. 

 Activating this option is pointless if you are grouping the 
objects in terms of surface area. The objects are independent. 
A path is calculated for each object. 

Grouping 

The objects are independent. A 
path is calculated for each object. 

Grouping 

The objects become joined. A single 
path is generated for the selection. 
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Entering the pass parameters for a toolpath 

In the dialog box for the path created, click the Pass parameters tab. 

Passes 

 

1. Key in the maximum Z or machining tip for the material if you are 
machining several paths, or maximum thickness if the material has 
different reliefs. 

2. Key in the Pass depth or the Number of steps: the total depth 
divided by the depth per pass gives the number of passes, and vice 
versa. 

3. If needed, key in the Total engraving depth (the default setting is 
for this to be equal to the depth keyed in the General tab). 
If the path is machined with a conical tool, key in the depth that 
produces the expected cutting width on the surface. 

4. Choose the machining direction in relation to the tool's forward 
movement in the material: 

  

Conventional milling: the 
tool rotates in the opposite 
direction from its movement 
direction and pushes back the 
material as it moves forward 
(chips are dragged with the 
tool). 
Conventional milling produces a 

poor engraving, but needs a low 
spindle power. It is particularly 
well-suited to roughing, because 
it reduces the chips ejection. 

Climb milling: the tool 
rotates in the direction of its 
movement and the material 
passes through underneath it as 
it moves forward (chips are 
thrown in front of the tool). 
Climb milling ensures a better 
finition (due to the absence of 

vibration), but requires a high 
spindle power. 

 

Overthickness Material to be machined on the next pass 

Skip external This option is suited to relief engraving. The finishing tool does not 
engrave the external frame, which saves time and avoids unnecessary 
usage of the tool. 
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Distance between steps(or pass 
width) 

 

The horizontal distance between two consecutive passes is measured 
from the center of the tool. 

Key in the distance in the unit chosen. 

Key in a percentage (the default setting is 50% to machine all the 
material) 
• of the radius for a cylindrical tool. 
• of the truncation for a conical tool. 

The difference between the distance between passes and the tool’s 
diameter represents the pass overlap. 

Pass width = 80% 

Overlap = 20% 

 

Pass width = 50% 

Overlap = 50% 
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Setting the tangent entry or exit properties for a toolpath 

This option allows you to machine a tangent curve upon entry or exit from a path assigned to a closed 
contour. 

 

The tangent entry/exit curve is calculated based on three key parameters: 

(D) the entry/exit distance between the entry/exit point and the contour 
connection point. 

(R) the transition radius in relation to the machined contour. 

(r) the drilling radius around the entry/exit point. 

 

The line of the tangent curve is subject to a check intended to prevent collisions 
between the tool and the material during machining. 

If a collision is detected within the drilling radius, a new connection point is sought 
to eliminate the problem. 

1. In the dialog box for the path created, click the Tangent Entry/Exit. 

2. Tick box Tangent Attack/Exit to edit or activate the relevant parameters. 

3. Key in the parameters for the tangent curve. 

a. Key in an Entry/exit distance (D) that is at most equal to double the connection radius. 

b. Key in a Transition radius (R) that is at least equal to the radius for a cylindrical tool or to the 
truncation for a conical tool. 

c. Key in an Drilling radius (r) less than the entry/exit distance. 

d. Click to machine the tangent curve upon the entry or exit from the path. 

e. Tick box With remaining material to key in the distance for the unmachined Remaining 
material, between the connection point and the opposite end of the path. This option ensures the 

part does not drop at the end of cutting. 

 

With remaining material 

 

With remaining material 
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4. Key in the collision control parameters. 

a. Tick box Control drilling In or Out to perform the check at the start or end of the path. 

b. Key in a Lookup speed between 0.05 and 0.95 so that a new connection point can be located in the 
event of a collision. An interval with a low value will extend the search time, but will increase the 
chances of finding the correct connection point. 

c. Set the Elimination filter for the search for a new connection point. 
• Key in the elimination distance (0.001 is the default setting). 
• Designate the elimination mode: 

Total control performed on the contours nearby 

Limited control performed on the machined contour 
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Plotting 

 

This path, which is particularly well-suited to Gravograph filar fonts, machines open 
contours and closed contours by following their lines. The center of the tool is aligned 
exactly on the theoretical path. 

Create the path and set its properties in the Plotting dialog box. 

1. Set the general path properties. 

2. Set the general Plotting properties: click the General tab. 

 

Key in the total engraving depth. 

With a conical tool, the cutting width at the engraving tip depends 
on the entry depth. 

 

Click to designate the trajectory of the tool for the path: 

One way (by default) 

Forward and backward 

Forward and backward on last slice 

Expert Mode This option allows you to machine a tangent curve upon entry or 
exit from a path assigned to a closed contour. 

Click to display the Tangent Entry/Exit tab in the dialog box. 

3. Key in the pass parameters. 

4. You have clicked the Expert Mode 
in the General tab: set the 
tangent entry/exit properties. 
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Vinyl 

 

 Create a quarter round tool that is suitable for this path. 

Create the path and set its properties in the Vinyl dialog box. 

1. Set the general path properties. 

2. Set the general Vinyl properties: click the General tab. 

 

Key in the cutting depth. 

 

Click the Kind of cutting: 

Plotting 

The tool remains fixed and follows the contour. 

 

Driven cutter 

The tool remains fixed and follows the contour. 
At each angle, the cutter is raised, changes direction and descends once again into the 
material. 

Define the angles between which the tool is raised and is repositioned in the Advanced 
tab. 

 

Floating cutter 

The tool is mobile and follows the contour via successive tangents. 
Upon each sharp angle, it machines a loop tangent to the outside of the material so it can 
reposition itself on the path. 

Define the angles between which the tool executes a loop in the Advanced tab. 

 

Rounded inner angles 

Inactivated option 

 

Tic box Tangential entry/exit to machine an entry/exit tangent to the path. 

Set the tangent entry/exit parameters in the Advanced tab. 

3. You have selected a driven cutter or a floating cutter in the General tab: click the Advanced tab 
and key in the advanced properties. 

Driven and floating 
cutter parameters 

Key in the angles between which the tool will change its trajectory. 

 

For any angle greater than the Minimum side angle: 
• the floating cutter machines a loop. 
• the servo-cutter is raised and repositions itself. 

 

For any angle greater than the Maximum side angle: 
• the floating cutter machines a loop. 
• the servo-cutter is raised and repositions itself. 
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For any angle with a width lower than the Minimum length for sides, the tool 
machines a tangent. 

 

These tangent entry/exit parameters which are dedicated to the floating 
cutter, allow the size of the loop machined upon each angle to be set. 

Key in the Transition radius. 

Key in the Entry/exit distance. 

Check 

intersections 

Click this option, which is dedicated to the floating cutter, to check the 

machined loops do not interfere with the original path. 
If they do, the size and orientation of the loops are automatically adapted to 
avoid any collisions between the path and the cutting geometry. 

For open contours These options, which are dedicated to the floating cutter, determine the way 
the tool adapts its machining trajectory. 

 

Normal 

The tool remains fixed and follows the contour. 

 

Driven tool 

The tool is raised at each angle, and then descends into the material. 

 

Arcs on exterior angles 

A repositioning loop is machined at each external angle. 

 

Arcs on inner angles 

A repositioning loop is machined at each internal angle. 

 

Arc on all angles 

A repositioning loop is machined at each angle. 
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Drilling 

 

 To view the drilling, display a surface render or a realistic render. 

Create the path and set its properties in the Drilling dialog box. 

1. Set the general path properties. 

2. Set the general Drilling properties: click the General tab. 

Mode 

Multi-pass drilling allows the material to be 
removed. 

Click 

Spot drill in a single pass 

Multi-steps with Z up between two passes 

Multi-steps without Z up (possible Z clearance) 

 

Key in the drilling depth. 

Raising the tool 

As soon as the drilling depth is attained, the tool is 
raised at engraving speed and is pointed at the next 
spot to be drilled. 

Key in the Z up position, the maximum raising 
distance above the material after drilling. 

Key in the Delay so the tool can pause at the end of 
drilling (spot facing). 

Tick box High speed clear move so that the tool 
can be raised at high speed (defined in the Machining 
tab for the tool selected). 

Selection filter 

The path created is represented by a curve 

consisting solely of a start point. 

Designate the points to be drilled. Click 

Markers (including drilling points) 

Start point for an open contour 

End point for an open contour 

Start/End points for a closed contour 

Braille or the center of a closed contour 

3. Key in the pass parameters (for spot drilling, key in the maximum Z). 
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2D Cutting 

 

 To cut with a true angle at the bottom, click this option in the Options 

dialog box. 

Create the path and set its properties in the 2D Cutting dialog box. 

1. Set the general path properties. 

2. Set the general 2D Cutting properties: click the General tab. 

 

Key in the total cutting depth. 

 

The default setting is for the cutting to be 

machined around the theoretical path at a 
distance equal to the tool’s radius, depending on 
the entry depth. 

Click to machine an Internal cut inside the 
theoretical path. 

Key in a negative or positive Added offset to 
offset the cutting in relation to the theoretical 
path. 

Key in the radius of the Rounded angles (the 
zero value produced by angles that are almost 
sharp). 
or 

Tick box Fit for tool to machine the roundness 
in accordance with the tool’s profile. 

Machining a Tangent entry/exit 
In the pull-down list, click 

Automatic to machine a predefined tangent 
entry. 
Manual to set the properties in the Tangential 
entry/exit tab in the dialog box. 
None to deactivate the tangent entry. 

Machining a precut 

 

The path calculated is displayed as a contour with 
a dotted line. 

a. Tick box Add links. 

b. Key in the Length and Width of a link. 

c. Key in the Distance between links. 
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3. Key in the pass parameters. 

4. You have selected a Manual Tangent Entry/Exit in 
the General tab: set the properties of the 
tangent entry or exit. 
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2D Milling 

 

This path machines the surface of closed contours. Then, it machines open contours, 
following their lines. 

Create the path and set its properties in the 2D milling dialog box. 

1. Set the general path properties. 

2. Set the general 2D Milling properties: click the General tab. 

 

Key in the total engraving depth. 

Engraving mode Click 

 

Center-line plots the theoretical path lines from 

tool-centre. 

 

2D on surface hollows out the theoretical path at 

the engraving tip. 

 

2D at bottom hollows out the theoretical path at 
the bottom of the engraving when using a material 
that has a transparent surface (Gravoglas). 
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For a 2D machining, click the milling method. 
Regardless of the method chosen, the path is 
completed by contouring the perimeter of the 
machined surface. 

Island using concentric paths outwards from the 
center, with connection between contours. This 
method optimizes the machining time and the 
engraving conditions. 

 

Hatch using rectilinear paths oriented according 

to the sweep angle entered. 

Key in an angle between 0° and 360°. This 

angle enables the clearance of the tool outside the 
material to be limited. 

Machining a tangent entry/exit using predefined 
parameters 

Click to machine a Tangential entry or exit on 

the contouring for the machined surface’s perimeter. 

Use sensor nose The sensor nose prevents the tool from dropping into 
zones that have already been machined. 

Click the box if your tool is equipped with this type 

of nose. 

Island is the only milling allowed. 

3. Key in the pass parameters. 
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Sweeping 

 

This roughing path hollows out the surface of a closed contour using rectilinear paths 
oriented according to the sweep angle. 

Create the path and set its properties in the Sweeping dialog box. 

1. Set the general path properties. 

2. Set the general Sweeping properties: click the General tab. 

 

Key in the total engraving depth. 

 

 

Key in an angle 

between 0° and 
360°. This angle 
enables the 
clearance of the tool 
outside the material 
to be limited. 

Sweeping type 

Indicate whether 
the sweeping is 
executed pocket by 
pocket or over all 
the pockets. Click 

 

By area: the tool 

will completely 
hollow out each 
pocket, which 
reduces the tool’s 
clearance outside 
the material and the 
machining time. 

 

Island jumping: 

the tool 
simultaneously 
hollows out all the 
pockets by quickly 
jumping between 
two pockets at a 
time (dotted red 
line). 
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Sweeping mode 

Designate the 
machining 
direction in 
relation to the 
tool's forward 
movement in the 
material. Click 

 

Forward and backward: the tool machines the material continuously by 
going back and forth without being raised. 

 

Conventional milling: the tool rotates in the opposite direction from its 
movement direction and pushes back the material as it moves forward (chips 

are dragged with the tool). 
Conventional milling produces a poor engraving, but needs a low spindle 
power. It is particularly well-suited to roughing, because it reduces the chips 
ejection. 

 

Climb milling: the tool rotates in the direction of its movement and the 

material passes through underneath it as it moves forward (chips are thrown 
in front of the tool). 
Climb milling ensures a better finition (due to the absence of vibration), but 
requires a high spindle power. 

 

Angle breaking 

Indicate whether 
the path should 
include a broken 
angle or not, either 
before or after the 
sweep. Click 

This sweeping hollows out a pocket by leaving the material in the angles. The angle 
breaking handles the angles by contouring. 

 The Conventional/Climb milling option in the Pass parameters tab applies to 
the angle breaking machining. 

 

None 

 

Before 

After 

3. Key in the pass parameters. 
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Contouring 

 

This roughing path hollows out the surface of a closed contour using concentric paths 
outwards from the center of the theoretical path, with connection between contours. 

Create the path and set its properties in the 2D Engraving dialog box. 

If the tool is not suited to contouring, the path may not be displayed on-screen. 

1. Set the general path properties. 

2. Set the general 2D Engraving properties: click the General tab. 

 

Key in the total engraving depth. 

3. Key in the standard pass parameters. 

4. Key in the 2D Engraving pass parameters. 

Passes 

Indicate if the 
theoretical path is 
hollowed out at the 
engraving tip or at the 
bottom, especially for 
conical tools which cut is 
wider on surface than at 
bottom. 

Click   

2D on surface hollows out the 

theoretical path at the engraving tip. 

2D at bottom hollows out the 

theoretical path at the bottom of the 
engraving when using a material that 
has a transparent surface (Gravoglas). 

 

Distance between 
steps 

 

  

The contouring is full by default: the 
tool hollows out the whole surface of the 
theoretical path. 

To partially hollow out the surface from 
its perimeter: 

Tick box Limited number of steps 

and key in the number of concentric 
paths to be machined. Validate. 
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Standard machining sequence 

 

This function allows you to combine three machining paths: 
• the roughing path is a fast 2D filling, usually far from the theoretical path. 
• the semi-roughing path will clean in 2d the islands remaining in the material. 
• the finishing path is a 2.5D contouring, very close to the theoretical path. 

Create the path and set its properties in the Sequence dialog box. 

1. Set the general path properties. 

2. Set the general Sequence properties: click the Sequence tab. 

List of tools 

 The two last tools must have the 

same coning half-angle. 
The truncation of the finishing tool 
should not be less than half of the 
semi-roughing tool’s truncation. 

Designate the tool suited to each path: 
• Cylindrical tool for roughing 
• Conical tool for semi-roughing 
• Conical tool for finishing 

a. Click the path, then  (or double-click the path). 

b. Select the tool in the Tool Database. 

The dialog box displays the tab, which allows you to set the 
pass parameters for each tool. 

Automatic overthickness Tick the box 

to retain for each path a thickness of material equal to 10% 

of the finishing tool's truncation. 

to key in the Allowance on roughing and Allowance on 

finishing. The semi-roughing tool will machine all areas 
between these two limits. 

Roughing Click the filling method: 

Contouring using concentric paths outwards from the 

center, with connection between contours. This method 
optimizes the machining time and the engraving conditions. 

Sweeping using rectilinear paths oriented according to the 
hatch angle between 0° and 360°. This angle enables the 
clearance of the tool outside the material to be limited. 

Semi-roughing 

3. Click the tab associated to each tool and key in its pass parameters. 

 Automatic filling is particularly efficient if the engraving depth is the same for all the selected 

tools. 
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Optimizing a toolpath 

1. Create the useful tool paths. 

2. Select an object to which you have assigned a path. 

3. Open the Preview of remaining material dialog box: click in the toolbox. 

4. Designate the tool in the Tool Database. 

a. Display the Available tools. 

For a quick selection, display the tools in terms of profile. 

b. Click a tool. 

5. Key in the machining depth. 

6.  Apply  Click. 

 

In the 2D XY view in the dialog box, the 
path’s critical zones are indicated: 

• by the tool using a dotted red line (its 
diameter is calculated for the depth 
entered). 
• by the unmachined surfaces, 
displayed in red. 

In the event of a machining error, the 
Preview of remaining material 
dialog box allows you to test the 
following immediately: 
• another tool. 
• a different machining depth. 
• new tolerance parameters between 
the theoretical path and the machined 
path. 

Edit the path’s properties depending 
on the solutions adopted. 
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Setting the display size using the Zoom tools 

 

Measuring a distance 

 

Setting the optimization preferences 

1. Click in the Preview of remaining material dialog box. 

2. Select the view Color Settings: 

a. Click the Unmilled area (red by default) or Background (white by default). 

b. Click the color in the Windows palette. 

3. In the Parameters zone, key in the dimensions of each segment machined from a 
curve in the theoretical path: 
• the Corner error or maximum height. 
• the Discretization or maximum length. 

4.  Apply  Click. 
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Viewing the tool cursor 

1. Create the useful tool paths. 

2. Open the Tool simulation dialog box: click in the Measure palette. 

3. Designate the tool (if needed, add the tool): 

a. Click to open the Tool Database. 

b. Display the Available tools. 

For a quick selection, display the tools in terms of profile. 

c. Double-click a tool. 

4. Key in the machining depth. To deactivate the cursor tool, key in a zero value. 

5. Click. The tool cursor is displayed in the work area. 

 Conical Tool cursor 

 

1 Fixed tool shank diameter 

 

2 Tool’s diameter at the set machining depth 

3 Truncated tool tip 

2D XY view Description 3D ISO view 

 Cylindrical Tool cursor 

 

1 Fixed tool shank diameter 

 

2 Diameter of the round-tipped tool at the set machining depth 

3 Radius at the tip of the rounded end tool 

2D XY view Description 3D ISO view 
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To locate the path’s critical zones, move the tool cursor along the theoretical path.  

The Tool simulation dialog box allows you to immediately test: 
• another tool. 
• a different machining depth. 

Depending on the solutions adopted, you may 

edit the contours to be machined. 

edit the path’s properties. 
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Reading tool paths information 

1. Create the useful tool paths. 

2. Right-click a path in the Toolpaths list  

3. In the contextual menu, click the Information command. 

4. In the Path information dialog box, click the tab displaying the information you are looking for: 

General 

Pass parameters 

Toolpath information  

Path name 

C:\GravoStyle\DRAWS\gnh1.029 

Location of the file in which the tool path is saved. 
This file has the composition’s name, followed by the number 
matching the path creation order. 

 

Name Type of path 

Machining length Total distance covered by the tool in the material 

Fast machining 
length 

Distance for movements carried out by the tool on the XYZ axes 

Machining time Machining time estimated in line with the characteristics entered in the 
Tools Database 

 

XMin YMin ZMin Tool path’s minimum coordinates on the XYZ axes 

XMax YMax ZMax Tool path’s maximum coordinates on the XYZ axes 

Depth Engraving depth defined during the tool path calculation 
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Toolpath report  

1. Right-click a path or on a group to obtain a report on all the paths it contains. 

2. In the contextual menu, click the Toolpath Report command. 

 Copy  Click to copy the report and paste it into a personal document. 

Paste  Click to edit the report in Word. 

Path Toolpath Name of the path 

Toolpath filename 

C:\GravoStyle\DRAWS\gnh1.029 

Location of the file in which the tool path is saved. 
This file has the composition’s name, followed by a 
number matching the path creation order. 

Toolpath type Type of path 

Machining Machining length Total distance covered by the tool in the material 

Fast machining length Distance for the movements carried out by the tool on 
the XYZ axes 

Machining time Machining time estimated in line with the 
characteristics entered in the Tools Database 

Bounding box Minimum: Tool path’s minimum coordinates on the XYZ axes 

Maximum: Tool path’s maximum coordinates on the XYZ axes 

Precision Resolution depending on the complexity and quality 
of the machining required 

Tool Tool name: Default 
Type: Cylindrical 
Diameter: 4.000 mm 
Half angle: 20.000 deg 
Radius: 0.000 mm 
Tool tip: 0.300 mm 

Profile of the tool assigned to the path 

Execution parameters Execution parameters entered in the General tab in 
the dialog box associated with the path 

Milling 
parameters 

Top Z: 0.000 mm 
Milling depth: 2.000 mm 
Bite steps: 2.000 mm 
Step number: 1 

Pass parameters entered in the Pass Parameters 
tab in the dialog box associated with the path 
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Managing toolpaths 

1. Create the useful tool paths. 

2. Open the Toolpaths list: click in the toolbox. 

This window displays 

the paths assigned to objects in the current composition. 

the groups in which these paths are stored. 

Click to display or hide the paths in the list. 

Managing paths  

Displaying paths 

If you assign several paths to the same 
selection, compare their lines by hiding 
them or displaying them. 

Double-click 

• a path to make it visible or invisible. 

• a group to make its paths either all visible or all 

invisible. 

Editing a path 1. Select the objects to which the path is assigned, otherwise it 
is recalculated for all the objects. 

2. Right-click a path. 

3. In the contextual menu, click command 

 Modify computation to edit the path’s properties. 

 Replace tool to edit the advanced machining or 
correction parameters for the tool. 

Renaming a path 1. Click the path. 

2. Click its name. 

3. Type the new name. 

Deleting a path 1. Right-click a path. 

2. Click the Delete command in the contextual menu. 

Duplicating a path 1. Right-click a path. 

2. Click the Copy command in the contextual menu. 

1. Right-click the Duplicate command in the contextual 

menu. 

Displaying the properties of a path 1. Right-click a path. 

2. In the contextual menu, click the Information or Report 
command to read the path’s properties. 
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Transferring a path for engraving 1. Right-click a path. 

2. In the contextual menu, click the Machining command to 
define the path’s engraving parameters. 

Manipulating a path 1. Right-click a path. 

2. In the contextual menu, click command 

 Edit toolpath geometry command to convert the path into 
a curve object in GravoStyle. 

 Replace path to delete the theoretical path. 

Displaying a path’s render 1. Right-click a path. 

2. In the contextual menu, click the Simulation or NC 
Simulation command to simulate the path. 

Managing groups  

Adding a group 

Organizing the tool paths by group is 
useful for classifying them by type or 
machining range. 

1. Create the group: 

a. Right-click the group which is going to receive the 

path group. 

b. Click the Add a group command in the contextual 
menu. 

2. Store the tool paths of your choice in the new group: drag 

and drop each path onto the group  

Deleting a group 

 This procedure deletes all the 

group’s tool paths. 

1. Right-click the group to be deleted. 

2. Click the Delete command in the contextual menu. 

Renaming a group 1. Click the group. 

2. Click its name. 

3. Type the new name. 
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Calculation preferences 

Defining toolpath calculation preferences 

1. Open the Options dialog box: 

Press the key. 

Click the Options command in the Edit menu. 

2. Click the Calculation parameters tab. 

3. Set the preferences of your choice. 

4. Click. 

Contours sorting 

Auto-merging 

Connection between contours 

True angle 

Cutting order Op1 

Other preferences 
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Designating the machining order 

1. Open the Options dialog box. 

2. Click the Calculation parameters tab. 

3. Click the Sort of contours that determines their machining order: 

Manual The order of creation/selection determines the order the contours 
are machined in. 

Minimum distance (active 
default mode) 

The pockets are machined in order of closeness, from the Xmin to 
the Xmax coordinate. 

Surface min. ->max. Small surface areas (the inside of letters, for example) are given 
priority in terms of machining. 
This mode is automatically activated for a Cutting path. 

Surface max. -> min. Large surface areas are given priority in terms of machining. 

Warning none No sorting 
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Connection between contours 

This active default option optimizes machining by contouring (concentric paths outward from the theoretical 
path’s center). 

1. Open the Options dialog box. 

2. Click the Calculation parameters tab. 

3. Click to deactivate or activate the Connected profiles. 

  

Connected profiles 

Contouring with a connection is continuous. The 
machining contours are connected by a line. 

Connected profiles 

Without a connection, the tool is raised between two 
machining contours, which extends the path time. 
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Auto-merging 

1. Open the Options dialog box. 

2. Click the Calculation parameters tab. 

3. Click to deactivate or activate the Auto-merging. 

Auto-merge allows you to delimit the surfaces to be machined 
on superimposed closed contours. 

Auto-merging 

The default setting is for this option to be inactive. Each 
closed contour produces a pocket, or in other words a surface 
for machining. 

  

Auto-merging 

Auto-merging contours with the same direction produces a 
pocket that integrates the surface of the contours. 

  

Auto-merging 

Auto-merging contours in opposite directions produces 
two pockets that exclude where they intersect. 

  

 Auto-merging does not apply to embedded closed 

contours. 

The surface between the two contours produces a pocket. The 
internal circle forms an island, or in other words, a surface 
area that is not to be machined. 
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Designating the Op1 cutting order 

1. Open the Options dialog box. 

2. Click the Calculation parameters tab. 

3. Key in an Op1 value falling between 0 and 3 depending on the cutting order chosen. 

Op1 = 0 Standard cutting 

Small surfaces are given priority in terms of cutting. 

 

Op1 = 1 Unit cutting 

All the objects are independent and are cut one by one. 
For each object, the internal contour is given priority in 
terms of cutting. 
This fast mode is applied to cutting objects that are 
spaced sufficiently, as it cannot handle tools collisions. 

 

Op1 = 2 Cutting piece by piece 

The order of creation/selection defines the order in which 
objects are cut. 
For each piece, the internal contours are given priority in 
terms of cutting. 
This mode is recommended for partially cutting pieces 
with collision management (word or first name using the 
Jewellery option). 

 

 A tool collision occurs when the current path 

spills over onto a path that has already been 
machined (between two letters for example). 
Collision management causes the tool to be 
raised at each angle. 
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True angle 

True angles allow the machining of angles to be refined and makes it possible to eliminate machining flaws. 

  

True angle at top 

Re-entrant angle finishing by raising the tool 

True angle at bottom 

Re-entrant or outward angle finishing by lowering the 
tool 

1. Open the Options dialog box. 

2. Click the Calculation parameters tab. 

3. Click to activate the finition by a True angle at bottom. 

4. Key in the minimum and maximum angles between which a true angle is executed. 
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Other preferences for toolpath calculation 

1. Open the Options dialog box. 

2. Click the Calculation parameters tab and key in the following parameters: 

Z Limit Maximum raising distance away from the 3D machining material (particularly for 
true angle) 

Critical angle Maximum angle above and beyond which the true angle at top is not executed 

Discretization Maximum length of a segment machined from a curve on the theoretical path, if 
the segmentation is activated in the Cote dialog box. 

Chordal error Maximum height of a segment machined from a curve on the theoretical path, if 
the segmentation is activated in the Cote dialog box. 

Multi-passes on Z 
axis Op0 

Op0 = 3 Deactivated option 

Op0 = 
17 

Activated option 

For the Sweeping path, this Op0 value requires a fixed rotation of the 
tool between each pass. Op0 = 

19 

Va0, Va1 
 Any modification made to these parameters automatically renders the 

manufacturer’s and distributor’s warranty to the user null and void. 

3. Click the Specific parameters tab and key in the following parameters for angle machining: 

Max. angle for 
intaglio 

Maximum angle above which the true angle at top is not executed (135° is default, 
max. value = 180°) 

Max. angle for 
uncut material 

According to the angle's aperture and the pass width, the tool's extended 
penetration may be required to remove the material remaining in a sharp angle. 

The path will be extended inside the angle, when this is lower than the value keyed 
in (135° is default, max. value = 180°). 

Plunged angle of 
tool 

Key in a value from 1° to 89°. 
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Simulation 

Simulating tool paths 

Create the useful tool paths. 

   

The path created is displayed automatically on 
the selection to which it is assigned. 

The selection’s contours form the theoretical 
path. 

The path consists of 
vectorial contours. 

Each start point indicates 
the high-speed movement of 
the tool on to the next 
contour. 

The raising of the tool at the 
end of the path is represented 
by a vertical dotted line. 

 

Surface render 

Display surface simulation to view material machining in 
relation to the tool diameter at the depth keyed in. 

 

Realistic render 

Run NC simulation to watch the live tool path and the 
machining progression which ends with the realistic render in 
material. 
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Displaying surface rendering for a toolpath 

1. Right-click a group or a path in the Toolpaths list  

2. In the contextual menu, click the Simulation command. 

 

The path’s course is represented by a series of yellow circles, the diameter of 
which is the tool’s diameter at the requested depth. 

Hit the key to stop the simulation. 

Click to recalculate the path. 

Click to display the Theoretical path in red (select the machined object 

before opening the simulation). 

Setting the render size 

Use Zoom tools. 

Right-click to double the size on-screen. 

Setting the render 
resolution 

Enter a Precision between 1 and 0.0001 mm (maximum resolution). 

Slide the cursor to alter the value. 

Setting the render depth 

 

Enter a negative Depth that is at most equal to the total engraving depth. 

Slide the cursor to alter the value. 

Click Background so that the path is displayed in the engraving’s 
background. 

The path’s course is represented by a series of a grey circles, the radius of 
which is equal 
• to the radius for a cylindrical tool. 
• to the tip for a conical tool. 

Orienting the render 

 

1. Click to open the View dialogue box. 

2. Click a view (2D XY is the default view). 

3. Validate. 
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Displaying realistic rendering for a tool path 

1. Right-click a group or a path in the Toolpaths list  

2. In the contextual menu, click the NC simulation command. The Simulation window and the NC panel 
will be displayed. 

3. Click to display the Theoretical path in red (select the machined object before opening the 

simulation). 

4. Click the render resolution: 

High 

Medium 

Low 

5. Click the render colors: 

Grayscale 

Metallic effect 

6. Click the simulation mode. The rendering calculation starts automatically. 

 

The full simulation displays 
• the block of material's size in red 
• the path's plotting in brown 
• the tool's path in white 

 
The partial simulation displays the path's plotting and the block of material's size. 

 
The quick simulation displays the block of material's size. 

 

Click to suspend the simulation. 

 
Click to cancel the simulation.   
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Orienting the render in the 
simulation 

 

Slide the pointer to make the render tilt or pivot. 

Right-click to slide the pointer vertically in the simulation to set the 
size of the render. 

 

Simulating the machining on a 
zone of the material 1. Click in the NC panel. 

2. Slide the pointer onto the render. Release it when the zone to be 
enlarged is framed. 

3. Run the rendering calculation. 

Click to display the whole block. 

Defining the block of material 

 To define the block of 
material before the 
simulation, press the 

key when you click 

NC Simulation in the 
contextual menu. 

1. Click in the NC panel. 

2. Key in the XYZ dimensions or XYZ machining coordinates. 

 

 Box of paths   Click to adjust the block of material depending on the paths calculated. 

 Clip to zero   Click to place the maximum Z coordinate at the zero point on the 
surface of the block of material. 

Converting the render into a 
Styl'Art object 

 

1. Click in the NC panel. 

2. Close the simulation. The volumic surface is generated in the 

work area. 
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Transfer for machining 

Transferring machining toolpaths to an IS machine 

 Before performing the transfer, check that: 
• The computer and the IS machine are correctly connected. 
• The IS machine is powered up. 
• The IS machine is not in the process of executing an engraving. 
If you have not installed the IS machine, follow the installation procedure and the advice 
provided in the Gravograph manual enclosed with the machine. 

1. Select the paths to be machined (all by default): right-click a group or a path in the Toolpaths list 

 

2. Open the CAM Machining dialog box: 

Click the Machining command in the contextual menu. 

Type the hotkey. 

Click in the main toolbar. 

3. Designate the active target machine. Select the machine that is actually going to 

engrave the current composition. 
If there is none, add this target machine. 

4. Set the standard engraving parameters and options. 

5. Set the CAM machining properties. 

6. Select paths to be transferred. 

7. Configure the transfer. 

8.  Run  Click: the progression bar indicates the percentage of data transferred. 

To stop the transfer  

9. On the engraving machine, execute the pre-engraving settings (consult the Gravograph manual for your 
machine). 

10. Run the engraving from your machine’s control panel. 

 Designate the machining order in the Options dialog box. In terms of engraving, closed 
contours are given priority over open contours. 

 Changing the tool during engraving is indicated by the tool’s name being displayed on the 

machine’s LCD screen. 

 Any modification to the CAM paths will only occur in the engraving following a new transfer, 

which will delete the preceding one. 
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General properties 

Setting the CAM machining properties 

Set the machining properties in the CAM Machining dialog box. 

Machining coordinates 

This table displays the XYZ coordinates for 
the tool at the start and end of the 
engraving, in relation to the 0 point of the 
machine. 

The Delta values represent the difference 
between the maximum and minimum 
coordinates, and consequently the 
engraving’s footprint. 

1. Click to gain access to the XYZ values. 

2. Key the Min., Max., Medium coordinates to reposition the 
floating origin of the composition. 
Modifying a value will recalculate the related values. 

Click to lock them. 

 Multi Z...  Multi-passes machining Redefining the number of passes required to machine a 
sequence's paths 

 Cote...  Machining dimensions Configuring the movements for a sequence's machining 

Click to validate the new properties. 
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Multi-passes machining for a sequence 

 If you want the multi-Z option to be activated, key in the 19 value to the parameter Op0 in the 
Calculation parameters of the Options dialog box. 

1.  Multi Z...  Click in the CAM Machining dialog box. 

2. Click to select the calculation mode for the number of passes. 

None The machining is executed according to the number of passes set for each toolpath's 
computing. 

Tool 

info 

The machining is executed according to the cutting depth for the tool used. 

Manual The machining is executed according to the Z step cutting you have keyed in. 

3.  
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Setting the machining dimensions for a sequence 

 Cote...  Click in the CAM Machining dialog box. 

Attack-speed falling 
into the material 

 

Fast-speed movements 
over the material 

Material 

Output curves as 
segments 

Tick this box to machine the theoretical path as small segments, instead of 
curves. 
The maximum dimensions of a machined segment will be set in the 
Discretization and Chordal error in the Calculation parameters of the Options 
dialog box. 

Z1 Initial position 

Ending position 

Key in the XYZ coordinates for the tool, in relation to the 0 point of the machine 
• at the start of machining 
• at the end of machining 
• where the tool will be changed 

Change tool position 

Z4 Z security 
beginning of 
machining 

Minimum and maximum machining movements 

The Z security value at the start of machining must be at least equal to the Z 
max. coordinate in the CAM Machining dialog box. 

Z5 Z security end of 
machining 

Z2 Z between 
contours 
(absolute 
value/machining 
file) 

Maximum rising for the tool between two machined contours 

This value must be greater than the Z max. coordinate in the CAM Machining 
dialog box. 

Z3 Z approach 
(relative 
value/piece) 

Maximum drop speed distance for the tool 
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Tool Database 

Using the Tool Database 

Select the Tools Database command in the Machining menu. 

The Tools Database dialog box displays the libraries 

Tool Database where the available tools are stored. 

Tools used for engraving the paths in the current composition. 

Each tools group corresponds to an engraving profile (braille, finishing, diamond, etc.). 

Click to display or hide the contents of a library or a group. 

1. Right-click a tool. 

2. Click an operation in context menu: edit tool properties, add a tool or create a group to order your tools. 

 Managing engraving tools in the Tool Database 

 Setting the properties for an existing tool in the Tool Editor 

 Creating a special tool 
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Managing the engraving tools 

Open the Tool Database dialog box. 

At the end of the operation, click in the Tool Database dialog box. 

Managing the available tools  

Adding a tool 1. Open the Tool Database. 

2. It the tool belongs to a group, open the group. 

3.  Add tool  Click. 

4. Set the tool's properties. 

Editing a tool 1. Open the Tool Database. 

2. It the tool belongs to a group, open the group. 

3. Select the tool: 

a. Click the tool. 

b.  Edit tool  Click in the Tool Database dialog box. 

or 

a. Right-click the tool. 

b. Click the Edit tool command in the contextual menu. 

4. Edit the tool's properties. 

Deleting a tool 1. Open the Tool Database. 

2. It the tool belongs to a group, open the group. 

3. Select the tool to be deleted: 

a. Click the tool. 

b.  Delete  Click in the Tool Database dialog box. 

or 

a. Right-click the tool. 

b. Click the Delete command in the contextual menu. 
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Managing groups of tools  

Adding a group 1. Create the group of tools: 

a. Click the library which will contain the group. 

b.  Add group  Click in the Tool Database dialog box. 

or 

a. Right-click the library which will contain the group. 

b. Click the Add group command in the contextual menu. 

2. Arrange the tools of your choice in the group: drag and drop each 

tool onto the group  

Renaming a group 1. Click the group. 

2. Click the name of the group. 

3. Type the new name. 

Deleting a group 

 This procedure also 
deletes the tools 
belonging to the group. 

1. Open the library which contains the group of tools. 

2. Select the group: 

a. Click the group to be deleted. 

b.  Delete  Click in the Tool Database dialog box. 

or 

a. Right-click the group to be deleted. 

b. Click the Delete command in the contextual menu. 
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Tool properties 

Defining the properties of an engraving tool 

1. Add or edit a tool. 

2. Set the properties of the tool selected in the Tool Editor: 

a. Describe the tool’s profile. 

b. Key in the advanced machining parameters. 

c. Key in the correction parameters when you use a tool changer. 

3. Click in the Tool Editor. 
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Describing the tool’s profile 

1. Add or edit a tool. 

2. In the Tool Editor, click the Tool shape tab. 

3. Type the Name of the tool, its Reference and its Supplier. 

4. Click the profile  

5. Key in the grinding parameters (except for the quarter round tool)   

By way of an example, for a B7300 conical TwinCut insert, key in: 
• a tool diameter of 3.17 mm 
• a coning half-angle of 22.5° 
• a truncation of 0.32 mm (these values are calculated for a cutting depth of 0.33 mm). 

 

Diameter of the tool 

The distance between the engraving contour and the center of 
the tool is equal to its radius. 

 

 

The coning half-angle defines half of the cutting angle. 

 

 

The radius determines the roundness of the engraving. 
 

 

The truncation defines the cutting width at the machining tip 

(Z=0). 
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6. Key in the standard machining parameters  

The parameters are the same for the quarter round tool, although the representation of the 

tool may be different. 

Rotation speed in RPM (rotations per minute) 

 

Forward speed in mm per minute 

 

Attack speed in mm per minute 

Click the Automatic Adjustment to obtain a value equal to half the 
forward speed. 

 

Number in the tool changer 
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Entering the advanced machining parameters for a tool 

1. Add or edit a tool. 

2. In the Tool Editor, click the Technologies tab. 

3. Key in the advanced machining parameters: 

Depth 

Max. 
Min. 

Maximum/minimum engraving depth 

Key in an engraving depth that is between the maximum depth 
and the minimum depth defined for the tool. 

Of Cut Maximum pass depth, between 0.01 mm and the maximum 
depth. 

The number of passes required for the engraving is equal to the 
engraving depth divided by the cutting depth. 

Cutting width 

Max. 
Min. 

Maximum/minimum distance between 2 passes 

The difference between them matches the overlap value in terms 
of the calculation of the tool path. 
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Feed rate 

Nominal speed F = (A x a x S) Engraving speed 

Fast speed Forward speed with the spindle over the material 

Max. 
Min. 

Maximum/minimum nominal speed 

To lock the engraving speed for the tool selected, key in the 
same value for the Min. and Max. speeds. 

Descending feed rate Maximum drop speed allowed with the spindle over the material, 
if (F) is higher 

Plunge speed Maximum speed allowed for attacking the material, if (F) is 
higher 

Cutting speed (V) Linear advance speed of the cutting edge, at least equal to 0.01 
mm/min 

Flying angle Maximum drop angle (referenced in relation to the horizontal 
plane) 

Vol. of chips Volume of chips which the tool can manage 

Nb of teeth (a) Value at least equal to 1 

Feed/tooth (A) Chip thickness which the tool can manage 

Rotation speed 

Nominal S = (1000 x V) / (P x D) Spindle rotation speed (D: tool diameter) 

For a conical tool, take the average value for the cutting depth 
entered. 

Max. 
Min. 

Maximum/minimum rotation speed 

To set the rotation speed for the tool selected, key in the same 
value for the Min. and Max. speeds. 

 The rotation and engraving speeds are limited by the post-processor for the machine equipped 
with the tool selected. 



CAM Machining 

357 

Entering the tool correction parameters 

1. Add or edit a tool. 

2. In the Tool Editor, click the Turret tab. 

3. Key in the correction parameters in the line associated with the tool (double-click on the box which you 
want to modify the value for). 

Tool index Number assigned in the Profile tab 

Corrector Physical location in the tool changer 

The default setting is for the number of the tool to always match its position in 
the changer. 

Click box Index=Corrector to key in different values. 
By way of an example, you can place tool 7 in row 3 of the tool changer. 

Max length Maximum engraving distance allowed 

If this is exceeded, the path is cut into as many sections as are necessary. 

Used length Total of the engraving distances covered 

When the Maximum Distance and the Machined Distance are the same, this 
means the tool is worn and should be replaced. 

Initializing the correction 
parameters 

1. Click the heading of a column. 

2.  Initialize a column  Click to edit all the column’s values. 

3. Key in the default column Value. 

4. Validate. 
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Creating a special engraving tool 

1. Draw the open contour which represents the tool's profile. 

2. Centre vertically two markers to form the tool's axis. 

3. For this type of tool, check that the distance between the profile base and 

the axis is at most equal to half the truncation. 

4. Select the profile, and then the markers. 

5. Click in the toolbox to display the selection in the CAM window. 

6. Click in the toolbox. 

The tool is automatically added into the Special tools group in the Tool 

Database. 

7. Set the properties of the special tool in the Tool Editor in which the preview 
displays the cutting expected: 

a. Key in the standard machining parameters. 

b. Key in the advanced machining parameters. 

c. Key in the correction parameters when you use a tool changer. 

8. Click in the Tool Editor. 
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Customize the program 

Defining your program preferences 

The more you use the program, the more you will need to adapt it to your work habits. 
The simplest way is to assign your personal values to the parameters and options that you use regularly. That 
way, they will automatically be applied to each new composition. 

1. Open the Options dialog box: 

Press the key. 

Click the Options command in the Edit menu. 

2. Click the tab for the preferences to be modified. 

3. Set the preferences of your choice. 

4. Click. 

General 

Display 

Colors 

Grid 

Material 

Text attributes 

Spell Checker 

Fonts 

Mouse buttons 

Machining parameters 
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Setting the general preferences 

1. Click the General tab in the Options dialog box. 

2. Click the option or customize the parameter of your choice: 

Undo level To set the number of procedures saved in the Undo/Redo memory, key in an Undo 
level between 1 and 100. 

Auto save To set the automatic save period, key in an Auto save every … minutes: 
• a number of minutes between 1 and 60. 
• a zero value to deactivate the automatic save. 

Sound The activation of certain commands produces a sound. 
Click the box to use this function. 

Save a *.VNX 

copy 

Tick the box to automatically create a .vnx type neutral file, each time you save the 
composition. 
This format converts all the objects into vectorial contours and allow the composition to 
be opened in any version of GravoStyle or Type3. 

 Text objects and complex objects are converted into curves and no more 

editable. 
Bitmap images and surfaces are retained intact. 

Unit 
Click a measuring unit. 

Language 
Click your language. 

 Mouse button (F5)   Click to configure your mouse. 
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Customizing the display 

1. Click the Display tab in the Options dialog box. 

2. Click the option or customize the parameter of your choice: 

Show ruler To display the horizontal and vertical rulers 

Show bitmap To display a bitmap image 

Show start point To display a contour’s start point 

Show control point To display a contour’s control points 

Show direction To display a contour’s direction 

Arrow move To set the movement distance for an object using the arrow keys in the numeric 
keypad 

Snap distance To delimit the magnetic field around a snap element 

Display timer To display the time spent on the current composition 

Toolbars 

configuration 
To organize floating palettes 
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Customizing colors 

1. Click the Colors tab in the Options dialog box. 

2. Click the color desired: 

Neutral black 

Open contour black 

Counterclockwise closed contour green 

Clockwise closed contour blue 

Background white 

Baseline grey 

Engraving path black 

Fast movement black 

Material black 

Snap distance red 

Selection red 

Margins grey 

Grid dark grey 

Guide lines black 
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Customizing text attributes 

1. Click the Text attributes tab in the Options dialog box. 

2. Customize the attribute of your choice: 

 

Font 

 
Height 

 
Width 

 
Text slant 

 
Exponent/index text 

Bubble time Zoom period during text entry 

Control +/- Sets manual auto-kerning, by adding or subtracting spaces with each keyboard shortcut. 
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Configuring the mouse 

Adapt the mouse behaviour to your work habits. 

Click your preferences in Mouse use dialog box: Press the key. 

or 

a. Click the General tab in the Options dialog 
box. 

b.  Mouse button (F5)  Click. 

 

Click the action performed with the central 
wheel: 

 
Zoom in/out 

 
Scroll up/down 

 

Click the action performed with the right 
button: 

 
Zoom to double the display size 

 
Undo, to cancel the last procedure 
performed 

 
No action 
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References 

References 

.gnh Files How to manage the compositions saved on your computer? 

Object Types What are the objects with which you can enhance a composition? 

File formats What are the external file formats: 
• that you can import and use in the program? 
• in which you can export a composition so it can be used in another 
program? 

Fonts How to manage the fonts used to display the text in the composition? 
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.gnh Files 

Open the Open the Find File dialog box: click the Find command in the File menu. 

 Close  Click to close the dialog box. 

Find 1. Open the Find File dialog box. 

2. Designate the drive you want to look for .gnh files on: 

Find in directory  Click if you are searching on the [c] hard drive. 

Otherwise, click the drive name ([a] for the floppy-disk drive, or [d] for the CD-
ROM drive). 

3. Click the name of a directory available on the drive. 
[…] Click to go back to the upper level in the tree. 

4.  Find in sub-directory  Click to find .gnh files stored in the directory selected. 

If no name is displayed, restart the search from step 1. 

5. If several .gnh files are displayed, click a sorting criterion in the Sort by zone 
(name, creation or modification date, etc.). The files contained in the selected 
directory appear in the specified sort order. 

Manage 1. Perform a search in the Find File dialog box. 

2. Click the file name in the list of .gnh files found; the composition selected is 
previewed. 

3. Click the button which runs the procedure you want on the file selected. The 
procedure is applied to the .gnh file and to the files that are related to it (tool path, 
Styl'Art shape, etc): 

 Open   To open the .gnh file 

 Delete   

Click in the Delete a .gnh File dialog box. 

 Copy   

Move  

a. Click the name of the drive to which the file is going to be moved or copied: ([a] 
for the floppy disk drive, [c] the hard drive). 

b. Click the directory name. 

c. Click. 
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Available types of objects (non-contractual list) 

Text objects 

These objects consist of one single line of text or a paragraph. 

To edit the text 

in Selection mode: double-click the object. 

in Text mode: click the object. 

To modify a line parameter or a text attribute, click the relevant command 
in the Text palette or in Rapido palette. 

Horizontal text 

Text in an arc 

Slant text 

Vertical text 

Text on a curve 

Text in a rectangle 

Text in Columns 

Static Matrix series 

Curve objects 

These objects consist of one or more vectorial contours. 

To edit the contours comprising this type of object, ungroup them. 
You can retouch their lines without ungrouping them. 

Geometric shapes (except 
Markers) 

Objects converted into 
curves 

Symbols 

Bounding box 

Marker object 

This object is used as a marker for a dimension or a drilling point 

Marker 

Single drilling point 

Composite objects 

These objects are groups of different types of objects. 

To edit the objects comprising this type of object, ungroup them. 
If the composite object contains contours, you can retouch their lines 
without ungrouping them. 

Symbols 

Cutting axes for a static 
Matrix series 

Drilling points 

Vectorized images 

Overlap markers 

Complex objects 

These objects are groups of different types of objects. 
You cannot transform this type of object. 

To modify its parameters, double-click on the object in Selection 

mode  

To edit the objects comprising this type of object, convert it into curves if 
possible. 

Level 2 Braille Text 

Dynamic Matrix Series 

Dials 

Bar Codes 

Dimensions 

Images 

These objects are obtained from: 
• digitizing a photo or a drawing on paper using a scanner. 
• importing files produced with a bitmap drawing program. 

To retouch this type of object in the Bitmap Editor, double-click on the 

object in Selection mode  

Bitmap Images 
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Using Gravograph fonts Option for ALL levels 

Installing a Gravograph font 

 The fonts in Pack 1 are available as 
a standard feature. 

Fonts created in Font Editor can be 
used immediately. 

1. To use a font, first install the Pack it belongs to: execute 
First Installation steps 1 to 9. 

2. In the Setup Type dialog box, click Custom. 

3. Proceed the installation in Custom mode. 

4. Execute First Installation steps 11 to 14. 

5. Order and activate this option. 

6. After activating the Pack, you can select the fonts. 

Deleting Gravograph Fonts 

 To use a deleted font, reinstall the 

Pack it belongs to. 
If this Pack has already been 
activated, the font will be available 
immediately. 
Otherwise, you have to order and 
activate this option. 

1. Launch Windows Explorer. 

2. Locate the drive on which you have installed the program 

(C: is the default drive). 

3. Double-click on the GravoStyle folder. 

4. Double-click on the FONTS folder. 

5. Double-click on the Gii folder. 

6. Click the .CHR type file, which features the name of the 

font to be deleted. 

7. Press the key. 

Installing Braille fonts in Windows 

 Execute this procedure if the Ttf 

fonts Braille, NHBraille, 

Simbraille do not appear in the 
font menu. 

1. In the Windows Task Bar, click Start. 

2. In the Start menu, click command Settings (Windows 

98/NT). 

3. In the Parameters menu, click command Control panel. 

4. In the Control Panel, double-click icon Fonts. 

5. In the Add Fonts dialog box, click command Install a new 
font in the File menu. 

6. In the Drives list, click the drive where you have installed 

the program (c: is the default drive). 

7. In the Folders list, click folder GravoStyle. 

8. In this folder, click folder Ttf of FONTS directory. 

9. Click box Copy all fonts into the Windows FONTS 

directory. 

10. Click. 
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File formats recognized 

Click to locate a format. 

Vectors (*.eps, *.ai, *.dxf, *.plt, *.igs, *.iso, 
*.stl, *.hpg) 

Bitmap (*.bmp, *.wmf, *.tiff) 

Gravograph-New Hermes (*.vnd, *.job, *.ejo, 
*.lgo) 

GravoStyle (*.gnh, *.vna, *.syb) 

Vector files 

IMPORT EXPORT 

Image generated from a combination of geometrical shapes 

Before importing: 
• Convert text into curves. You can no longer correct it, but you can apply geometric 
warping. 
• Smooth contours, whether they consist of lines or curves. 
• Export the file in one of the following formats: 

  HPGL 
(*.hpg) 

HPGL 
Vectors 

Standard Hewlett-Packard Format 

This format, which is commonly found in the CAD sector, reproduces the 
contours in the form of small vectors. 
The quality can be decreased, particularly in curve smoothness. 

If the drawing's import is not correct, export it again under HPGL Vectors 

format. This draws contours with line segments. Lines are simplified, but 
more faithfully reproduced. 

  HPGL 
(*.plt) 

  EPS 
(*.eps) 

Standard PostScript Format 

This faster and optimized process programs contours and characters as 
Bezier curves, producing fewer elements for analysis. 

When you import EPS files, the EPS Import dialog box opens. 

Click option Autoconnected imported file to automatically close open 

contours and delimit surfaces to be engraved over the imported drawing. 

If you fail to open this type of file correctly, import it under 

generic PostScript format:  

1. Exit the program. 

2. Explore folder GravoStyle. 

3. Rename folder FILTRES under DPS name. 

4. Create new FILTRES folder. 

5. Copy file dicogen.pda from DPS folder. 

6. Paste the file into FILTRES folder. 

7. Run the program and import the PostScript file again. 

After importation, restore initial filters. Rename 
• folder FILTRES under DICOGEN name. 

• folder DPS under FILTRES name. 

  EPS (*.ai) 
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  DXF 
(*.dxf) 

Standard Autocad Format 

How to import a DXF file that contains text? 

 If the text has been typed with an Asian font, select the country it 

belongs to. 

a. Open Local Options in Control Panel. 

b. Click the geographic zone in Standards and Formats. 

c. Click. 

 In GravoStyle, select the font which will replace the fonts missing to 

display text of the imported DXF file. 

When you import 2D DXF files, the 2D DXF Import dialog box opens. 

1. In zone Scaling, click the active measure unit: 

Automatic or default unit 

from millimeters 

from inches 

2. Click option Autoconnected imported file to automatically close 
open contours and delimit surfaces to be engraved over the imported 
drawing. 

3. Click. 

4. Use overlap markers to check that contours are correctly closed. 
If needed, close open contours using auto-connexion. 

  2D 

  3D face 

  IGES 
(*.igs) 

Standard 4CAM surface description format 

  ISO 
(*.iso) 

Surface recognition format 

When a Digitized ISO file is imported, the Digitized ISO dialog box opens. 

1. Depending on the level of precision desired, key in 
NbX, the number of grid points on the X axis. 
NbY, the number of grid points on the Y axis. 

2. Click. 

  Digitized 
ISO 

Vector 

  STL 
(*.stl) 

Surface recognition format 

When an .stl file is imported, the STL Import dialog box opens. 

Click a view (Top is the default setting). 

or 

1. Click Customize and orient the surface projection: 

a. Key in the Alpha, Beta or Gamma rotation angle. 

b. Key in the projection's Resolution. 

2. Click. 

  ASCII 

  binary 
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Bitmap files 

IMPORT EXPORT Image generated from a pixel grid, or points on the screen, with different colors 

  BMP (*.bmp, *.dib) Standard format for Windows images 

  PNG (*.png) Commonly-used format for Web images 

  TIFF (*.tif) Commonly-used format for exchanging images between MacOS 
and Windows programs 

  Windows Metafile 
(*.wmf) 

Format for Windows images integrating bitmap data and 
vectorial data 

GravoStyle files 

IMPORT EXPORT Files related to the composition (.gnh files) 

  ISO (*.u??) Engraving saved in the form of a file transferred to the 
machine subsequently 

  Geometric tool path 
(*.0??, *.P??) 

CAM toolpath 

  Vision Numeric TypeArt 
(*.vna) 

Styl'Art Shape 

  Symbol (.syb) Logo stored in the Symbols library 

Gravograph files 

IMPORT EXPORT  

  *.ejo, *.lgo Documents created and saved in the Open Software program 

  GravoStyle97 
(*.job) 

Composition created and saved in the GravoStyle 1 & 2 for 
Windows 3.1/95 program 

  Vision Numeric 
(*.vnd) 

Composition created and saved in previous versions of GravoStyle 
or Type3 

Text files (ascii) 

IMPORT EXPORT  

  *.txt Commonly used format for exchanging raw text between programs 

Used to create a list of names or to associate text with graduations in a dial. 
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Install the program 

Installing the program on your computer 

 Plugging the dongle 

 First setup 

 Install mode 

 After setup-Operations 

 You are allowed to install the program onto several computers, but it will only operate on a 

computer with the dongle plugged into it. 
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Plugging the dongle into your computer 

This protection key checks your codes and user rights to the program (last installation date, program version, 
program level and the options integrated into this level). 

 Unplug any USB key from the back of your computer. During installation, a message will remind 

to remove this kind of dongle. 

1. Power down the computer and peripherals (printer, scanner). 

2. Unplug the printer cable and any other peripheral connected to the computer’s parallel port (LPT). 

3. Connect the plug end of the dongle to this parallel port. 

4. Plug the printer cable and the other peripherals into the dongle. 

5. Power up the peripherals (the printer must be running and plugged in at all times). 

 If the dongle is not recognized, carry out the procedure again. 
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Successfully completing the first installation 

1. Check that your computer has the minimum configuration required. 

PC Minimum Recommended 

Microprocessor Pentium III Pentium IV 

Frequency 500 MHz 800 MHz 

RAM 128 MB 256 MB 

1 internal hard drive 100 MB available 400 MB 

1 internal CD-ROM 
drive 

x16 x32 

1 mouse Windows compatible  

1 clavier extended (105 keys)  

LPT parallel ports 1 2 

COM serial ports 1 2 

1 graphics card 65535 colors, 24 bits 16.7 million colors, 32 bits 

1 SVGA monitor 17", resolution 768x1024 20", resolution 1024x1280 

Other peripherals 1 internal 3.5" HD floppy disk drive 1 printer  
1 TWAIN scanner  
1 sound card  
1 ZIP drive 

Software 
environment 

Windows 98 Windows 2000 

Internet Explorer 5 

Acrobat Reader 5 

Word 97/98 

Windows Multimedia Player 

Arial, Microsoft Sans Serif Regular, 

Verdana Fonts 

Engraving machine Gravograph IS or L-Solution 
2D Equipment (laser, vinyl cutter or 
water jet) 

3D Machine 
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2. Plug the dongle into the back of your computer. 

3. Place disk GravoStyle in the CD-ROM drive. 

4. Wait until the installation panel is displayed. 

If this panel does not open, double-click the drive. 

5.  Next>  In the Welcome dialog box, click to start the installation. 

Back to the previous dialog box  <Back   

6. Type your Name and your Address in the Coordinates dialog box. 

Next>  Click. 

7. Type your Phone number, Fax number and your Email address. 

Next>  Click. 

8. The Choose Destination Location dialog box will inform you that the program is going to be installed 

in the GravoStyle  folder, created by default on hard drive C:. 

Next>  Click. 

9. In the Setup Type dialog box, click the installation mode ( Typical is the default mode). 

Next>  Click. 

10. Installation begins. The progress panel and bar show the state of progress in terms of the procedure. 

To cancel installation,  Cancel  click in the current dialog box, then on  Exit setup  in the Exit Setup dialog 

box. 

11. Check that you have unplugged any USB dongle from the back of your computer. 

Click. 

12. Install L-Solution Printers driver to simplify the connection between the software and your laser 
machine. 

13. In the Setup Complete dialog box, click Yes, I want to restart my computer now, and then on 

 Finish   

14. Restart your computer and run the program:  click the icon set on Desktop. 

15. Have your first contact with the program. 
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Selecting an installation mode 

Typical mode 

Convenient for most users, this default mode installs the components required for the program to operate 
(program, messages, documentation in your language). It suits to a major part of users. 

Compact mode 

This mode only installs the program in your language and limits the space required for installation. 

Custom mode 

This mode allows the space required for installation to be managed by allowing you to 
• install only the useful components. 
• add components, following prior installation of the same program version. 

In the Select Component dialog box, click the component to install or ignore (see the table belows). 

Next>  Click after component selection and complete the setup. 

Gravograph Software GravoStyle engraving program 

Additional Languages 

By default, the program is in your 
language. 

Click the component to install: 

 Resources 

 Documentation 

Fonts to install the sets that contain the 

fonts with which you type text. Each font 
Pack is an option. 

Click to install the fonts of your choice: 

 Gravograph Font Pack 1, 2 or 3 

 Vision Font JPN/PRC/KR (Japan, China, Korea) 

Others to install more components. Click the component to install: 

 Symbols: graphics library (symbols, logos, envelopes, 
connectors) 

 Windows 98: driver for L-Solution machine 

 Windows NT/2000/XP: driver for L-Solution machine 
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Updating program 

To take full advantage of new features and other improvements to the software, ask your Gravograph 
distributor for the latest update. 

1. Place disk GravoStyle in the CD-ROM drive. 

2. Wait until the installation panel is displayed. 

If this panel does not open, double-click on the drive. 

3. The Install Wizard asks you which operation you will carry out:  click Remove. 

Next>  Click. 

4.  Yes  Confirm the program's final deletion from your computer. 

5. Click at the end of the operation. 

6. Install the new program version according to the First setup. 

 Install no target machine because your existing target machines are retained. 
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Index 

A 

Align ....... 149, 150, 151, 152, 153, 154, 155, 156 

B 

Bar Codes ..............................265, 266, 267, 268 
Bitmap Editor 

.bmp files ......................................... 215, 216 
colors ........... 218, 224, 225, 226, 227, 228, 229 
environment .......................208, 209, 210, 212 
image ........... 213, 214, 215, 219, 220, 221, 222 
mask ..................................230, 231, 232, 233 

Bitmap Editor .........................207, 217, 223, 230 
Braille ................................................... 64, 238 

C 

CAM Machining 
preferences ... 332, 333, 334, 335, 336, 337, 338 
renders ..............................324, 326, 340, 341 
tool database 347, 348, 350, 351, 353, 355, 356 
toolpath305, 306, 307, 308, 310, 324, 328, 330, 
332, 339 
transfer ..............................343, 344, 345, 346 

CAM Machining 303, 304, 312, 313, 315, 316, 318, 
320, 322, 323 
Composition .......... 10, 11, 21, 22, 25, 31, 34, 269 
Contours 102, 119, 120, 121, 133, 170, 179, 191, 
199 

D 

Dials ............................. 244, 245, 248, 249, 250 
Dimension .................................... 167, 168, 169 
Dongle .................................................. 35, 372 
Drilling ................................................ 236, 315 
Duplicate ................ 157, 158, 159, 161, 162, 163 

E 

Effects on contours . 170, 171, 172, 173, 174, 175, 
176, 177, 178 
Export ................................................. 132, 367 

F 

Font Editor ......................... 93, 94, 95, 96, 98, 99 
Fonts ....................................... 66, 93, 366, 375 

G 

GNH files .................................. 23, 24, 364, 367 
GravoStyle 5 .............. 1, 4, 5, 7, 9, 10, 11, 12, 26 
Grid ........................................................... 138 
Guide lines.................................................. 139 

H 

Help .................................................. 2, 35, 363 
Hotkeys ........................................................ 26 

I 

Image ........................... 197, 198, 199, 202, 207 
Import ................................................ 127, 367 
Incrementation .............................. 254, 256, 258 

L 

Laser engraving .......... 4, 5, 7, 270, 299, 300, 301 
Layers ................................................. 142, 263 
List of names ................................ 252, 256, 258 

M 

Markers ................................ 104, 148, 178, 236 
Material ....................... 37, 38, 40, 41, 42, 43, 45 
Matrix .................................. 259, 260, 262, 263 
Measure ............................... 164, 165, 166, 167 
Move ............................................ 145, 185, 189 

O 

Objects... 124, 125, 127, 128, 129, 130, 132, 133, 
134, 144, 149, 157, 164, 170, 365 

P 

PhotoStyle ..................... 202, 203, 204, 205, 206 
Points ..... 102, 121, 180, 181, 182, 183, 184, 185, 
186, 187, 188, 189, 190, 191, 193, 194, 196 
Print ............................................................. 32 
Program 

preferences ... 38, 281, 357, 358, 359, 360, 361, 
362 
setup ......................... 371, 372, 373, 375, 376 
upgrading .................................................. 12 

Program ............................. 3, 35, 357, 363, 371 

R 

Rulers ........................................................ 137 

S 

Save ..................................................... 30, 358 
Scanner ...................................................... 198 
Select.............................................61, 128, 181 
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Shapes ... 101, 102, 104, 105, 106, 107, 108, 110, 

111, 112, 113, 114, 115, 117, 118, 119, 120, 
121, 174, 191 
Slant/Diagonal text ........................................ 79 
Snap .......................................................... 136 
Symbols ..................................................... 125 

T 

Target machine .................. 15, 16, 17, 18, 19, 40 
Tasks ..... 235, 236, 238, 239, 240, 241, 244, 251, 
259, 265 
Text ............... 49, 50, 59, 60, 61, 62, 63, 77, 133 
Text attributes . 65, 66, 68, 69, 70, 71, 72, 73, 74, 
75, 76 
Text in arc ......................................... 85, 86, 87 
Text in columns ....................... 88, 89, 90, 91, 92 
Text in rectangle ........................................... 78 
Text line ........... 48, 51, 52, 53, 54, 55, 56, 57, 58 
Text on curve ................................................ 83 
Tool engraving 

2D filling ........................................... 272, 318 
advanced paths .... 303, 305, 306, 330, 332, 339 
long plate ...........................283, 284, 286, 287 
simple paths .......................271, 274, 280, 281 

tool properties .....................350, 351, 353, 355 
Tool engraving 269, 270, 276, 277, 279, 282, 299, 
300, 301 
Transform ...................... 144, 145, 146, 147, 148 

U 

Undo/Redo ......................................29, 358, 362 

V 

Variables ....................... 251, 252, 254, 256, 258 
Vectorize ...................................... 199, 200, 201 
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